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PREFACE

The Volpe National Transportation Systems Center (Volpe Center) of the United States
Department of Transportation’s Research and Innovative Technology Administration has
developed a modeling system to assist the National Highway Traffic Safety Administration
(NHTSA) in the evaluation of potential new Corporate Average Fuel Economy (CAFE)
standards. Given externally-developed inputs, the modeling system estimates how
manufacturers could apply additional fuel-saving technologies in response to new CAFE
standards, and estimates how doing so would, relative to a given baseline scenario, increase
vehicle costs, reduce national fuel consumption and carbon dioxide emissions, and result in other
effects and benefits to society. The modeling system can also be used to estimate the stringency
at which an attribute-based CAFE standard satisfies various criteria. For example, the system
can estimate the stringency that produces a specified average required fuel economy level, or that
maximizes net benefits to society.

This report documents the design and function of the CAFE Model as of July 14, 2016; specifies
the content, structure, and meaning of inputs and outputs; and provides instructions for the
installation and use of the modeling system.

The authors of this report are Mark Shaulov, Kevin Green, Brianna Jean, Ryan Keefe, Donald
Pickrell, and John Van Schalkwyk.

The authors acknowledge the technical contributions of present and former Volpe Center and
NHTSA staff who have been involved in guiding recent changes to the modeling system,
including Dan Bogard, Walter Gazda, Ryan Harrington, Ken Katz, Gregory Powell, Jim Tamm,
Lixin Zhao, and Stephen Zoepf. The authors further acknowledge former DOT staff who
participated in the development of earlier versions of the modeling system, including Gregory
Ayres, Phil Gorney, Kristina Lopez-Bernal, José Mantilla, Joe Mergel, Arthur Rypinski, and
Kenneth William.

The authors further acknowledge the technical contributions of individuals who have reviewed
detailed results of the model (and/or earlier versions of the model) and/or provided specific
suggestions regarding the model’s design. Among these individuals are Steve Plotkin and
Michael Wang of the Department of Energy’s Argonne National Laboratory, Jeff Alson, William
Charmley, Ben Ellies, David Haugen, Ari Kahan, Richard Rykowski, and Todd Sherwood of the
U.S. Environmental Protection Agency (EPA), Gary Rogers of FEV Engine Technology, Inc.,
David Boggs, Anrico Casadei, Scott Ellsworth, and Sandy Stojkovski of Ricardo, Inc., Jamie
Hulan of Transport Canada, and Jonathan Rubin of the University of Maine.
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Chapter One Introduction

The Energy Policy and Conservation Act (EPCA), as amended by the Energy Independence and
Security Act of 2007 (EISA), requires the National Highway Traffic Safety Administration
(NHTSA), an agency within the U.S. Department of Transportation (DOT), to promulgate and
enforce Corporate Average Fuel Economy (CAFE) standards. NHTSA has been administering
these standards since 1975.

The Volpe National Transportation Systems Center (Volpe Center) provided technical support to
the Department in connection with the establishment of the CAFE program in the 1970s, and has
continued to provide such support since that time. The Volpe Center is a Federal fee-for-service
organization within DOT.

In 2002, the Volpe Center began developing a new modeling system to support NHTSA’s
analysis of options for future CAFE standards. Objectives included, but were not limited to, the
following: the ability to utilize detailed projections of light vehicle fleets to be produced for sale
in the United States, the ability to efficiently estimate how manufacturers could apply available
technologies in response to CAFE standards, the ability to quickly evaluate various options for
future CAFE standards, and the ability to estimate a range of outcomes (in particular, changes in
fuel consumption and emissions) resulting from such standards.

Since 2002, the Volpe Center has made many changes to this modeling system. Some changes
were made in response to comments submitted to NHTSA in connection with CAFE
rulemakings, and in response to a formal peer review of the system. Some changes were made
based on observations by NHTSA and Volpe Center technical staff. As NHTSA began
evaluating attribute-based CAFE standards (i.e., standards under which CAFE requirements
depend on the mix of vehicles produced for U.S. sale), significant changes were made to enable
evaluation of such standards. At the same time, the system was expanded to provide the ability to
perform uncertainty analysis by randomly varying many inputs. Later, the system was further
expanded to provide automated statistical calibration of attribute-based standards, through
implementation of Monte Carlo techniques, as well as automated estimation of stringency levels
that meet specified characteristics (such as maximizing estimated net benefits to society). In
2007, NHTSA and Volpe Center staff worked with technical staff of the U.S. Environmental
Protection Agency (EPA) on major changes to the range of fuel-saving technologies
accommodated by the model, as well as the logical pathways for applying such technologies. In
2008, NHTSA and Volpe Center staff collaborated on further revisions, particularly with respect
to the representation of available fuel-saving technologies, support for the reexamination of
which was provided by Ricardo, Inc. In support of the 2010 rulemaking, a multi-year technology
application feature was introduced into the modeling system. In 2011, a feature to evaluate
voluntary overcompliance has been added as well.

In 2014, the system was adapted and expanded to allow NHTSA and Volpe Center staff to
perform analysis in support of the medium duty rulemaking. As such, a new regulatory class,
covering class 2b and class 3 pickups and vans, was introduced into the modeling system. To
better illustrate the behavior of the industry, a feature allowing technologies to be inherited
between vehicle platforms, engines, and transmissions has been reintroduced into the modeling



system as the primary mode of operation. In 2016, the modeling system was further refined to
allow simultaneous analysis of light duty and medium duty fleets, accounting for potential
interaction between shared platforms, engines, and transmissions. Additionally, in 2016, the
modeling system has undergone a major overhaul to allow for integration of vehicle simulation
results from Argonne National Laboratory’s Autonomie model.



Chapter Two System Design
Section 1 Overall Structure

The basic design of the CAFE Model developed by the Volpe Center is as follows: The system
first estimates how manufacturers might respond to a given CAFE scenario, and from that the
system estimates what impact that response will have on fuel consumption, emissions, and
economic externalities. A CAFE scenario involves specification of the form, or shape, of the
standards (e.g., flat standards, linear or logistic attribute-based standards, scope of passenger car
and truck regulatory classes), and stringency of the CAFE standard in each model year to be
analyzed.

Manufacturer compliance simulation and effects estimation encompass numerous subsidiary
elements. Compliance simulation begins with a detailed initial forecast, provided by the user, of
the vehicle models offered for sale during the simulation period. The compliance simulation then
attempts to bring each manufacturer into compliance with CAFE standards defined in an input
file developed by the user; for example, CAFE standards that increase in stringency by 4 percent
per year for 5 consecutive years, and so forth. The model sequentially applies various
technologies to different vehicle models in each manufacturer’s product line in order to simulate
how a manufacturer might make progress toward compliance with CAFE standards. Subject to a
variety of user-controlled constraints, the model applies technologies based on their relative cost-
effectiveness, as determined by several input assumptions regarding the cost and effectiveness of
each technology, the cost of CAFE-related civil penalties, and the value of avoided fuel
expenses. For a given manufacturer, the compliance simulation algorithm applies technologies
either until the manufacturer achieves compliance, or until the manufacturer exhausts all
available technologies, or, if the manufacturer is assumed to be willing to pay civil penalties,
until paying civil penalties becomes more cost-effective than increasing vehicle fuel economy.
The user may disable the civil penalty paying option for manufacturers expected to be unwilling
to pay them, thus effectively “forcing” the manufacturer to add additional technology even once
it might otherwise be preferable to pay penalties (considering the cost to add further technology
as compared to the estimated value of the resultant saved fuel). At this stage, the system assigns
an incurred technology cost and updated fuel economy to each vehicle model, as well as any
civil penalties incurred by each manufacturer.

This point marks the system’s transition between compliance simulation and effects calculations.
At the conclusion of the compliance simulation for a given model year, the system contains a
new fleet of vehicles with new prices, fuel types (e.g., diesel, electricity), fuel economy values,
and curb weights that have all been updated to reflect the application of technologies in response
to CAFE requirements. For each vehicle model in this fleet, the system then estimates the
following: lifetime travel, fuel consumption, and carbon dioxide and criteria pollutant emissions.
After aggregating model-specific results, the system estimates the magnitude of various
economic externalities related to vehicular travel (e.g., noise) and energy consumption (e.g., the
economic costs of short-term increases in petroleum prices).

Different categorization schemes are relevant to different types of effects. For example, while a
fully disaggregated fleet is retained for purposes of compliance simulation, vehicles are grouped



by type of fuel and regulatory or vehicle class for the energy, carbon dioxide, criteria pollutant,
and fatalities calculations. The system may be expanded in the future to represent CAFE-induced
market responses (i.e., mix shifting), in which case such calculations would group vehicles by
market segment. Therefore, this system uses model-by-model categorization and accounting
when calculating most effects, and aggregates results only as required for efficient reporting.



Section 2 CAFE Compliance Simulation
S2.1 Compliance Simulation Algorithm

Each time the modeling system is used, it evaluates one or more CAFE scenarios. Each of these
scenarios is defined in the “scenarios” input file described in Section A.4 of Appendix A. Each
scenario describes an overall CAFE program in terms of the program’s coverage, applicability of
multi-fuel vehicles, the structure and stringency of the standards applicable to passenger cars,
lights trucks, and class 2b and 3 trucks, as well as other miscellaneous settings that may have an
impact on compliance. The system is normally used to examine and compare at least two
scenarios. The first scenario is identified as the baseline scenario, usually defined as the world in
the absence of new CAFE standards (which itself can be considered in a variety of ways),
providing results to which results for any other scenarios are compared. Although many
scenarios can be examined with each run of the model, for simplicity in this overview, we will
only describe one scenario occurring in one model year.

The compliance simulation applies technology to each manufacturer’s product line based on the
CAFE program described by the current scenario, the assumed preference of each manufacturer
to pay civil penalties rather than complying with the program, and the degree of voluntary
overcompliance allowed by the system. The first step in this process involves definition of the
fleet’s initial state — that is, the volumes, prices, and attributes of all vehicles as projected
without knowledge of future CAFE standards — during the study period, which can cover one or
more consecutive model years (MYs). The second step involves evaluating the applicability of
each available technology to each vehicle model, platform, engine, and transmission in the fleet.
The third and final step involves the repeated application of technologies to specific vehicle
models, platforms, engines, and transmissions in each manufacturer’s fleet. For a given
manufacturer, this step terminates when CAFE standards have been achieved or all available
technologies have been exhausted. Alternatively, if the user specifies that some or all
manufacturers should be considered to prefer to pay civil penalties for noncompliance, this step
terminates when it would be less expensive to pay such penalties than to continue applying
technology. Furthermore, if the system has been configured to evaluate voluntary
overcompliance, this step would not terminate until all cost-effective solutions, for all
manufacturers, were applied, beyond what is necessary to meet the CAFE standard.

S2.1.1 Initial State of the Fleet

The fleet’s initial state is developed using information contained in the vehicle models, engine,
and transmission worksheets described in Section A.1 of Appendix A. The set of worksheets
uses identification codes to link vehicle models to appropriate engines and transmissions. Figure
1 provides a simplified example illustrating the basic structure and interrelationship of these
three worksheets, focusing primarily on structurally important inputs. These identification codes
make it possible to account for the use of specific engines or transmissions across multiple
vehicle models. They also help the compliance simulation algorithm to realistically “carry over”
technologies between model years.



Vehicle Models Worksheet

Veh Sales MSRP Engine Transmission
Model | FE
ID MY1l | MY12 | MY1l | MY12 Code Code
1 | vehl |20.95| 11,516 | 10,963 | 27,500 | 28,875 1 2
2 | veh2 |21.78| 93,383 | 97,767 | 23,000 | 24,150 1 3
3 | veh3 |18.33| 46,880 | 49,367 | 31,250 | 32,813 | 2 /4
4 | vehs |22.02| 65,054 | 68,505 | 24,250 | 25463 | 3 / 3
5 | Veh5 | 18.51| 21,843 | 25,838 | 31,500 33y§ 4 4
Engine Worksheet /
I
Eng . Valves per
D Ny/ Fuel Cyl [Displagement Cylinder
1} Engt G 6 / 35 2
»
2 Eng?2 G 8 |/ 4 2
3 Eng3 G 6 / 35 4
4 Eng4 G 8/ 4 4
Transmission Work gheet
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> ¥V na T 4 A
3 A5 T 5 A
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Figure 1. Basic Structure of Input File Defining the Fleet’s Initial State




S2.2 Vehicle Technology Application within the CAFE Model

Vehicle technologies provide a set of possible improvements available for the vehicle fleet
within the modeling system. The input assumptions for vehicle technologies, referred to below
simply as “technologies”, are defined by the user in the technology input file for the model. As
part of the technology definition, the input file includes: additional cost associated with
application of the technology, an improvement factor (in terms of percent reduction of fuel
consumption), initial year that the technology may be considered for application, whether it is
applicable to a given class of vehicle, as well as other miscellaneous assumptions outlining
additional technology characteristics. Section A.2 of Appendix A describes all technology
attributes in greater detail.

Internally, the system also assigns intrinsic properties for each technology defining the
application schedule (further restricting when a technology may be considered for application)
and the application level (controlling the scope of a technology’s applicability). The application
schedule determines whether a technology may be applied during a vehicle’s redesign year only,
during a vehicle’s refresh or redesign years, or if the technology is defined as part of the baseline
input fleet and is not available for application during modeling. The application level indicates
whether the technology is vehicle-level, in which case it may be applied directly to individual
vehicles, or if the technology is platform, engine, or transmission-level, in which case it will be
applied to all vehicles that share a common platform, engine, or transmission.

The following two tables outline all technologies available within the modeling system, along
with their application levels and schedules:



Table 1. CAFE Model Technologies (1)

Application | Application .
Technology LE\?eI th% dule Description
SOHC Engine Baseline Only Single Overhead Camshaft Engine
DOHC Engine Baseline Only Double Overhead Camshaft Engine
OHV Engine Baseline Only Overhead Valve Engine
TEFRI Engine Redesign Only Engine Friction Reduction Improvements (time-based)
LUBEFR1 Engine Refresh/Redesign Imp_roved .LO_W Friction_Lubricants and

Engine Friction Reduction

LUBEFR2 Engine Redesign Only LUBEFR2, Level 2
LUBEFR3 Engine Redesign Only LUBEFR2, Level 3
VVT Engine Refresh/Redesign | Variable Valve Timing
VVL Engine Redesign Only Variable Valve Lift
SGDI Engine Redesign Only Stoichiometric Gasoline Direct Injection
DEAC Engine Redesign Only Cylinder Deactivation
HCR Engine Redesign Only High Compression Ratio Engine
HCRP Engine Redesign Only High Compression Ratio "Plus" Engine
TURBO1 Engine Redesign Only Turbocharging and Downsizing, Level 1 (18 bar)
SEGR Engine Redesign Only Stoichiometric Exhaust Gas Recirculation
DWSP Engine Redesign Only Engine Downspeeding
TURBO?2 Engine Redesign Only Turbocharging and Downsizing, Level 2 (24 bar)
CEGR1 Engine Redesign Only Cooled Exhaust Gas Recirculation, Level 1 (24 bar)
CEGR1P Engine Redesign Only Cooled Exhaust Gas Recirculation, Level 1 "Plus" (24 bar)
CEGR?2 Engine Redesign Only Cooled Exhaust Gas Recirculation, Level 2 (27 bar)
HCR2 Engine Redesign Only Advanced High Compression Ratio Engine
CNG Engine Baseline Only Compressed Natural Gas Engine
ADSL Engine Redesign Only Advanced Diesel
TURBODSL | Engine Redesign Only Improved Diesel Turbocharger
DWSPDSL | Engine Redesign Only Diesel Engine Downspeeding with Increased Boost
EFRDSL Engine Redesign Only Diesel Engine Friction Reduction
CLCDSL Engine Redesign Only Closed Loop Combustion Control
LPEGRDSL | Engine Redesign Only Low Pressure Exhaust Gas Recirculation
DSIZEDSL | Engine Redesign Only Diesel Engine Downsizing

In Table 1 above, note that SOHC, DOHC, and OHV engine technologies are defined as
baseline-only. These technologies are used to inform the modeling system of the input engine’s
configuration in order to correctly account for synergy adjustments of fuel consumption
improvement factors (technology synergies are further discussed below). Note that CNG engine
technology is defined as baseline-only as well. While it may be present in the input fleet, this
technology is not directly applicable by the model.



Table 2. CAFE Model Technologies (2)

Application | Application s

Technology Lg\?el Scphi dule Description
MT5 Transmission | Baseline Only 5-Speed Manual Transmission
MT6 Transmission | Redesign Only 6-Speed Manual Transmission
MT7 Transmission | Redesign Only 7-Speed Manual Transmission
TATI Transmission | Refresh/Redesign | Automatic Transmission Improvements (time-based)
AT5 Transmission | Baseline Only 5-Speed Automatic Transmission
AT6 Transmission | Redesign Only 6-Speed Automatic Transmission
AT6P Transmission | Redesign Only 6-Speed "Plus" Automatic Transmission
AT8 Transmission | Redesign Only 8-Speed Automatic Transmission
AT8P Transmission | Redesign Only 8-Speed "Plus" Automatic Transmission
DCT6 Transmission | Redesign Only 6-Speed Dual Clutch Transmission
DCT8 Transmission | Redesign Only 8-Speed Dual Clutch Transmission
CVT Transmission | Redesign Only Continuously Variable Transmission
EPS Vehicle Refresh/Redesign | Electric Power Steering
IACC1 Vehicle Refresh/Redesign | Improved Accessories - Level 1

. . Improved Accessories - Level 2
IACC2 Vehicle Refresh/Redesign (w/p Alternator Regen and 70% Efficient Alternator)
SS12v Vehicle Refresh/Redesign | 12V Micro-Hybrid (Stop-Start)
BISG Vehicle Redesign Only Belt Mounted Integrated Starter/Generator
CISG Vehicle Redesign Only Crank Mounted Integrated Starter/Generator
SHEVP2 Vehicle Redesign Only P2 Strong Hybrid/Electric Vehicle
SHEVPS Vehicle Redesign Only Power Split Strong Hybrid/Electric VVehicle
PHEV30 Vehicle Redesign Only 30-mile Plug-In Hybrid/Electric Vehicle
PHEV50 Vehicle Redesign Only 50-mile Plug-In Hybrid/Electric Vehicle
BEV200 Vehicle Redesign Only 200-mile Electric Vehicle
FCV Vehicle Redesign Only Fuel Cell Vehicle
LDB Vehicle Refresh/Redesign | Low Drag Brakes
SAX Vehicle Refresh/Redesign | Secondary Axle Disconnect
ROLL10 Vehicle Refresh/Redesign | Low Rolling Resistance Tires, Level 1 (10% Reduction)
ROLL20 Vehicle Refresh/Redesign | Low Rolling Resistance Tires, Level 2 (20% Reduction)
MR1 Platform Refresh/Redesign | Mass Reduction, Level 1 (5% Reduction in Glider Weight)
MR2 Platform Redesign Only Mass Reduction, Level 2 (7.5% Reduction in Glider Weight)
MR3 Platform Redesign Only Mass Reduction, Level 3 (10% Reduction in Glider Weight)
MR4 Platform Redesign Only Mass Reduction, Level 4 (15% Reduction in Glider Weight)
MR5 Platform Redesign Only Mass Reduction, Level 5 (20% Reduction in Glider Weight)
AERO10 Platform Refresh/Redesign | Aero Drag Reduction, Level 1 (10% Reduction)
AERO20 Platform Redesign Only Aero Drag Reduction, Level 2 (20% Reduction)

In Table 2 above, note that MT5 and AT5 transmission technologies are both defined as
baseline-only. While they may be present in the input fleet, these technologies are not directly
applicable by the model.

The modeling system defines several technology classes and pathways for logically grouping all
available technologies for application on a vehicle. Technology classes provide costs and
improvement factors shared by all vehicles with similar body styles, curb weights, footprints, and
engine types, while technology pathways establish a logical progression of technologies on a

vehicle.




S2.2.1 Technology Classes

The modeling system defines two types of technology classes: the vehicle technology classes and
the engine technology classes. The system utilizes vehicle technology classes as a means for
specifying common technology input assumptions for vehicles that share similar characteristics.
Predominantly, these classes signify the degree of applicability of each of the available
technologies to a specific class of vehicles, as well as determine the base improvement factors
attributed to those technologies. Furthermore, for each technology, the vehicle technology
classes also define the amount by which the vehicle’s weight may decrease (resulting from
application of mass reducing technology), and the additional cost associated with application of

non-engine-level technologies.

The model supports seven vehicle technology classes as shown in Table 3:

Table 3. Vehicle Technology Classes

Class Description

SmallCar Small passenger cars

MedCar Medium to large passenger cars

SmallSUV Small sport utility vehicles and station wagons

MedSUV Medium to large sport utility vehicles, minivans, and passenger vans
Pickup Light duty pickups and other vehicles with ladder frame construction
Truck 2b/3 Class 2b and class 3 pickups

Van 2b/3 Class 2b and class 3 cargo vans

Since the costs attributed to application of engine-level technologies vary based upon the engine
configuration (such as number of engine cylinders or banks), the model defines separate engine
classes for specifying input costs for these technologies. The modeling system provides sixteen

engine technology classes as shown in Table 4:

Once the inputs for technology classes are defined, the user would assign each vehicle in the
input fleet to use an appropriate vehicle and engine technology classes. The model would then

Table 4. Engine Technology Classes

Class Description

2C1B SOHC/DOHC engine with 2 cylinders and 1 bank
3C1B SOHC/DOHC engine with 3 cylinders and 1 bank
4C1B SOHC/DOHC engine with 4 cylinders and 1 bank
4C2B SOHC/DOHC engine with 4 cylinders and 2 banks
5C1B SOHC/DOHC engine with 5 cylinders and 1 bank
6C1B SOHC/DOHC engine with 6 cylinders and 1 bank
6C1B_ohv | OHV engine with 6 cylinders and 1 bank

6C2B SOHC/DOHC engine with 6 cylinders and 2 banks
6C2B_ohv | OHV engine with 6 cylinders and 2 banks

8C2B SOHC/DOHC engine with 8 cylinders and 2 banks
8C2B_ohv | OHV engine with 8 cylinders and 2 banks

10C2B SOHC/DOHC engine with 10 cylinders and 2 banks
10C2B_ohv | OHV engine with 10 cylinders and 2 banks

12C2B SOHC/DOHC engine with 12 cylinders and 2 banks
12C4B SOHC/DOHC engine with 12 cylinders and 4 banks
16C4B SOHC/DOHC engine with 16 cylinders and 4 banks
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use the technology class assignments to obtain the appropriate applicability, improvement factor,
and cost for each technology as appropriate for an individual vehicle.

S2.2.2 Technology Pathways

The modeling system defines technology pathways for grouping and establishing a logical
progression of technologies on a vehicle. Each pathway (or path) is evaluated independently and
in parallel, with technologies on these paths being iterated in sequential order. As the model
traverses each path, the costs and improvement factors are accumulated on an incremental basis
with relation to the preceding technology. The system stops examining a given path once a
combination of one or more technologies results in a “best” technology solution for that path.*
After evaluating all paths, the model selects a most cost-effective solution among all pathways.
This “parallel path” approach allows the modeling system to progress thorough technologies in
any given pathway without being unnecessarily prevented from considering technologies in other
paths.

The modeling system incorporates thirteen technology pathways for evaluation as shown in
Table 5. Similar to individual technologies, each path carries an intrinsic application level that
denotes the scope of applicability of all technologies present within that path, and whether the
pathway is evaluated on one vehicle at a time, or on a collection of vehicles that share a common
platform, engine, or transmission.

Table 5. Technology Pathways

Technology Pathway Application Level
Basic Engine Path Engine
Turbo Engine Path Engine
Advanced Engine Path Engine
Diesel Engine Path Engine
Manual Transmission Path Transmission
Automatic Transmission Path Transmission
Electrification Path Vehicle
Hybrid/Electric Path Vehicle
Advanced Hybrid/Electric Path Vehicle
Dynamic Load Reduction Path Vehicle

Low Rolling Resistance Tires Path | Vehicle
Mass Reduction Path Platform
Aerodynamic Improvements Path | Platform

The technologies that comprise the four Engine-Level paths available within the model are
presented in Figure 2 below. Note that the baseline-level technologies (SOHC, DOHC, OHV,
and CNG) are grayed out. As mentioned earlier, these technologies are used to inform the

1 Within the context of the compliance simulation, “best” is defined from the manufacturers’ perspective. The
system assumes that the manufacturer will seek to progress through the technology pathways in a manner that
minimizes effective costs, which include (a) vehicle price increases associated with added technologies, (b) for
manufacturers that prefer to pay civil penalties, reductions in civil penalties owed for noncompliance with CAFE
standards, (c) the value vehicle purchasers are estimated to place on fuel economy, and (d) any changes in consumer
valuation attributed to the added technologies.
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modeling system of the input engine’s configuration, and are not otherwise applicable during the
analysis.

:Basic Engine Path i iTurbo Eng.Path | Adv.Eng.Path | :Diesel Eng.Path |
SOHC DOHC oHv | i i | Turso1 | i i | HcR2 | i i | ADsL
N v P J . P ¢
LUBEFR1 P seer | i CNG : i | TurBDSL
LUBEFR2 | pwse | \ | pwsppsL
LUBEFR3 i 1| TurBO2 | i | EFrDsL
wWT 0| ceer1 | i | cLeost
WL i 1| cEGRip | : | LPEGRDSL
SGDI 1| ceGR2 | : | Dsizebst
N
DEAC HCR
HCRP

Figure 2. Engine-Level Paths

For all pathways, the technologies are evaluated and applied to a vehicle in sequential order, as
shown, from top to bottom. In some cases, however, if a technology is deemed ineffective, the
system will bypass it and skip ahead to the next available technology. If the modeling system
applies a technology that resides later in the pathway, it will “backfill” anything that was
previously skipped in order to fully account for costs and improvement factors, each of which are
specified on an incremental basis. For any technology that is already present on a vehicle (either
from the input fleet or previously applied by the model), the system skips over those
technologies as well and proceeds to the next. These skipped technologies, however, will not be
applied again during backfill.

The Basic Engine path begins with SOHC, DOHC, and OHV technologies defining the initial
configuration of the vehicle’s engine. Since these technologies are not available during
modeling, the system evaluates this pathway starting with LUBEFR1 technology. Toward the
end of the path, the model encounters a choice between DEAC and HCR technologies.
Whenever a technology pathways forks into two or more branch points, all of the branches are
treated as mutually exclusive. The system evaluates all technologies forming the branch, and
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selects the most costs-effective for application, while disabling the remaining. In the case of the
Basic Engine path, that means if a vehicle continues with application of the DEAC technology,
the HCR and HCRP technologies will be disabled. Likewise, if the vehicle applies the HCR
technology, the HCRP technology will still be available for evaluation, while the DEAC
technology will be disabled.

The technologies exposed by the Advanced Engine path (HCR2 and CNG) are not incremental
over each other and do not follow a traditional progression logic present on other paths.
Consequently, these technologies are treated as mutually exclusive within the model. Since CNG
is a baseline-level technology, the only remaining choice for application within the Advanced
Engine path is HCR2.

The technologies that make up the two Transmission-Level paths defined by the modeling
system are shown in Figure 3 below. The baseline-level technology (MT5 and AT5) are grayed
and are only used to signify the initial configuration of the vehicle’s transmission. For simplicity,
all manual transmissions with five forward gears or fewer should be assigned the MT5
technology in the input fleet. Similarly, all automatic transmissions with five forward gears or
fewer should be assigned the AT5 technology.

iManual Trn. Path{ Automatic Transmission Path

MTS5 ATS

) /N
MT6 AT6 DCT6
T— | T T
MT7 . AT6P DCT8

CVT AT8

|}

AT8P

Figure 3. Transmission-Level Paths

Given the definition of incremental costs and fuel consumption improvement factors utilized
during the analysis, the system assumes that all manual transmissions with seven or more gears
are mapped to the MT7 technology. Moreover, the AT8 technology should map to all automatic
transmissions with seven or more forward gears, DCT6 technology should map to all dual-clutch
(DCT) or auto-manual (AMT) transmissions with five or six forward gears, and DCT8
technology should map to all DCT’s or AMT’s with seven or more forward gears. These
transmission technology utilization assignments, however, are defined within the input fleet, and
are not strictly enforced by the modeling system.
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As mentioned earlier, the branch points, as shown in the Automatic Transmission path, are
mutually exclusive. For example, if a vehicle transitions to the DCT branch, the CVT and all

ATn technologies will become unavailable.

The technologies that compose the two Platform-Level paths provided by the model are

displayed in Figure 4 below.

!MR Path

:AERO Path

MR1

Figure 4. Platform-Level Paths

AERO10

J

AERO20

The technologies that constitute the five Vehicle-Level paths defined by the system are outlined

in Figure 5 below.

iElectrification Path

iHybrid/Electric Path

EPS SHEVP2 SHEVPS
IAccL Advanced Hybrid/leciric path ]
IACC2 PHEV30
SS12V PHEV50
4N 4N
BISG CISG BEV200 FCV

Figure 5. Vehicle-Level Paths

iDLR Path {ROLL Path
LDB ROLL10
SAX ROLL20

The technologies on the Hybrid/Electric path (SHEVP2 and SHEVPS) are defined as stand-alone
and mutually exclusive. These technologies are not incremental over each other and do not
follow a traditional progression logic present on other paths.

14



Even though the model evaluates each technology path independently, some of the pathways are
interconnected to allow for additional logical progression and incremental accounting of
technologies. For example, the SHEVPS (power-split strong hybrid/electric) technology on the
Hybrid/Electric path is defined as incremental over the DEAC (cylinder deactivation) technology
on the Basic Engine path, the AT5 (5-speed automatic) technology on the Automatic
Transmission path, and the CISG (crank mounted integrated starter/generator) technology on the
Electrification path. For that reason, whenever the system evaluates the SHEVPS technology for
application on a vehicle, it ensures that, at a minimum, all the aforementioned technologies (as
well as their predecessors) have already been applied on that vehicle.

Of the thirteen technology pathways present in the model, all Engine paths, the Automatic
Transmission path, the Electrification path, and both Hybrid/Electric paths are logically linked
for incremental technology progression. This relationship between pathways is illustrated in
Figure 6 below.

. . Automatic Manual .
Basic Engine L. L. Electrification
- Transmission [ Transmission
Path Path
Path Path
\ 4 \ 4
Turbo Engine «| Hybrid/Electric
Path - Path
| Vv v
. Advanced
Advanced Engine . )
Hybrid/Electric
Path
Path
Diesel Engine
Path
. Aerodynamic Dynamic Load Low Rolling
Mass Reduction . . )
Improvements Reduction Resistance Tires
(MR) Path
(AERO) Path (DLR) Path (ROLL) Path

Figure 6. Technology Pathways Diagram

Some of the technology pathways, as defined in the CAFE model and shown in the diagram
above, may not be compatible with a vehicle given its state at the time of evaluation. For
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example, a vehicle with a 6-speed automatic transmission will not be able to get improvements
from a Manual Transmission path. For this reason, the system implements logic to explicitly
disable certain paths whenever a constraining technology from another path is applied on a
vehicle. On occasion, not all of the technologies present within a pathway may produce
compatibility constraints with another path. In such a case, the system will selectively disable a
conflicting pathway (or part of the pathway) as required by the incompatible technology. The
precise logic for conflicting pathways defined within the model is shown in the table below:

Table 6. Technology Pathway Compatibility Logic
Technology Pathway Conflicting Pathways Disabled in the Model
Advanced Engine Path
Diesel Engine Path
Turbo Engine Path
Advanced Engine Path Diesel Engine Path
Both Hybrid/Electric Paths (except if HCR2-only is used)
Turbo Engine Path
Diesel Engine Path Advanced Engine Path
Both Hybrid/Electric Paths
Automatic Transmission Path
Manual Transmission Path Electrification Path (only micro-/mild-HEV technologies)
Both Hybrid/Electric Paths
Automatic Transmission Path | Manual Transmission Path
. . Turbo Engine Path (except if SHEVP2-only is used)

Hyb”d{EleCt”C Paths Advanced Engine Path (except if SHEVP2-only is used)
(including adv. H/E) : -

Diesel Engine Path

Turbo Engine Path

In addition to the logic described in Table 6, for any interlinked technology pathways shown in
Figure 6 above, the system also disables all preceding technology paths whenever a vehicle
transitions to a succeeding pathway. For example, if the model applies SHEVPS technology on a
vehicle, the system disables the Turbo, Advanced, and Diesel Engine paths (as defined above), as
well as the Basic Engine, the Automatic Transmission, and the Electrification paths (all of which
precede the Hybrid/Electric path).?

S2.2.3 Technology Applicability

The modeling system determines the applicability of each technology on a vehicle, engine,
transmission, or platform using the combination of technology input assumptions and the
technology utilization settings defined in the input fleet (as specified in the market data input
file).3

For each vehicle technology class (discusses above), the technology input assumptions provide
the Applicable, Year Available, and Year Retired fields that control the scope of applicability of
each technology. If the Applicable field is set to FALSE for a specific technology, that
technology will not be available for evaluation. Conversely, if this field is set to TRUE, the

2 The only notable exception to this rule occurs whenever SHEVP2 technology is applied on a vehicle. This
technology may be present in conjunction with any engine-level technology, and as such, the Basic Engine path is
not disabled upon application of SHEVP2 technology, even though this pathway precedes the Hybrid/Electric path.

3 The technology utilization section is described in Sections A.1.2, A.1.3, and A.1.4 of Appendix A.
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technology will be available for application. Furthermore, the Year Available and Year Retired
fields determine the minimum and maximum model years during which the technology may be
considered by the modeling system. Additionally, technology phase-in caps may limit the
availability of technologies if a particular penetration rate is reached for a vehicle’s manufacturer
in a model year being evaluated.

In the market data input file, the worksheets describing each vehicle model, engine, and
transmission selected for simulation provide the Technology Information sections that are used to
define the initial technology utilization state of the input fleet. Each of the CAFE model
technologies listed in Table 1 and Table 2 above are referenced on these worksheets as
appropriate, based on the application-level of the technology. The user determines which
technologies are initially present in the input fleet, given the characteristics of each vehicle,
engine, and transmission. Since the modeling system relies heavily on the Technology
Information settings, these sections must accurately and completely represent the initial state of
each vehicle, platform, engine, and transmission in order to avoid potential modeling errors.

Lastly, the logical restrictions imposed by the technology pathways described above further
restrict the applicability of technologies should any compatibility issues arise during modeling.

S2.2.4 Technology Evaluation and Inheriting

Once the system determines the applicability of all technologies, it may begin evaluating them
for application on a vehicle. As stated before, the system examines each pathway sequentially,
bypassing and backfilling technologies whenever necessary. The model considers and applies
redesign-based technologies (as defined in Table 1 and Table 2 above) whenever a vehicle is at a
redesign, while refresh-based technologies may be considered during a vehicle’s refresh or
redesign years.

When the system evaluates platform, engine, or transmission-level technologies, since the
technology being analyzed directly modifies a shared vehicle component*, the resultant
improvements must be considered on all vehicles that utilize a common platform, engine, or
transmission simultaneously. During modeling, the system elects a “leader” vehicle, with all
technology improvements being realized on that vehicle first, and afterwards, propagated down
to the remainder of the vehicles (known as the “followers”) that share the leader’s platform,
engine, or transmission. As such, new technologies are initially evaluated and applied to a leader
vehicle during its refresh or redesign year (as appropriate for a specific technology). Any
follower vehicles that share the same redesign and/or refresh schedule as the leader apply these
technology improvements during the same model year. The rest of the followers inherit refresh-
based technologies from a leader vehicle during a follower’s respective refresh or redesign year,
while redesign-based technologies are inherited on a follower vehicle during its redesign year
only.

4 For the purposes of CAFE modeling, a vehicle component is defined as any major vehicle block that maintains its
own production line and is utilized on multiple vehicles at a time. Vehicle platforms, engines, and transmissions are
all considered to be vehicle components from the model’s perspective.
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The system dynamically assigns a leader vehicle for each platform, engine, and transmission
during analysis, based on the following criteria:

1) For vehicle platforms only, the system first determines which of the shared vehicles have
the highest degree of platform-level technology utilization,®

2) The system filters out (ignores) vehicles that have production volumes in only a few
analysis years,

3) From the filtered list of vehicles, the system selects a vehicle model with the lowest
production volumes (averaged across all analysis years) as the leader,

4) If multiple vehicles are selected (that is, they all have the same average production
volumes), the vehicle with the highest MSRP is then chosen as the leader.

Note that, since platforms, engines, and transmissions do not always encompass the same set of
vehicles, a vehicle chosen as the leader of an engine may not necessarily be selected as a leader
of a platform or transmission.

Since vehicle-level technologies affect only one vehicle at a time, all technology improvements
are applied immediately to just the one vehicle model during its refresh or redesign year.

S2.2.5 Technology Fuel Consumption Improvement Factors

The technology input assumptions define the base fuel consumption improvement factor FC for
each modeled technology. The FC value is defined on a gallons-per-mile basis and represents a
percent reduction in vehicle’s fuel consumption value. The formula to find the resulting increase
in fuel economy (miles-per-gallon) of a vehicle with fuel consumption reduction factors from
one or more technologies is defined as:

1 1 1

FE =FE, ;, X X eee X
new 9T (1=FCy)  (1-FC) (1-FCy)

)

FEorig : the original fuel economy for the vehicle,

FCoz,..n: the fuel consumption improvement factors attributed to the 0-th to n-th
technologies, and

FEnew : the resulting fuel economy for the same vehicle.

For approximately two-thirds of the technologies represented within the modeling system, the
fuel consumption improvement factors were derived from a database containing detailed vehicle
simulation results, analyzed at Argonne National Laboratory using the Autonomie model. In
order to incorporate the results of the Argonne database, while still preserving the basic structure

5> Unlike engines and transmissions, the vehicle platforms are not discretely defined in the market data input file.
Instead, technology utilization of platform-level technologies is attributed to individual vehicles. Therefore, on
occasion, vehicles that share a common platform may begin the analysis with varying degrees of platform-level
technologies. For this reason, the system begins the leader selection process by first filtering for vehicles with the
highest utilization of these technologies.

18



of the CAFE model’s technology subsystem, it was necessary to translate the points in the
database into corresponding locations defined by the technology pathways, described in Section
S2.2.2 above. By recognizing that most of the pathways are unrelated, and are only logically
linked to allow for incremental technology progression, it is possible to rearrange the paths into a
smaller number of groups and branches by technology type. To achieve this level of linearity, we
define following technology groups: engine cam configuration (CONFIG), engine technologies
(ENG), transmission technologies (TRANS), electrification and hybridization (ELEC), mass
reduction levels (MR), aerodynamic improvements (AERO), and rolling resistance (ROLL).®
The combination of technology levels along each of these paths define a unique technology
combination that corresponds to a single point in the database for each technology class. These
technology state definitions are more important for defining synergies than for determining
incremental effectiveness, but the paths are incorporated into both.

As an example, a technology state vector describing a vehicle with a SOHC engine, variable
valve timing (only), a 6-speed automatic transmission, a belt-integrated starter generator, mass
reduction (level 1), aerodynamic improvements (level 2), and rolling resistance (level 1) would
be specified as SOHC;VVT;AT6;BISG;MR1;AERO20;ROLL10. By assigning each technology
state a vector such as the one in the example, the CAFE model can assign each vehicle in the
analysis fleet an initial state that corresponds to a point in the database. From there, it is
relatively simple to assign a percentage improvement to any new combination of technologies
and apply that percentage improvement to the fuel consumption of a vehicle in the analysis fleet.

Once a vehicle is assigned a technology state (one of the tens of thousands of unique 7-tuples,
defined in the technology input file as CONFIG;ENG;TRANS;ELEC;MR;AERO;ROLL),
adding a new technology to the vehicle simply represents progress from one technology state to
another. Then the formula to find the increase in vehicle’s fuel economy shown in Equation (1)
becomes:

FE, ., = FE,.;, X 1 X 1 X 1 X Sorig @)
e o (1 - FCO) (1 - FCl) (1 - FCn) Snew
Where:

FEorig : the original fuel economy for the vehicle,

FCo,z,..n: the fuel consumption improvement factors attributed to the 0-th to n-th
technologies,

Soirg . the synergy factor associated with the technology state before application of
any of the 0-th to n-th technologies,

Snew . the synergy factor associated with the technology state after application of the

0-th to n-th technologies, and
FEnew : the resulting fuel economy for the same vehicle.

& Since none of the technologies within the Dynamic Load Reduction path were simulated by Argonne, this pathway
is not represented by the technology group combination.
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The synergy factor is defined in a way that captures the incremental improvement of moving
between points in the database, where each point is defined uniquely as a 7-tuple describing its
cam configuration, highest engine technology, transmission, electrification type, mass reduction
level, and level of aerodynamic or rolling resistance improvement.

For some technologies, the modeling system may convert a vehicle or a vehicle’s engine from
operating on one type of fuel to another. For example, application of Advanced Diesel (ADSL)
technology converts a vehicle from gasoline operation to diesel operation. In such a case, the
aforementioned Equations (1) and (2) still apply, however, in each case, the FEnew value is
assigned to the vehicle’s new fuel type, while the fuel economy on the original fuel is discarded.

Moreover, whenever the modeling system converts a vehicle model to a 30-mile Plug-In
Hybrid/Electric Vehicle (PHEV30), that vehicle is assumed to operate simultaneously on
gasoline and electricity fuel types. In this case, the FC and the Secondary FC fields, defined in
the technology input file, are used to estimate the FEnew values on gasoline and electricity,
respectively. In the case of electricity, the Secondary FC field is defined as an improvement over
FEorig on gasoline. For PHEVs, the Secondary FS field specifies the assumed amount of miles
driven by the vehicle when operating on electricity. The vehicle’s overall rated fuel economy is
then defined as the average of the fuel economies on gasoline and electricity, weighted by the
fuel shares.” As the system transitions to PHEV50, the same calculation applies, however, this
time, Secondary FC field is defined as an improvement factor over FEqrig On electricity.

When the system further improves the vehicle, converting it from a PHEV50 to a 200-mile
Electric Vehicle (BEV200), the gasoline fuel component is removed, while the electric-operated
portion remains. In this case, the FC field represents an improvement factor over FEorig On
PHEV50’s electricity component.

Lastly, for non-liquid fuel types, such as CNG, electricity, and hydrogen, the FC improvement
and the resulting FEnew are assumed to be specified in gasoline gallon equivalents of energy use.

S2.2.6 Technology Cost Tables

The technology input assumptions provide a fully “learned-out” table of year-by-year technology
costs, as specified by the Cost Table field. As mentioned earlier, the costs for engine-level
technologies are specified for each engine technology class, while the costs for all other
technologies are defined for each vehicle technology class.

For most of the technologies, the costs provided are used as is. However, for all technologies on
the Mass Reduction path, the input costs are specified on per pound basis, where the base cost
value is multiplied by the amount of pounds by which a vehicle’s glider weight is reduced, in
order to obtain the full cost of applying the technology. Additional effects of mass reduction
technologies are discussed in Section S2.2.7 below.

" The overall fuel economy for PHEVs is the rated value achieved by the vehicle assuming on-road operation
specified by the Secondary FS field. For compliance purposes, the vehicle’s overall fuel economy is determined by
the Multi-Fuel and the PHEV Share parameters defined in the scenarios input file. The scenarios input file is further
discussed in Section A.4 of Appendix A.
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The modeling system also incorporates cost adjustment factors to provide accounting corrections
for technology costs. Since the Basic Engine path (see Figure 2 above) converges from SOHC,
DOHC, and OHYV technologies, and since the base input costs are defined for the DOHC path,
the system necessitates the use of these adjustments in order to offset the costs of some basic
engine technologies used on the SOHC and OHV engines. Given the new structure input file and
logical representation of technologies within the current version of the model, at present, the cost
adjustments for only a few engine technologies are required to be defined in the technologies
input file.

Along with the base Cost Table, the input assumptions also define the Maintenance Cost Table
and the Repair Cost Table. Both of these tables are specified for each model year and account for
the learning effect, wherever applicable. The former identifies the changes in the amount buyers
are expected to pay for maintaining a new vehicle®, while the latter identifies the increases in
non-warranty repair costs attributed to application of additional technology. Additionally, the
input assumptions include the Stranded Capital Table, which associates a penalty cost for each
technology that is replaced (or superseded) prior to fully amortizing the initial investment
associated with that technology.

Further discussion of the technology cost input assumptions can be found in Section A.2 of
Appendix A.

S2.2.7 Application of Mass Reduction Technology

When the modeling system evaluates application of mass reduction technology, the vehicle’s
new payload and towing capacity may be influenced as well by way of adjusting the gross
vehicle weight rating (GVWR) and gross combined weight rating (GCWR) values. The degree
by which GVWR and GCWR are affected is controlled in the scenarios input file through the
Payload Return and Towing Return parameters. The calculation of new GVWR and GCWR are
represented by the following formulas:

GVWR — PayloadReturn X (CW — CWyew),
GVWRypey, = MIN CW.. % (GVWR ©))
new cw MAX
GCWR — TowingReturn X (GVWR — GVWR,.,),
GCWRpew = MIN GVW R ey X (CCWR (4)
new GVWR/ max
Where:

CwW - vehicle’s curb weight prior to application of mass reduction technology,

CWhew . vehicle’s curb weight following application of mass reduction

technology,

8 The maintenance costs may lead to increases in cost to consumers, such as for advanced diesel engines, or in cost
saving to consumers, such as for electric vehicles. In the case of electric vehicles, the cost savings result from
avoiding traditional vehicle maintenance such as engine oil changes.
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GVWR
GVWRnew
GCWR
GCWRnew

TowingReturn
(GVWR
W S MAX

(GCWR
GVWR/ MAX

. vehicle’s GVWR prior to application of mass reduction technology,
. vehicle’s GVWR following application of mass reduction technology,
. vehicle’s GCWR prior to application of mass reduction technology,
. vehicle’s GCWR following application of mass reduction technology,
PayloadReturn :

the % of CW reduction returned to payload capacity,

. the % of GVWR reduction returned to towing capacity,
. the limiting factor, defined for each input vehicle, preventing GVWR

from increasing beyond levels observed among the majority of similar
vehicles, and

. the limiting factor, defined for each input vehicle, preventing GCWR

from increasing beyond levels observed among the majority of similar
vehicles.

Note that this adjustment is only relevant for class 2b and class 3 pickups and vans. In order to
prevent the vehicles in these classes from crossing into the light duty category, and thus be
treated as light duty vehicles for regulatory purposes, the GVWRnew is further capped to prevent
decreasing below 8501 Ibs.
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S2.3 Compliance Simulation Loop

Having determined the applicability of each technology to each vehicle model, platform, engine,
and transmission, the compliance simulation algorithm begins the process of applying
technologies based on the CAFE standards applicable during the current model year. This
involves repeatedly evaluating the degree of noncompliance, identifying the next “best”
technology available on each of the parallel technology paths mentioned above, and applying the
best of these. The algorithm combines some of the pathways, evaluating them sequentially
instead of in parallel, in order to ensure appropriate incremental progression of technologies.
Figure 7 below gives an overview of the process.

The algorithm first finds the best next applicable technology in each of the technology pathways,
then selects the best among these. If a manufacturer is assumed to be unwilling to pay CAFE
civil penalties (or, equivalently, if the user has set the system to exclude the possibility of paying
civil penalties as long as some technology can still be applied), then the algorithm applies the
technology to the affected vehicles. Afterwards, the algorithm reevaluates the manufacturer’s
degree of noncompliance and continues application of technology. Once a manufacturer reaches
compliance (i.e., the manufacturer no longer pays CAFE civil penalties), the algorithm proceeds
to apply any additional technology determined to be cost-effective (as defined below).
Conversely, if a manufacturer is assumed to prefer to pay CAFE civil penalties, the algorithm
only applies technology if it is cost-effective to do so. The algorithm stops applying additional
technology to this manufacturer’s products once no more cost-effective solutions are
encountered.

This process is repeated for each manufacturer present in the input fleet. It is then repeated again

for each modeling year. Once all modeling years have been processed, the compliance
simulation algorithm concludes.
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Whether or not the manufacturer is assumed to be willing to pay CAFE penalties, the algorithm
uses CAFE penalties not only to determine whether compliance has been achieved, but also to
determine the relative attractiveness of different potential applications of technologies.
Whenever the algorithm is evaluating the potential application of a technology, it considers the
effective cost of applying that technology to the group of vehicles in question, and chooses the
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option that yields the lowest effective cost.® The effective cost is used for evaluating the relative
attractiveness of different technology applications, not for actual cost accounting. The
calculation can span multiple modeling years. For example, if the candidate technology was
enabled for application in a previous year and not used, then it can remain as a candidate to be
applied and then carried forward to the current model year. The effective cost obtained from
application of a set of one or more candidate technologies on a cohort of vehicles k is defined by
the following formula:

Ziek(zj=MY TECHCOST;; — TECHVALUE; ; — (VALUEgyg,);, j) + AFINEy

j=BaseMY 5
COSTers = TOTALSALES ©
Where:
MY . the model year being analyzed for compliance,
BaseMY . the first model year of the potential application of candidate
technologies (can be less than or equal to MY),
TECHCOSTi,; : the total cost off all candidate technologies evaluated on vehicle i in
model year j,
TECHVALUE;;: the net change in consumer valuation of all candidate technologies
evaluated on vehicle i in model year j,
(VALUEFueL)ij : the value of the reduction in fuel consumption resulting from
application off all candidate technologies evaluated on vehicle i in
model year j,
AFINEmy . the reduction in manufacturer’s fines in the analysis year MY (or zero, if

the manufacturer prefers not to pay fines or the compliance scenario
being evaluated does not allow fine payment for a specific regulatory
class), and

TOTALSALES : the total sales volume of all affected vehicles in cohort k covering
model years between BaseMY and MY.

The value of the reduction in fuel consumption achieved by applying a set of candidate
technologies in question to a specific vehicle is calculated as follows:*°

VALUEFUEL = [( (6)
FT

v=PB
Z SURV, X VMT, X (VMTgrowrn) my+v) X (PRICEpr) uy FSgr _ FS'pr

(1 - GAPFT) X (1 + T')V FEFT FE,FT
v

=0

% Such groups can span regulatory classes. For example, if the algorithm is evaluating a potential upgrade to a given
engine, that engine might be used by a station wagon, which is regulated as a passenger car, and a minivan, which is
regulated as a light truck. If the manufacturer’s passenger car fleet complies with the corresponding standard, the
algorithm accounts for the fact that upgrading this engine will incur costs and realize fuel savings for both of these
vehicle models, but will only yield reductions of CAFE fines for the light truck fleet.

10 This is not necessarily the actual value of the fuel savings, but rather the increase in vehicle price the manufacturer
is assumed to expect to be able impose without losing sales.

25



Where:

FT . the fuel type the vehicle operates on (gasoline, e85, diesel, electricity,
hydrogen, or CNG),

PB . a “payback period”, or number of years in the future the consumer is
assumed to take into account when considering fuel savings,

SURV, . the probability that a vehicle of a given vintage v will remain in
service,

VMT, . the average number of miles driven in a year by a vehicle at a given
vintage v,

(VMTgrowtH)my+v: the growth factor to apply to the base miles driven in the current
model year MY at the given vintage v,
(PRICEFT)my . the price of the specific fuel type in year MY,

GAPET . the relative difference between on-road and laboratory fuel economy
for a specific fuel type,
r . the discount rate the consumer is assumed to take into account when

considering fuel savings,

FErr and FE'rr : the vehicle’s fuel economy for a specific fuel type prior to and after
the pending application of technology, and

FSerand FS'rr : the vehicle’s assumed share of operating on a specific fuel type prior
to and after the pending application of technology.

As discussed in Section A.3 of Appendix A, SURV,, VMTy, (VMTcrowtH)my+v, (PRICEFT)MY, and
GAPer are all specified in the parameters input file, while the values for r and PB are specified in
the market data input file (see Section A.1.1 in Appendix A).

In equation (5), AFINE is the change in total CAFE penalties (i.e., accounting for all regulatory
classes in the current CAFE scenario and model year). Typically, AFINE is negative because
applying a technology would increase CAFE.'! The change in fines is calculated by evaluating
the following before and after the pending technology application, and taking the difference
between the results:

FINE = Z —kg ¢ X MIN(CREDIT; + CREDITIN, — CREDITOUT,, 0) @)
c

Here, krc is in dollars per one credit of shortfall and specified in the scenarios input file.

Within each regulatory class C, the amount of CAFE credit created (noncompliance causes credit
creation to be negative, which implies the use of CAFE credits or the payment of CAFE
penalties) is calculated by taking the difference between the CAFE level achieved by the class
and the standard applicable to the class, and multiplying the result by the number of vehicles in
that class. Taking into account attribute-based CAFE standards, for light duty regulatory classes,
this is expressed as follows:

11 Exceptions can occur, for example, if mass reduction is applied under a CAFE system in which attribute standards
are weight-based rather than footprint-based.
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CREDIT; = [ROUND(CAFE;(V(),1) — STD; (V)] X N¢ X 10 8)

While for the class 2b and class 3 regulatory classes, credits are computed as:

CREDIT,; = — ROUND( X N¢ x 100 9)

10 100 2)]
STD:(V,) CAFE.(V()’

Where:

Vc . a vector containing all vehicle models in regulatory class C,
CAFEc(Vc): the CAFE level for regulatory class C,

STDc(Vc) : afunction defining the standard applicable to regulatory class C, and
Nc . the total sales volume for regulatory class C.

Additionally, in equation (7) above, CREDITINc is the amount of CAFE credit transferred into
regulatory class C from another compliance category, while CREDITOUTc is the amount of
CAFE credit transferred out of regulatory class C into another compliance category.

In order to obtain updated credits, and thereby change in fines, due to application of new
technology, for each regulatory class C, the values for the CAFE level (or the achieved fuel
economy level) and the standard (or the required fuel economy level) are calculated before,
during, and after evaluation of each successive technology application. The CAFE level is
computed by taking a sales-weighted harmonic average of the individual fuel economies attained
by each vehicle model i in a cohort of vehicle k. The following equation presents the calculation
of the achieved CAFE level for regulatory class C:

Yiek SALES;
CAFEc(Ve) = 5 SALES, (10)
i€k FEi
Where:
Vc . a vector containing all vehicle models in regulatory class C,
SALES;: the sales volume for a vehicle model i, and
FEi  : the fuel economy (in mpg) attained by a vehicle model i.

Similarly, the value of the standard applicable to regulatory class C is calculated using a sales-
weighted harmonic average of the fuel economy targets applicable to each vehicle model i in a
cohort of vehicles k. This defines the manufacturer’s required fuel economy standard for
regulatory class C and is represented by the following equation:

Diek SALES;

SALES; (11)
i€k Ti

STDC (Vc) =
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Where:

Vc . a vector containing all vehicle models in regulatory class C,
SALES;: the sales volume for a vehicle model i, and
Ti . the fuel economy target (in mpg) applicable to a vehicle model i.

Equation (11) universally applies to an attributed-based standard (i.e., a functional form where a
different fuel economy target is computed for each vehicle based on, for example, its footprint)
as well as a flat standard (i.e., a functional form where each vehicle model has the same fuel
economy target). However, for a flat standard, since with a common target the sales volumes of
individual vehicle models cancel out, equation (11) is reduced to the following:

STDc(Ve) =T, 12)

Figure 8 gives an overview of the logic the algorithm follows in order to identify the best next
technology application for each pathway.

Within a given path, the algorithm considers technologies in the order defined by the technology
pathways (as discussed above). If the phase-in limit for a given technology has been reached, the
algorithm proceeds to the next technology. If not, the algorithm determines whether or not the
technology remains applicable to any sets of vehicles, evaluates the effective cost of applying the
technology to each such set, and identifies the application that would yield the lowest effective
cost.

As shown in Figure 8, the algorithm repeats this process for each technology path, and then
selects the technology application yielding the lowest effective cost. As discussed above, the
algorithm operates subject to expectations of each manufacturer’s preference to pay fines and
whether a compliance scenario allows fine payment within the regulatory class being evaluated.
COSTes is determined, as above, by equations (5), (6), and (7), irrespective of the fine payment
settings.

At the end of each year in the model year loop, the vehicle/technologies combinations that can be
candidates for application in multi-year processing are identified.
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Note, in the diagram above, a “component” is any platform, engine, or transmission produced by
a manufacturer, where application of a technology is evaluated on a vehicle designated as a
leader of that component. Any follower vehicles of the same component, for which a candidate
technology is available for application in the same analysis step as the leader vehicle, will also be

evaluated during technology application.
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Chapter Three Calculation of Effects

This chapter describes the way the CAFE modeling system estimates the effects of potential new
CAFE standards on energy use, as well as on emissions of greenhouse gases and other air
pollutants. These effects are caused by improvements in the fuel economy of individual vehicle
models that manufacturers make in response to the implosion of higher CAFE standards. This
section also describes how these energy use and environmental impacts are translated into
estimates of economic benefits or costs, and identifies which of these economic impacts are
borne privately by vehicle owners and by society as a whole.

The effects on energy use and emissions from tightening or reforming CAFE standards are
estimated separately for each individual vehicle model and vintage (or model year) over its
expected life span in the U.S. vehicle fleet. A vehicle model’s life span extends from the initial
model year when it is produced and sold, through the year when vehicles produced during that
model year have reached the maximum age assumed in the CAFE model.*> Each of the effects
of raising CAFE standards is measured by the difference in the value of a variable — such as total
gallons of fuel consumed by a vehicle model and vintage over its lifetime — with its baseline fuel
economy level, and its estimated fuel economy if that model were instead required to comply
with a stricter CAFE standard. A vehicle model’s baseline fuel economy level is usually (but not
necessarily) defined as the level of fuel economy it would be expected to have if the CAFE
standard currently in effect for its vehicle class remained in effect for the future model year when
it is produced.

Although these effects are calculated for individual vehicle models, vintages, and future calendar
years over their respective lifetimes, they are typically reported at the aggregate level for all
vehicle models in a CAFE regulatory class produced during each model year affected by a
proposed standard. Cumulative impacts for each CAFE regulatory class and model year over its
expected life span are reported both in undiscounted terms and as their present value discounted
to the calendar year defined within the parameters input file.

12 We adopt the simplifications that vehicle model years and calendar years are identical, and that all vehicles
produced during a model year are sold and placed into service during the corresponding calendar year.
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Section 1  Vehicle Lifetimes

The number of vehicles of a specific model and model year (or vintage) that remains in service
during each subsequent calendar year is calculated by multiplying the number originally
produced by estimates of the proportion expected to remain in service at each age up to an
assumed maximum lifetime. Separate survival rates by age of vehicle were developed for
passenger automobiles, light trucks (class 1 and 2a), and medium duty trucks (class 2b and 3),
where light trucks are further separated into vans, SUVs, and pickups, as reported in Section
A.3.1 of Appendix A. Thus, the number of vehicles of model i produced during model year MY,
and belonging to survival category C, which remain in use during a future calendar year CY is
defined by the following equation:

Nimy,cy = SURV 4 X N; yy (13)
Where

SURVc.. : the probability that vehicles belonging to a specific category C will remain in
service at a given age a,

Nimy . the forecast number of new vehicles of a specific vehicle model i produced
and sold during a given model year MY, and

Nimvcy : the number of vehicles of model i produced during model year MY that remain
in use during a future calendar year CY.

The age of a vehicle model produced in model year MY during calendar year CY is defined as:
a=CY—My?* (14)

The CAFE model currently accommodates different schedules of survival rates by vehicle age
for varying vehicle classes, where class 1/2a light trucks are further separated into vans, SUVS,
and pickups, as reported in Section A.3.1 of Appendix A. Based on analysis of recent
registration data, the maximum ages of passenger automobiles and light and medium duty trucks
are estimated to be 30 years and 37 years, respectively.'*

Each vehicle model i produced during a model year MY is designated as operating on a specific
fuel type or employing a specific technology; all units of that model produced during a model
year are assumed to be of the same fuel or technology type. The CAFE model currently
recognizes seven fuel or technology types: gasoline, diesel, compressed natural gas, flexible-fuel
vehicles (or FFVs, which are capable of operating on gasoline or on gasoline blended with up to
85% ethanol), plug-in hybrid electric vehicles (or PHEVs, which can operate on either gasoline

13 We define a vehicle’s age to be 0 during the year when it is produced and sold; that is, when CY=MY. Thus, for
example, a model year 2005 vehicle is defined to be 10 years old during calendar year 2015. Because we do not
attempt to forecast changes in the proportion of vehicles produced during future model years that are expected to
survive to each age, a vehicle’s age depends only on the difference between its model year (MY) and the calendar
year (CY) for which these calculations are performed, and not on their specific values.

14 These are defined as the ages when the number of vehicles of a model year that remain in service has declined to
fewer than 2% of those originally produced.
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or electricity generated off-board and stored in on-board batteries), electric vehicles (or EVs,
which operate only on electricity generated off-board and stored in on-board batteries), and fuel
cell vehicles (or FCVs, which use fuel cells to power on-board electric motors using compressed
hydrogen gas). The fractions of total mileage for which FFVs operate on gasoline and ethanol-
blend fuels, and the fractions of total mileage for which PHEVs operate on gasoline and stored
electricity, are inputs to the model.
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Section 2 Vehicle Use and Total Lifetime Mileage

The CAFE model employs the widely-documented relationship between vehicle age and
declining average vehicle use to estimate the number of miles that individual vehicle models are
driven annually and in total over their expected lifetimes. Separate schedules of average annual
miles driven by age of vehicle were developed for passenger automobiles, light trucks (class 1
and 2a), and medium duty trucks (class 2b and 3), where light trucks are further separated into
vans, SUVs, and pickups, as reported in Section A.3.1 of Appendix A.

Two adjustments are applied to these mileage schedules to forecast the average number of miles
that vehicles produced during future model years will be driven each year over their expected
lifetimes. First, the estimates of annual miles driven by passenger cars and trucks are adjusted to
reflect assumed future growth in average vehicle use.’® Second, the estimates of average annual
miles driven by cars and trucks of each age are further adjusted by applying the estimated
elasticity of vehicle use with respect to fuel cost per mile to the difference in inflation-adjusted
fuel price per gallon between the base calendar year, when the VMT survey was taken, and each
subsequent calendar year. This adjustment employs a combination of actual historic fuel prices
for the calendar years prior to start of the modeling analysis, forecasts for calendar years as
reported in the U.S. Energy Information Administration’s Annual Energy Outlook (AEO), and
extrapolations of gasoline prices beyond the last year provided by AEO. The elasticity (or a fuel
economy rebound effect) as well as the VMT growth assumptions are provided as inputs to the
model and are further described in Section A.3.4 of Appendix A.

The average number of miles driven by a surviving vehicle model i produced in model year MY,
and belonging to VMT category C, during calendar year CY is given by:

MI; yy oy = VMTg 5 X (1 + 1)€Y —Basecy 5 l1 +ex (m - 1)] (15)
Y ' CPMH,a,BaseCY
Where:

VMTca . the average annual miles that vehicles belonging to a specific category C
drive at a given age a,

BaseCY . the base calendar year for VMT usage data corresponding to the year
when the VMT survey was taken,

r . the rate of growth in VMT per vehicle beginning in the base year
BaseCY,

£ . the elasticity of annual vehicle use with respect to fuel cost per mile,

CPMimy,cy : the fuel cost per mile of a vehicle model i produced in model year MY
during calendar year CY,

CPMH agasecy - the average fuel cost per mile of all historic vehicles that were age a
during the base calendar year BaseCY, and

15 Increases in the average number of miles cars and trucks are driven each year have been an important source of
historical growth in total car and truck use, and are expected to represent an important source of future growth in
total light-duty vehicle travel as well.
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MIimy.cy . the resultant number of miles driven in a year by a vehicle model i
produced in model year MY during calendar year CY.

The value of fuel cost per mile for vehicle model i depends on both the price per gallon of fuel
(or gasoline gallon equivalent, GGE, in the case of electricity, hydrogen, and CNG) during
calendar year CY as well as the actual fuel economy that vehicle i of model year MY achieves in
on-road driving. For most vehicles that operate exclusively on a single fuel type (typically,
gasoline or diesel) the cost per mile is calculated from just that one fuel component. However,
for dual fuel vehicles (such as PHEVs and FFVs), the cost per mile is a weighted sum of
individual fuel components on which the vehicle operates. The cost per mile for vehicle model i
produced in model year MY during each calendar year CY is hence defined by the following
equation:

(PRICEFT)CY
CPM; = E X FS; 16
i,MY,CY L FE;wy rr X (1 — GAPyr) i,MY,FT (16)
Where:
FT . the fuel type the vehicle model i operates on (gasoline, e85, diesel,

electricity, hydrogen, or CNG) in model year MY,
(PRICEFT)cy: the inflation-adjusted price per gallon (or per GGE) of the specific fuel
type in calendar year CY,

FEimyFr . the rated fuel economy a vehicle model i achieves during model year MY
when operating on a specific fuel type FT,

FSimy,Fr . the percentage share of miles a vehicle model i produced during model
year MY travels when operating on a specific fuel type FT, and

GAPer . the relative difference between on-road and laboratory fuel economy for a

specific fuel type.

Each model’s rated fuel economy is assumed to be determined during the model year when it is
produced, and to remain fixed throughout its lifetime. However, its actual on-road fuel economy
is assumed to fall short of that rating by the on-road fuel economy “gap” (a model input specified
in the parameters input file).

Similar to the cost per mile equation for a vehicle model i, the value of fuel cost per mile
averaged across all historic vehicles H that were age a during the calendar year BaseCY when the
VMT survey was taken is represented by the following equation:

(PRICEFT)BaseCY
cPM = X FS _
thabasecy = FEpasecy-arr X (1 — GAPpr) Basecy-art an
Where:
BaseCY . the base calendar year for VMT usage data corresponding to the year

when the VMT survey was taken,
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BaseCY —a : the model year during which the historic vehicles were produced when
they were age a in the base calendar year BaseCY,

FT . the fuel type that historic vehicles h operated on (gasoline, €85, diesel,
electricity, hydrogen, or CNG) in model year BaseCY - a,

(PRICEFT)Basecy : the inflation-adjusted price per gallon (or GGE) of the specific fuel
type in the calendar year BaseCY,

FEBgasecy-a FT . the sales-weighted average fuel economy that all historic vehicles
achieved in model year BaseCY — a for a specific fuel type FT,

FSgasecy-aFr . the percentage share of total miles that all historic vehicles traveled in
model year BaseCY — a when operating on a specific fuel type FT, and

GAPer . the relative difference between on-road and laboratory fuel economy

for a specific fuel type.

Since the mileage accumulation schedule used in equation (15) is based on the VMT survey that
was conducted during the calendar year BaseCY, the elasticity of annual vehicle use correlates
the cost per mile of a new vehicle model of age a during each calendar year CY to the cost per
mile of a typical historic vehicle that was of the same age during the base calendar year BaseCY.
The CPM of a historic vehicle is hence calculated using the fuel prices of the base VMT calendar
year, while the CPM of a new vehicle model is obtained using the fuel price forecasts in the
calendar years corresponding to the vehicle’s model year and age. This relationship between the
new and existing vehicles reflects the fuel economy rebound effect, which occurs because buyers
of new vehicles respond to the reduction in their operating costs—resulting from higher fuel
economy of new vehicles—Dby driving slightly more during a particular calendar year.

Equation (15) specifies the average number of miles driven by a single surviving vehicle model i
produced in model year MY during calendar year CY. The total number of miles driven by all
vehicles of a specific model i and model year MY during each calendar year they remain in the
fleet is then calculated by multiplying the appropriate estimate of annual miles driven per vehicle
by the number of vehicles of that model year remaining in service during that calendar year.
Thus, the total miles driven during calendar year CY by the surviving vehicles of model i that
were originally produced during model year MY is calculated as:

MI; yy cy = Nimy.cy X MLy cy (18)
Where:

Nimy,cy : the number of vehicles of model i produced during model year MY that remain
in use during a future calendar year CY as defined in equation (13) above,

Mlimy,cy : the number of miles driven in a year by a single vehicle model i as defined in
equation (15) above, and

MI'imv,cy: the resultant number of miles driven in a year by all surviving vehicles of
model i produced in model year MY during calendar year CY.

36



Section 3  Fuel Consumption and Savings

Fuel consumption by vehicles of each model and vintage during a future year depends on the
total mileage that the surviving vehicles are driven during that year, as well as on the fuel
efficiency they obtain in actual driving. As indicated previously, the fuel economy levels that
new vehicles achieve in real-world driving falls significantly short of the rated fuel economy
levels that are used to assess manufacturers’ compliance with CAFE standards.

The number of gallons of each type of fuel (or GGE for electricity, hydrogen, and CNG)
consumed by a surviving vehicle of model i produced in model year MY during calendar year CY
is calculated as shown in the following equation:

MIL' MY,CY
G; = — X FS; (19)
l,MY,CY,FT FEL’MY’FT X (1 _ GAPFT) i,MY FT
Where:
FT . the fuel type the vehicle model i operates on (gasoline, e85, diesel,

electricity, hydrogen, or CNG) in model year MY,

Mlimy,cy : the number of miles driven in a year by a vehicle model i produced in model
year MY during calendar year CY, as defined in equation (15) above,

FEimv,rr : the rated fuel economy a vehicle model i achieves during model year MY
when operating on a specific fuel type FT,

FSimvrr : the percentage share of miles a vehicle model i produced during model year
MY travels when operating on a specific fuel type FT,

GAPer  : the relative difference between on-road and laboratory fuel economy for a
specific fuel type, and

Gimy,cy,Fr: the resultant number of gallons of fuel consumed in a year by a vehicle
model i produced in model year MY during calendar year CY, when operating
on a specific fuel type FT.

As equation (19) indicates, many of the factors determining a vehicle model’s consumption of
different fuels can vary depending on the CAFE standard that is in effect during the model year it
is produced. Specifically, the shares of miles for which it operates on different fuels, its fuel
economy when using each different fuel, and as discussed previously, its average annual mileage
can each differ between the baseline market forecast and any alternative CAFE level that the
model is used to analyze. These differences occur because manufacturers will increase the fuel
economy of some models in response to increases in CAFE standards from their baseline level,
and may convert some gasoline-powered models to diesels, PHEVS, or EVs.

Similar to the mileage accumulation equations discussed in the previous section, the fuel
consumption equation above estimates the amount of gallons consumed by a single vehicle
model i of model year MY during calendar year CY. The total amount of gallons (or GGE)
consumed by all surviving vehicles of model i and model year MY during calendar year CY is
then defined as follows:
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! _
Gimy.cy.rr = Nimy.cy X Gimy,cy,rr (20)

Where:
Nimycy  : the number of vehicles of model i produced during model year MY that
remain in use during a future calendar year CY as defined in equation (13)
above,

Gimvcyvrr : the amount of gallons of fuel consumed in a year by a single vehicle model i
as defined in equation (19) above, and

G'imy,cvrr : the resultant amount of gallons of fuel consumed in a year by all surviving
vehicles of model i produced in model year MY during calendar year CY,
when operating on a specific fuel type FT.

From here, the total fuel consumption for each fuel type of all surviving vehicles of model i and
model year MY over their expected lifetimes may be obtained by summing the amount of gallons
consumed across the individual calendar years as such:

! _ !
Gimy,Fr = E G my,cy,Fr (21)
cY

The calendar year CY in the equation above ranges between the model year MY when the vehicle
model i was produced until MY plus the maximum survival age of that vehicle.

Although the modeling system calculates fuel consumption for each individual vehicle model, it
aggregates these results across all vehicle models for reporting purposes. The total consumption
of each type of fuel by all vehicle models produced in model year MY during calendar year CY is
calculated by summing the fuel consumptions of each individual vehicle model i in a cohort of
vehicles k as shown in the following equation:

GALLONSyy cy rr = Z Gimy,cyFr (22)

iek

Similarly, the total consumption of each type of fuel by all vehicle models produced in model
year MY over their expected lifetimes is calculated by summing the total lifetime fuel
consumptions of each vehicle model i as follows:

GALLONSyy pr = Z G my Fr (23)

iek

As with annual consumption of different types of fuels by individual vehicle models, total annual
consumption of each fuel by all vehicle models will differ depending on the CAFE standard that
prevailed during the model year when they were originally produced. The change in fuel use
that results from imposing a different CAFE standard is always measured relative to expected
fuel use with some baseline or comparison standard in effect.
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The usual assumption employed in the CAFE model is that the baseline fuel economy levels for
vehicles produced during a future model year would be those that manufacturers would provide
if the most recently adopted standard was extended to apply to future model years. Thus, for
example, the baseline fuel economy levels projected for vehicles produced during some future
model years are estimated under the assumption that the recently adopted CAFE standards for
model year 2016 (as an example) cars and light trucks would be extended to apply to those future
model years. Estimated fuel consumption with the 2016 CAFE standard assumed to remain in
effect for model years after 2016 provides the baseline for measuring reductions in fuel use
expected to result from adopting higher CAFE standards in the future model years.

The savings in total consumption of each type of fuel by all vehicle models produced during a
model year MY over their expected lifetimes is computed as:
AGALLONSyy pr = (GALLONSyy pr)

— (GALLONSyy pr) (24)

CAFE Baseline

Where:

(GALLONSwy,F1)care : the total fuel consumption by all vehicle models produced
during model year MY over their expected lifetimes, for each
fuel type FT, resulting from increases in vehicle fuel economy
as a response to the new CAFE standards,

(GALLONSMy,F1)Baseline - the total fuel consumption by all vehicle models produced
during model year MY over their expected lifetimes, for each
fuel type FT, assuming the baseline standards stay in place
during a future model year MY, and

AGALLONSwmy T . the changes in fuel consumption for each fuel type FT resulting
from average increases in vehicle’s fuel economies due to
higher CAFE standards relative to the baseline fuel economy
levels.

In addition to calculating fuel consumption in terms of amount of gallons (or GGE) consumed
for each fuel type, the modeling system also calculates corresponding energy consumption in
quadrillion British thermal units (or Quads) attributable to each fuel type analyzed within the
model, reporting these quantities on a total and incremental basis. For non-liquid fuel types
(electricity, hydrogen, and CNG), the CAFE model also estimates energy consumption in native
units of that fuel type (kilowatt-hours, or kWh, for electricity and standard cubic feet, or scf, for
hydrogen and CNG)?.

For liquid fuel types (gasoline, e85, and diesel), the conversion of energy consumption to
quadrillion BTUs is calculated within the model by simply multiplying the amount of gallons of
the specific fuel consumed by the energy density of that fuel type and scaling the result from
BTUs to Quads. The system computes amount of Quads consumed by each individual vehicle

16 When reporting amounts of fuel and energy consumption, the system converts all units into thousands. Thus,
liquid fuel consumed is reported in thousands of gallons, electricity in mW-h, and hydrogen and CNG in Mcf.
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model as well as overall consumption across all surviving vehicle models, for any given calendar
year and/or model year. Thus, the equation for calculating Quads takes general form as shown:

GALLONSp7 X EDpy

= 25
QUADSgr B (25)
Where:
GALLONSEt: the amount of gallons of fuel type FT consumed by one or more vehicle
models,
EDfr . the energy density of fuel type FT, and

QUADSFT : the energy consumption expressed quadrillion BTUs for fuel type FT.

For electricity, hydrogen, and CNG fuel types, since their consumption is measured in gasoline
gallon equivalents, the conversion to Quads is calculated by multiplying the amount of GGE by
the energy density of gasoline. Equation (25) above then becomes:

GALLONSFT X EDGasoline

26
lel5 (20)

QUADSFT =

Additionally for electricity, hydrogen, and CNG, the conversion from GGE to native units (kWh
or scf) is calculated by multiplying the amount of gallons consumed by the ratio of the energy
density of gasoline to the energy density of a specific fuel type. As with the calculation of
energy use in Quads, the system computes consumption of kilowatt-hours and standard cubic
feet for each individual vehicle model and total consumption for all surviving vehicle models.
Hence, for electricity, the equation is defined as:

Gasoline

ED
KWH = GALLONS; X ——2301ne @7)
EDpr

While for hydrogen and CNG, the equation is as follows:

Gasoline

ED
SCF = GALLONS - x —=2%0tine (28)
EDpr

Where:
GALLONSFt: the amount of gasoline gallon equivalents of Electricity, Hydrogen, or

CNG fuel types (denoted by the FT subscript) consumed by one or more
vehicle models,

EDgasoline  : the energy density of gasoline fuel,

EDFr . the energy density of Electricity, Hydrogen, or CNG fuel types,

KWH . the amount of kilowatt-hours of Electricity fuel type consumed by one or
more vehicle models (equation (27)), and

SCF . the amount of standard cubic feet of Hydrogen or CNG fuel types

consumed by one or more vehicle models (equation (28)).
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Section 4 Greenhouse Gas Emissions

Fuel savings from imposing stricter CAFE standards will result in lower emissions of carbon
dioxide (CO.), the primary greenhouse gas emitted during the refining, distribution, and
combustion of transportation fuels. Lower fuel consumption reduces carbon dioxide emissions
directly, because the largest source of these emissions from transportation activity is fuel used by
internal combustion engines. The CAFE model calculates CO» emissions from vehicle operation
by multiplying the number of gallons of a specific fuel consumed (gasoline, €85, or diesel) by the
carbon content per gallon of that fuel type, and then applying the ratio of carbon dioxide
emissions generated per unit of carbon consumed during the combustion process.’

Emissions of carbon dioxide resulting from fuel consumption by all surviving vehicle models
produced in model year MY during calendar year CY are calculated from their consumption of
each individual fuel type as:

_ Zrr(GALLONSyy cy pr X MDer X Cpr) x (44/15)

Where:

GALLONSwmy,cy,Fr : the amount of gallons of fuel consumed in a year by all surviving
vehicle models produced in model year MY during calendar year CY,
for a specific fuel type FT,

MDer . the mass density of a fuel type FT (an input parameter specified in
grams per unit of fuel type, which is either gallons, kWh, or scf),

Crr . the fraction of each fuel type’s mass that represents carbon,

(*12) . the ratio of the molecular weight of carbon dioxide to that of
elemental carbon?®,

1e6 . the conversion factor from grams to metric tons, and

CO2"Nyy,cy . the total emissions of carbon dioxide (denominated in metric tons)

resulting from fuel consumption by all surviving vehicle models
produced in model year MY during calendar year CY aggregated for
all fuel types.

Vehicles operating on electricity or hydrogen are assumed to generate no CO2 emissions during
vehicle use. For vehicles operating on CNG, since mass density is specified in grams per scf, the

17 The carbon content for each type of fuel is specified as an input to the model in the parameters input file (further
discussed in Section A.3.11 of Appendix A). Although the model does not explicitly account for incomplete
conversion of carbon to carbon dioxide, input values specifying carbon content can be adjusted accordingly (i.e.,
reduced to 99-99.5% of actual carbon content). Since electricity and hydrogen fuel types do not cause CO,
emissions to be emitted during vehicle operation, the carbon content for these fuel types should be set to zero in the
input file.

18 This ratio measures the mass of carbon dioxide that is produced by complete combustion of mass of carbon
contained in each gallon of fuel.
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generated CO. emissions are calculated using amount of scf of CNG instead of amount of
gallons consumed by all vehicle models. Thus, equation (29) above becomes:

44
co2ssh., = Y rr(SCFuyy cy rr X IZDgT X Cpr) X ( /12) (30)
’ e

As with the model’s calculations of fuel consumption, estimates of annual CO, emissions from
fuel use are summed over the calendar years that vehicles produced during each model year are
projected to remain in use to obtain estimates of lifetime emissions. Specifically, lifetime CO>
emissions from fuel consumption by vehicle models produced during model year MY is defined
by the following:

Cco2veh = Z CO24l ey (31)
CcY

By reducing the volume of fuel consumed, raising CAFE standards will also affect carbon
dioxide emissions from refining and distributing liquid fuels (gasoline, diesel, and e85). Carbon
dioxide emissions occur during the production of petroleum-based fuels as a result of energy use
for petroleum extraction, transportation, storage, and refining, as well as during storage and
distribution of refined fuel. Producing the chemical feedstocks or agricultural products from
which non-petroleum fuels such as ethanol are derived also entails energy use and generates CO-
emissions, as does refining, storing, and distributing those fuels. Generating electricity for use
by PHEVs and EVs, or hydrogen for use by FCVs, using fossil energy sources such as coal or
natural gas also produces CO, emissions. Additionally, extracting natural gas from wells, as
well as production (consisting of compression, cooling, and dehydration) and storage of CNG,
also produces CO, emissions.

The CAFE model calculates reductions in carbon dioxide emissions from each stage of fuel
production and distribution using aggregate estimates of emissions from all stages of these
processes per unit of fuel energy supplied. These estimates are first converted to grams per
quadrillion BTUs, then multiplied by the amount of Quads of each fuel type consumed to
estimate total carbon dioxide emissions from production and distribution of various fuel types.
Hence, the total CO, emissions resulting from producing and distributing of fuel consumed by all
surviving vehicles of model year MY during calendar year CY is given by:

coref . — Y rr(QUADSyy cy pr X CO2pr X 1€9) (32)
MY,CY 1@6

Where:

QUADSwy,cT,Fr - the amount of quadrillion BTUs of energy consumed in a year by all
surviving vehicle models produced in model year MY during calendar
year CY, for a specific fuel type FT,

CO2rr . overall emissions of carbon dioxide from all stages of feedstock
production and distribution of fuel type FT (an input parameter
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specified in grams per million-Btu; the input value is multiplied by 1e9
in order to convert it into grams per Quad),

1e6 . the conversion factor from grams to metric tons, and

CO2"®\y,cy . the total emissions of carbon dioxide (denominated in metric tons)
resulting from production and distribution of various fuel types used by
all surviving vehicle models produced in model year MY during
calendar year CY.

Annual CO; emissions generated by fuel production and distribution are then summed over the
lifetimes of all vehicle models produced during each model year MY as such:

f _ f
COZIr\;Y - Z Cozzr\;y,cy (33)
cY

Finally, CO2 emissions from fuel consumption are combined with emissions generated during
the fuel supply process to yield total CO. emissions from fuel production and consumption by
vehicles produced during a model year over their expected lifetimes, and are defined as such:

CO28t = co2yet + co2iet (34)

Since imposing a higher CAFE standard in a given model year reduces the overall fuel
consumption over the lifetimes of all vehicles produced during that year, and since CO:
emissions are a direct product of the volume of fuel produced and consumed, imposing a higher
CAFE standard also reduces the lifetime CO, emissions. The model estimates this reduction in
CO2 emissions by taking the difference between the total lifetime emissions of all vehicle models
produced in a model year with the new CAFE standard in effect and their total lifetime emissions
with the baseline standard in effect. This calculation is defined by the following equation:

ACO2yy = (COZMY)CAFE - (COZMY)Baseline (35)

Where:

(CO2my)care : the total emissions of carbon dioxide generated from production and
consumption of various fuel types by all vehicle models produced during
model year MY over their expected lifetimes, resulting from increases in
vehicle fuel economy as a response to the new CAFE standard,

(CO2my)Baseline = the total emissions of carbon dioxide generated from production and
consumption of various fuel types by all vehicle models produced during
model year MY over their expected lifetimes, assuming the baseline
standard stay in place during a future model year MY, and

ACO2my . the changes in total emissions of carbon dioxide resulting from average
increases in vehicle’s fuel economies due to higher CAFE standards
relative to the baseline fuel economy levels.
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Section 5  Air Pollutant Emissions

Stricter CAFE standards can result in higher or lower emissions of criteria air pollutants, by-
products of fuel combustion that are also emitted during the production and distribution of fuel.
Criteria pollutants that are emitted in significant quantities by motor vehicles include carbon
monoxide, various hydrocarbon compounds, nitrogen oxides, sulfur dioxide, and fine particulate
matter.

The increased use of vehicle models with improved fuel economy that occurs through the fuel
economy rebound effect causes increased emissions of most criteria pollutants, since federal
standards regulate permissible emissions of these pollutants on a per-mile basis. In contrast,
reductions in the volume of fuel consumed that result from requiring higher fuel economy cause
emissions of criteria pollutants during fuel production and distribution to decline. The net
change in total emissions of each criteria pollutant that results from imposing a higher CAFE
standard depends on the relative magnitudes of changes in emissions from vehicle use and from
fuel refining and distribution.

The CAFE model calculates emissions of criteria pollutants resulting from vehicle operation by
multiplying the number of miles driven by vehicles of a model year during each year they remain
in service by per-mile emission rates for each pollutant, which are listed in the parameters input
file by model year and vehicle age. These emission rates differ among passenger cars, light
trucks, and class 2b/3 trucks when operating on different fuel types. The CAFE modeling
system accepts emission rate tables defined for gasoline and diesel fuel types, where the gasoline
rates are also used for vehicles operating on E85.1° Additionally, vehicles operating on
electricity (PHEVs and EVs), hydrogen (FCV), and CNG are assumed to generate no emissions
of criteria air pollutants during vehicle use.

Total emissions of any given criteria air pollutant from the use of all surviving vehicle models
produced during model year MY during calendar year CY is defined as follows:

!
pveh  _ 2i 2k MI yy oy X FSimy rr X Eimy,a rr

= (36)
MY,CY 16

Where:

MI'imv,cy: the number of miles driven in a year by all surviving vehicles of model i
produced in model year MY during calendar year CY,

FSimvrr © the percentage share of miles a vehicle model i produced during model year
MY travels when operating on a specific fuel type FT,

Eimvarr : the per-mile rate at which vehicles of model i and model year MY emit a given
pollutant at age a when operating on a specific fuel type FT,

19 Given that no reliable sources of information for criteria emissions resulting from vehicle operation are available
for E85 fuel, and since overall utilization of E85 by all vehicle models is insignificant when compared to overall
vehicle fuel consumption, the modeling system assumes a simplification that emissions generated from vehicle
operation on E85 fuel are equivalent to that of gasoline.
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1e6 . the conversion factor from grams to metric tons, and

EveMwy.cy : the total emissions of a specific pollutant (denominated in metric tons)
resulting from fuel consumption by all surviving vehicle models produced in
model year MY during calendar year CY aggregated for all fuel types.

As with fuel use and CO> emissions, annual emissions of each criteria air pollutant are summed
over the calendar years that vehicle models originally produced during each model year are
expected to be in service, in order to produce estimates of their total lifetime emissions. Thus,
lifetime emissions of each air pollutant is defined as:

h _ h
BN =) Eifley @)

Emissions of criteria air pollutants that occur during production and distribution of various fuel
types are estimated using the same methodology employed for calculating carbon dioxide
emissions, as discussed in the previous section and defined by equation (32) above. The model
uses aggregate estimates of emissions of criteria air pollutants from all stages of fuel production
and distribution, which are specified in the parameters input file and are weighted by the user-
defined fuel import assumptions. Thus, the total emissions of any given criteria air pollutant
from producing and distributing of fuel consumed by all surviving vehicle models of model year
MY during calendar year CY is:

gref Yrr(QUADSyy cy pr X Epr X 1€9)

MY,CY — 1e6 (38)

Where:

QUADSwy,cT,rr - the amount of quadrillion BTUs of energy consumed in a year by all
surviving vehicle models produced in model year MY during calendar
year CY, for a specific fuel type FT,

Err . overall emissions of a given pollutant from all stages of feedstock
production and distribution of fuel type FT (an input parameter
specified in grams per million-Btu; the input value is multiplied by 1e9
in order to convert it into grams per Quad),

1e6 . the conversion factor from grams to metric tons, and

E™mv.cy . the total emissions of a specific pollutant (denominated in metric tons)
resulting from production and distribution of various fuel types used by
all surviving vehicle models produced in model year MY during
calendar year CY.

Emissions of each criteria pollutant attributable to producing and distributing the fuel consumed
over the lifetimes of all vehicle models produced during model year MY are summed to obtain:

ref __ ref
EMY - E EMY,CY (39)
cY
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Finally, total emissions of each criteria pollutant over the lifetimes of all vehicles of model year
MY are the sum of emissions that occur as a result of their lifetime use, and emissions from
producing and distributing the fuel they consume over their lifetimes, which is given by:

Eié = BV + Ery (40)

As with the emissions of carbon dioxide, total lifetime emissions of each criteria air pollutant by
all vehicles produced during a future model year will differ between the baseline CAFE standard
and any alternative standard that is specified. The model calculates the effect of imposing a
higher CAFE standard on emissions of criteria air pollutants by taking the difference between
lifetime emissions by all vehicle models produced during a model year the new CAFE standard
takes effect and those vehicles’ emissions under the baseline standard. This calculation is
defined as:

AEyy = (EMY)CAFE - (EMY)Baseline (41)

Where:

(Emv)care . the total emissions of a specific pollutant generated from production and
consumption of various fuel types by all vehicle models produced during
model year MY over their expected lifetimes, resulting from increases in
vehicle fuel economy as a response to the new CAFE standard,

(Emv)Basetine = the total emissions of a specific pollutant generated from production and
consumption of various fuel types by all vehicle models produced during
model year MY over their expected lifetimes, assuming the baseline
standard stay in place during a future model year MY, and

AEwmy . the changes in total emissions of a specific criteria air pollutant resulting
from average increases in vehicle’s fuel economies due to higher CAFE
standards relative to the baseline fuel economy levels.
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Section 6  Vehicle Safety Effects

As discussed in Section 2 above, vehicle miles traveled may increase due to the fuel economy
rebound effect, resulting from improvements in vehicle fuel efficiency and cost of fuel, as well
as the assumed future growth in average vehicle use. Increases in total lifetime mileage increase
exposure to vehicle crashes, including those that result in fatalities. Consequently, the modeling
system computes total fatalities attributed to vehicle use for vehicles of model year MY,
belonging to safety class SC and weight threshold T as:

VMT,
FMY,SC,T = % X BASESC,T X FMVSSSC‘T (42)

Where:

VMTwmysct: the lifetime vehicle miles traveled for vehicles of model year MY within a
safety class SC and weight threshold T,

BASEsc,t : the measure of base fatalities per billion miles for vehicles within a safety
class SC and weight threshold T, and

FMVSSsct: an adjustment for new Federal Motor Vehicle Safety Standards (FMVSS)
for vehicles within a safety class SC and weight threshold T.

The FMVSSsct adjustment in equation (42) above is employed to account for the fact that
vehicles involved in future crashes will be certified to more stringent safety standards than those
involved with past crashes upon which the base rates of involvement in fatal crashes were
estimated.

Since the use of mass reducing technology is present within the model, safety impacts may also
be observed whenever a vehicle’s base weight decreases. Thus, in addition to computing total
fatalities related to vehicle use, the modeling system also estimates changes in fatalities due to
reduction in vehicle’s curb weight. These changes are computed for vehicles of model year MY,
belonging to safety class SC and weight threshold T as:

pacw VMTyy scr y ACW
My,Sc.T 1e9 100

x Ef fectscr X BASEscr X FMVSSgc 1 (43)

Where:

VMTwmysct: the lifetime vehicle miles traveled for vehicles of model year MY within a
safety class SC and weight threshold T,

ACW . the amount by which the vehicle’s curb weight decreases,

Effectsct : the percentage by which fatalities change for every 100 Ibs. that a vehicle’s
curb weight is reduced for vehicles within a safety class SC and weight
threshold T,

BASEsct : the measure of base fatalities per billion miles for vehicles within a safety
class SC and weight threshold T, and

FMVSSsct: an adjustment for new FMVSS for vehicles within a safety class SC and
weight threshold T.
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Equation (43) is applied directly as long as the vehicle’s initial and final curb weights place it
within the same weight threshold. In the event that mass reduction causes the vehicle to cross
the threshold boundary, equation (43) is applied in two steps, where a portion of the ACW
reduced (up to the threshold boundary) uses the Effectmy,sct, BASEsct, and FMVSSsct
coefficients from the vehicle’s initial weight threshold, and a portion of the ACW reduced
(beyond the threshold boundary) uses the coefficients from the vehicle’s new weight threshold.

The total fatalities attributed to vehicle use and vehicle weight change for vehicles of model year
MY, belonging to safety class SC and weight threshold T are, hence, defined as the sum of the
two components:

Total __ ACW
FMY,SC,T - FMY,SC,T + FMY,SC,T (44)

Lastly, total fatalities attributed to all vehicle models produced during model year MY are
accumulated across all vehicles belonging to safety classes SC and weight thresholds T as:

Total _ Total
Fuy® = Z FM(l)/,SC‘lC,T (45)

The safety classes, weight thresholds, Effectsc 1, FMVSSsc 1t and BASEsc r variables are specified
as inputs to the model, which are defined in the parameters input file.

In addition to using inputs to estimate the future involvement of modeled vehicles in crashes
involving fatalities, the model also applies inputs defining other accident-related externalities
estimated on a dollar per mile basis, as discussed below in S7.7.
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Section 7  Private versus Social Costs and Benefits

Improving the fuel efficiency of new vehicles produces a wide range of benefits and costs, many
of which affect buyers of those vehicles directly. Depending upon how manufacturers attempt to
recoup the costs they incur for improving the fuel efficiency of selected models, buyers are likely
to face higher prices for some — and perhaps even most — new vehicle models. Purchasers of
models whose fuel economy is improved benefit from the resulting savings in the cost of fuel
their vehicles consume, from any increase in the range they can travel before needing to refuel,
and from the added driving they do as a result of the rebound effect. Depending on the
technology manufacturers use to improve fuel economy and its consequences for vehicle power
and weight, these benefits may be partly offset by a slight decline in the performance of some
new models.

At the same time, the reduction in fuel production and use resulting from improved fuel economy
produces certain additional benefits and costs to society as a whole. Potential social benefits
from reduced fuel use include any value that society or the U.S. economy attaches to saving fuel
over and above its private value to new vehicle buyers, lower emissions of air pollutants and
greenhouse gases generated from fuel production, distribution, and consumption, and reduced
economic costs associated with U.S. imports of crude petroleum and refined fuel. By causing
some additional driving through the rebound effect, improving fuel economy can also increase a
variety of social costs, including the economic value of health effects and property damages
caused by increased air pollution, the value of time delays to motorists from added traffic
congestion, added costs of injuries and property damage resulting from more frequent traffic
accidents, and economic costs from higher levels of traffic noise.

The following sections discuss how each of these benefits and costs can result from improving
the fuel economy of new vehicles, the factors affecting their likely magnitudes, and how their
values are commonly measured or estimated. Section A.3 of Appendix A provides examples of
specific unit economic values and other parameters used to estimate the aggregate value of these
various benefits and costs, and explains how these sample values were derived.

S7.1 Increases in New Vehicle Prices

Depending upon how manufacturers attempt to recover the costs they incur in complying with
CAFE regulations, purchase prices for some new models are likely to increase. Because we
assume that manufacturers fully recover all costs they incur for installing fuel economy
technologies to comply with CAFE in the form of higher prices for some models, the total
increase in vehicle sales prices has already been accounted for in estimating technology costs to
manufacturers. Nevertheless, the total value of these price increases represent a cost of CAFE
regulation from the viewpoint of buyers of vehicle models whose prices rise.

In addition to increases in the prices paid by buyers who elect to purchase these models even at
the higher price points, higher prices result in losses in welfare or consumer surplus to buyers
who decide to purchase different models instead. These losses are extremely complex to
estimate if prices change for a large number of models, and in any case are likely to be small
even in total. Thus, we do not attempt to estimate their value.
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S7.2 The Value of Fuel Savings

The CAFE modeling system estimates the economic value of fuel savings to buyers of new
vehicle models whose fuel economy is improved by applying the forecast (an input to the model)
of future retail fuel prices to each year’s estimated fuel savings for those models. The annual
fuel savings for a model during each year of its lifetime in the vehicle fleet is multiplied by the
number of those initially sold that are expected to remain in use during that year to determine the
total annual value of fuel savings to buyers of that model.

The forecast retail price of fuel per gallon — including federal and average state fuel and other
taxes — during that year is used to estimate the value of these fuel savings as viewed from the
perspective of their buyers. Based on evidence from previous studies of consumer purchases of
automobiles and durable appliances, we assume that new vehicle buyers value these savings over
the approximate number of years (an input to the model) they expect to own a new vehicle, and
that they discount these expected savings to the year in which they purchase new vehicles.

S7.3 Benefits from Additional Driving

The rebound effect also results in additional benefits to new vehicle buyers in the form of
consumer surplus from the increased driving it produces. These benefits arise from the value to
drivers and passengers of the social and economic opportunities made available to them by
additional traveling. As evidenced by the fact that they elect to make more frequent or longer
trips when improved fuel economy reduces the cost of driving, the benefits from this additional
travel exceed the costs drivers and their passengers incur in making more frequent or longer
trips. The amount by which these benefits from additional travel exceed its cost to them — which
has been reduced by improved fuel economy — represents the increase in consumer surplus
associated with additional rebound effect driving.

The system estimates the value of these benefits using the conventional approximation of one
half of the product of the decline in fuel cost per mile driven and the resulting increase in the
annual number of miles driven. This value is calculated for each year that a model whose fuel
economy is improved remains in the fleet, multiplied by the number of vehicles of that model
expected to remain in use during each year of its lifetime, and discounted to its present value as
of the year it was purchased. Given typical input values (e.g., for fuel prices), this benefit is
relatively small by comparison to most other economic impacts of raising CAFE standards.

S7.4 The Value of Extended Refueling Range

Manufacturers’ efforts to improve the fuel economy of selected new vehicle models will also
increase their driving range per tank of fuel. By reducing the frequency with which drivers
typically refuel their vehicles, and by extending the upper limit of the range they can travel
before requiring refueling, improving fuel economy thus provides some additional benefits to
their owners.?’ No direct estimates of the value of extended vehicle range are readily available,

20 If manufacturers instead respond to improved fuel economy by reducing the size of fuel tanks to maintain a
constant driving range, the resulting savings in costs will presumably be reflected in lower sales prices.
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so the CAFE model calculates the reduction in the annual number of required refueling cycles
that results from improved fuel economy. The change in required refueling frequency for
vehicle models with improved fuel economy reflects the increased driving associated with the
rebound effect, as well as the increased driving range stemming from higher fuel economy.

S7.5 Changes in Performance and Utility

The system currently assumes that the costs and effects of fuel-saving technologies reflect the
application of these technologies in a manner that holds vehicle performance and utility constant.
Therefore, the system currently does not estimate changes in vehicle performance or utility.

S7.6 Social Benefits and Costs from Increased Fuel Economy
S7.6.1 The “Social Value” of Fuel Savings

The economic value to society of the annual fuel savings resulting from stricter CAFE standards
is also assessed by applying estimated future fuel prices to each year’s estimated fuel savings.
Unlike the value of fuel savings to vehicle buyers themselves, however, the pre-tax price per
gallon is used in assessing the value of fuel savings to the economy as a whole. This is because
reductions in payments of state and federal taxes by purchasers of fuel will be exactly offset by
reduced spending on the construction and maintenance of streets and highways that fuel taxes are
mainly used to finance, and thus do not reflect a net savings in resources to the economy.

When estimating the nationwide aggregate economic benefits and costs from CAFE regulation,
we include this “social” value of fuel savings rather than their private value to vehicle buyers. In
computing the social value of fuel savings, we include their annual value over the entire
expected lifetimes of vehicle models whose fuel economy is improved, reflecting the presumably
longer-term horizon of society as a whole compared to that of vehicle buyers, who may be
concerned with fuel savings only over the time they expect to own newly-purchased vehicles.

S7.6.2 Economic Benefits from Reduced Petroleum Imports

Importing petroleum into the United States is widely believed to impose significant costs on
households and businesses that are not reflected in the market price for imported oil, and thus are
not borne by consumers of refined petroleum products. These costs include three components:
(1) higher costs for oil imports resulting from the combined effect of U.S. import demand and
OPEC market power on the world oil price; (2) the risk of reductions in U.S. economic output
and disruption of the domestic economy caused by sudden reductions in the supply of imported
oil; and (3) costs for maintaining a U.S. military presence to secure imported oil supplies from
unstable regions, and for maintaining the Strategic Petroleum Reserve (SPR) to cushion against
price increases. By reducing domestic demand for gasoline, tighter CAFE standards can reduce
petroleum imports, and thus reduce these social costs to the extent that their magnitude varies
with the volume of U.S. oil imports. Any reduction in their magnitude represents an additional
category of economic benefits from tighter fuel economy standards.

In this analysis, the reduction in petroleum imports resulting from higher CAFE standards is
estimated by assuming that the resulting savings in gasoline use during each future year is
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translated directly into a corresponding reduction in the annual volume of U.S. oil imports during
that same year. The value to the U.S. economy of reducing petroleum imports — in the form of
lower crude oil prices and reduced risks of oil supply disruptions — is estimated by applying the
sum of the previously reported estimates of these benefits to the estimated annual reduction in oil
imports.

S7.6.3 Valuing Changes in Environmental Impacts

The CAFE modeling system estimates the economic value of the net change in emissions of
criteria pollutants, including carbon monoxide, volatile organic compounds, nitrogen oxides,
sulfur dioxide, and fine particulates, using estimates of the economic damage costs per ton of
emissions of each of these pollutants. As indicated previously, emissions of criteria pollutants
can rise or fall when fuel economy increases, so the economic costs of these emissions can
increase or decline in response to higher CAFE standards.

The model estimates changes in damage costs caused by carbon dioxide emissions by
multiplying the magnitude of the change in emissions by the estimated value of damages per unit
of emissions.

S7.7 Social Costs of Added Driving

In addition to increasing emissions of criteria pollutants, any added driving associated with the
fuel economy rebound effect may contribute to increased traffic congestion, motor vehicle
accidents, and highway noise. Additional vehicle use can contribute to traffic congestion and
delays partly by increasing recurring congestion on heavily-traveled facilities during peak travel
periods, depending on how the additional travel is distributed over the day and on where it
occurs. Added driving can also increase the frequency of incidents such as collisions and
disabled vehicles that cause prolonged delays, although the extent to which it actually does will
again depend partly on when and where the added travel occurs. Finally, added vehicle use from
the rebound effect may also increase traffic noise, which causes inconvenience, irritation, and
potentially even discomfort to occupants of other vehicles, pedestrians and other bystanders, and
residents or occupants of surrounding property.

The CAFE modeling system uses estimates of the increases in external costs — that is, the
marginal social costs — from added congestion, property damages and injuries in traffic
accidents, and noise levels caused by additional vehicle usage. It does so by applying estimates
of the increases in these costs that result from each added mile of travel by different types of
vehicles to the increase in the total number of miles driven projected to result from the rebound
effect.

In addition to external costs, the modeling system also computes costs associated with the

cleanup of fatal crashes, attributed to increases in total miles driven and the application of mass
reduction technology.
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Appendix A Model Inputs

The CAFE Model utilizes a set of data files used as input to the analysis. All input files are
specified in Microsoft® Excel format and are outline in Table 7 below. The user can define and
edit all inputs to the system.

Table 7. Input Files

Input File

Contents

Market Data
(Manufacturers Worksheet)

Contains an indexed list of manufacturers available during the study period, along
with manufacturer’s willingness to pay fines and other manufacturer-specific
modeling settings.

Market Data
(Vehicles Worksheet)

Contains an indexed list of vehicle models available during the study period, along
with sales volumes, fuel economy levels, prices, regulatory classification, references
to specific engines and transmissions used, and settings related to technology
applicability.

Market Data
(Engines Worksheet)

Contains an indexed list of engines available during the study period, along with
various engine attributes and settings related to technology applicability.

Market Data
(Transmissions Worksheet)

Contains an indexed list of transmissions available during the study period, along
with various transmission attributes and settings related to technology applicability.

Technologies

Specifies estimates of the availability, cost, and effectiveness of various
technologies, specific to various vehicle categories.

Provides inputs used to calculate travel demand, fuel consumption, carbon dioxide
and criteria pollutant emissions (upstream and downstream), and economic

Parameters externalities related to highway travel and petroleum consumption. Additionally, the
parameters input file contains inputs necessary for performing fleet analysis for the
EIS.

Scenarios Specifies coverage, structure, and stringency of CAFE standards for scenarios to be

simulated.
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A.1 Market Data File

The market data file contains four worksheets: Manufacturers, Vehicles, Engines and
Transmissions. Taken together, the manufacturers, vehicle models, engines, and transmissions
worksheets provide the “initial state” historical and/or forecast data for the vehicle fleet. The
sections below describe each worksheet in greater detail.

A.1.1 Manufacturers Worksheet

The manufacturers input worksheet contains a list of all manufacturers that produce vehicle
models offered for sale during the study period. Each manufacturer has a unique code and is
represented by a unique manufacturer name. For each manufacturer, the manufacturer code,
name, discount rate, payback periods, and whether the manufacturer prefers to pay CAFE fines
must all be specified.

Table 8. Manufacturers Worksheet

Category Column Units Definition/Notes
Manufacturer Code integer | Unigue number assigned to each manufacturer.
Manufacturer Name text Name of the manufacturer.

Represents whether the manufacturer prefers to pay civil penalties instead of applying non
cost-effective technologies.

] Prefer Fines text - 'Y = pay fines instead of applying ineffective technologies
% - N = apply ineffective technologies instead of paying fines
o Discount Rate number Represe_nts the mar)ufacturer specific dis_c_ount rate, which factors into th_e effective cost
calculation. The discount rates are specified per class and style of a vehicle.
. The number of years required for an initial investment to be repaid in the form of future
Payback Period number

benefits or cost savings. The payback periods are specified per class and style of a vehicle.

Payback Period (OC) number | The payback period to use after the manufacturer reached compliance.

T na - - i
% = é i$ ;818 :g i$ ;813 g:zg::: Represents the manufacturer's available credits, banked from model years preceding the start
© 0 - - i ifi

g5 5 [2B3-2010 to 2B3-2014 | credits of analysis, specified for each regulatory class between model years 2010 and 2014.
> é B [ PE-2015to PC-2019 mpg Represents the manufacturer's available FFV credits towards CAFE compliance, specified for
o2 E‘ LT-2015t0 LT-2019 mpg each regulatory class between model years 2015 and 2019.

~ | 2B3-2015to 2B3-2019 | mpg

CA+S177 Sales (%) Zevs The percentage of manufacturer's total fleet assumed to be sold in California and S177 states.
ZEV The percentage of manufacturer's ZEV credits assumed to be generated in California and

Credits | CA+S177 ZEV (%) zevs Sl77pstates g g

A.1.2 Vehicles Worksheet

The vehicles worksheet contains information regarding each vehicle model offered for sale
during the study period. Each vehicle model is represented as a single row of input data. Data in
Table 9 lists the different columns of information specified in the vehicle models worksheet.

Table 9. Vehicles Worksheet

Category | Column Units Definition/Notes

Vehicle Code integer Unique number assigned to each vehicle.
Manufacturer text The manufacturer of the vehicle.

= Brand text The brand name of the vehicle.

5 Model text Name of the vehicle model.

g Nameplate text The nameplate of the vehicle.
Platform text The platform of the vehicle.
Engine Code integer The engine code of the engine that the vehicle uses.
Transmission Code | integer The transmission code of the transmission that the vehicle uses.
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Primary Fuel

- SHEVPS = power-split strong hybrid

Type? text The primary fuel type on which the vehicle operates.
Eg&i%;tljel number The CAFE fuel economy rating of the vehicle on the primary fuel type.
>
g %‘;‘;ijary Fuel text The secondary fuel type on which the vehicle operates (if applicable).
c
Q -
@ Eig%gﬁ)%':uel number The CAFE fuel economy rating of the vehicle on the secondary fuel type (if applicable).
[}
>
L Eﬂ:: E;gg?zr;]y (by number The CAFE fuel economy rating of the vehicle for each fuel type.
Fuel Share (by The percent share that the vehicle runs on each fuel type. This value indicates the amount gf
22 number miles driven by the vehicle on each fuel type. The sum of all fuel shares for any given vehicle
Fuel Type*)
must add up to one.
MY2015 units
» MY?2016 units
= Vehicle's projected production for sale in the US.
@ MY2031 units
MY2032 units
MSRP MSRP dollars Vehicle's projected average MSRP (sales-weighted, including options).
Origin text D = domestic; | = imported
Style text Vehicle style.
Structure text Vehicle structure (ladder or unibody).
Dri Vehicle drive (A=all-wheel drive, F=front-wheel drive, R=rear-wheel drive, 4=four-wheel
rive text drive).
Wheelbase inches ;‘ggsc;istance between the centers of the front and rear wheels, per SAE J1100, L101 (Sept.
-(I-Frfgrlft)w idth inches The distance between the front left and right wheels, per SAE J1100, W101-1 (Sept. 2005).
s '(I'l_‘r)a:;l:)Wldth inches The distance between the rear left and right wheels, per SAE J1100, W101-2 (Sept. 2005).
‘g Footprint sq. feet The vehicle footprint; wheelbase times average track width.
S Curb Weight pounds Total vyeight of t'he vehicle, including batteries, lubricants, and other expendable supplies, but
= excluding the driver, passengers, and other payloads (SAE J1100).
2 GVWR pounds Gross Vehicle Weight Rating; weight of loaded vehicle, including passengers and cargo.
= Gross Combined Weight Rating; weight of loaded vehicle, including passengers and cargo, as
< GCWR pounds . . -
> well as the mass of the trailer and cargo in the trailer.
Maximum ratio of GVWR to Curb Weight allowed for the vehicle. During application of mass
Max GVWR/CW proportion | reduction technology, vehicle's GVWR will be adjusted such that its GVWR/CW ratio does not
exceed this value.
Max Maximum ratio of GCWR to GVWR allowed for the vehicle. During application of mass
proportion | reduction technology, vehicle's GVWR will be adjusted such that its GVWR/CW ratio does not
GCWR/GVWR -
exceed this value.
Fuel Capacity gallons The capacity o_f the vehicle's fuel tank in gallons of diesel fuel or gasoline; MJ (LHV) of other
fuels (or chemical battery energy).
Employment . hours Employment hours associated with the production of each vehicle model.
Hours per Vehicle
Vehicle Power hp Maximum horsepower produced by the vehicle's engine or motor.
o= Vehicle Power rpm
R (RPM) The RPM at which vehicle's maximum horsepower is attained.
§ g Vehicle Torque Ib-ft Maximum torque produced by the vehicle's engine or motor.
& | Vehicle Torque om
(RPM) P The RPM at which vehicle's maximum torque is attained.
- Hybridization type of the vehicle, if any.
2 Tve of - 12VSS/SS12V = 12V micro hybrid
S Hyz id/Electri text - BISG = belt mounted integrated starter generator
2 ybric/Electric ex - CISG = crank mounted integrated starter generator
g Vehicle
I

- SHEVP2 = P2 strong hybrid

2L The "Primary Fuel Type",

"Primary Fuel Economy", "Secondary Fuel Type", and "Secondary Fuel Economy"
columns are specified for reference and are not used by the modeling system. Instead, the values in these columns
are used to inform the fuel economies and fuel shares by fuel type specified in adjacent columns.

22 For each vehicle, fuel economies and fuel shares are reported independently for each of the following fuel types:
gasoline, E85, diesel, electricity, hydrogen, and CNG. If the vehicle does not use a specific fuel type, the associated
fuel economy and fuel share values will be zero.
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- PHEV = plug-in hybrid
- EVIBEV = battery electric vehicle
- FCV = fuel cell vehicle
Electric Range number The range of an electric vehicle, in miles, when operating on a battery.
'\Dloltage or vo_Its or Voltage for HEV/PHEV/EV, pressure for hydraulic hybrid.
ressure psi
Vehicle's battery type.
Battery Type text - NiMH = Nickel Metal Hydride
- Li-ion = Lithium lon
Refresh/ Refresh Years )rg;criel List of previous and future refresh years of the vehicle, separated by a semicolon.
Redesign Redesign Year ;I:;?el List of previous and future redesign years of the vehicle, separated by a semicolon.
The regulatory assignment of the vehicle.
Regulatory Class text -PC =the vehicle should be regulated as a passenger automobile
- - LT = the vehicle should be regulated as a light truck
2 - LT2b3 = the vehicle should be regulated as a class 2b/3 truck
é Technology Class text The technology class assignment of the vehicle.
g Eggrll?lilogy Class text The engine technology class assignment of the vehicle.
O - -
> The safety clasg assignment of the vehicle. )
% Safety Class text -PC =the veh!cle belongs to a passenger automobile safety class
= - LT = the vehicle belongs to a light truck/SUV safety class
E’ - CM = the vehicle belongs to a light CUV/minivan safety class
Indicates whether a vehicle is a preferred candiate for ZEV technology application. The
ZEV Candidate text modeling system will attempt to upgrade ZEV candidates to a PHEV or a BEV in order to meet
the ZEV requirement.
EPS text
IACC1 text
IACC2 text
SS12v text
BISG text
CISG text
SHEVP2 text
s SHEVPS text
= PHEV30 text
1S PHEV50 text
ug BEV200 text <blank> = the technology is not used on the vehicle
- FCV text USED = the technology is used on the vehicle
g LDB text SKIP = the technology is not applicable to the vehicle
2 SAX text
E ROLL10 text
= ROLL20 text
MR1 text
MR2 text
MR3 text
MR4 text
MR5 text
AERO10 text
AERO20 text

The applicability of technologies considered on a vehicle model basis (as opposed, for example,
on an engine basis) can be controlled for each vehicle model by using the Technology
Information category. Since the modeling system relies heavily on these settings when
determining the initial usage and availability of technology to a vehicle, this section must be
complete and accurate in order to avoid modeling errors.

A.1.3 Engines Worksheet
Similar to the vehicles input sheet, the engines worksheet contains a list of all engines used in

vehicle models offered for sale during the study period. For each manufacturer, the engine code
IS a unique number assigned to each such engine. This code is referenced in the engine code
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field on the vehicles worksheet. As in the vehicles worksheet, the Technology Information for
any engine technology must be complete and accurate for any specific engine.

Table 10. Engines Worksheet

Category | Column Units Definition/Notes
Engine Code integer | Unigue number assigned to each engine.
Manufacturer text The manufacturer of the engine.
Configuration text Configuration of the engine.
One or more fuel types with which the engine is compatible.
- G = gasoline
Fuel text - D =diesel
- G+EB85 = flex fuel engine, running on gasoline and E85
- CNG = compressed natural gas
Engine Oil Viscosity text Ratio between t_he applied shear stress and the rate of shgar, which measures the resistance of
flow of the engine oil (as per SAE Glossary of Automotive Terms).
Cycle text Combustion cycle of the engine.
Air/Fuel Ratio number | Weighted (FTP+highway) air/fuel ratio (mass).
Fuel Delivery System | text The mechanism that delivers fuel to the engine.
Breathing or induction process of the engine (per SAE Glossary of Automotive Terms).
- NA = naturally aspirated
- S = supercharged
Aspiration text - T = turbocharged
- T2 = twin-turbocharged
- T4 = quad-turbocharged
- ST = supercharged and turbocharged
— . . Design of the total mechanism from camshaft to valve of an engine that actuates the lifting and
% Valvetrain Design text closing of a valve (per SAE Glossary of Automotive Terms).
8 Valve opening and closing points in the operating cycle (SAE J604).
- F = fixed
Valve text - VVT = variable valve timing
Actuation/Timing - ICP = intake cam phasing VVT
- DCP = dual cam phasing VVT
- CCP = coupled cam phasing VVT
The manner in which the valve is raised during combustion (per SAE Glossary of Automotive
Terms).
. - F =fixed
Valve Lift text - VVL = variable valve lift
- DVVL = discrete VVL
- CVVL = continuous VVL
Cylinders integer | Number of engine cylinders.
Valves/Cylinder integer | Number of valves per cylinder.
Indicates whether the engine includes a cylinder deactivation mechanism.
Deactivation text - 'Y = cylinder deactivation applied
- N = cylinder deactivation not applied
Displacement liters Total volume displaced by a piston in a single stroke.
E:l\(zm;))ressmn Ratio number | Minimum compression ratio of an engine.
E:'\zg;gressmn Ratio number | Maximum compression ratio of an engine.
'g The relative size of the engine, with respect to technology application. Allowed values are:
= - - SD or Small = a small sized engine
§ S Engine Size text - MD or Medium = a medium sized engine
O - LD or Large = a large sized engine
SOHC text
DOHC text
2 OHV text
5 TEFRI text
8 LUBEFR1 text
S LUBEFR2 text <blank> = the technology is not used on the engine
i LUBEFR3 text USED = the technology is used on the engine
= VVT text SKIP = the technology is not applicable to the engine
S VVL text
§ SGDI text
= DEAC text
HCR text
TURBO1 text
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SEGR text
DWSP text
TURBO2 text
CEGR1 text
CEGR2 text
LGDI text
CNG text
ADSL text
TURBODSL text
IPIDSL text
DWSPDSL text
EFRDSL text
CLCDSL text
LPEGRDSL text
DSIZEDSL text

A.1.4 Transmissions Worksheet

Similar to the vehicles and engines input sheets, the transmissions worksheet contains a list of all
transmissions used in vehicle models offered for sale during the study period. For each
manufacturer, the transmission code is a unique number assigned to each such transmission.
This code is referenced in the transmission code field on the vehicles worksheet. As in the
vehicles worksheet, the the transmission code field on the vehicles worksheet Technology
Information for any transmission technology must be complete and accurate for any specific
transmission.

Table 11. Transmissions Worksheet

Category | Column Units Definition/Notes
Transmission Code integer | Unigue number assigned to each transmission.
Manufacturer text The manufacturer of the transmission.
Type of the transmission.
S - M = manual
% Type text - A = automatic (torque converter)
o - AMT = automated manual transmission (single clutch w/ torque interrupt)

- DCT = dual clutch transmission
- CVT = belt or chain CVT
Number of Forward Gears | integer | Number of forward gears the transmission has.

MT5 text
. MT6 text
= MT7 text
3 TATI text
S 2%51 :zﬁ <blank> = the technology is not used on the transmission
i ATI2 text USED = the technology is used on the transmission
g AT6 toxt SKIP = the technology is not applicable to the transmission
£ ATS8 text
E CVT text
DCT6 text
DCT8 text
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A.2

Technologies File

The technologies input file contains assumptions regarding the fuel consumption benefit, cost,
and applicability of different vehicle, platform, engine, and transmission-level technologies
available during the study period. As described in Section S2.2.1 above, input assumptions are
defined for the seven vehicle technology classes listed in Table 3 and sixteen engine technology
classes listed in Table 4. Input assumptions that are common among all technology classes are
listed on a separate technologies definitions tab. Table 12 shows the contents of a technologies
definitions tab for all classes while Table 13 and Table 14 shows the contents of the technology
assumptions tabs.

Table 12. Technology Definitions

Category Column Units Definition/Notes
Index integer Unique index assigned to each technology.
Name text Name of the technology.
s Technology Description | text Description of the technology.
% The path within which the technology progresses. For most technologies, the
o Technology Path text incremental costs and fuel consumption improvements are accrued over the preceding
technology within the same path.
Phase-in Cap percentage | Percentage of the entire fleet to which the technology may be applied.
Off-Cycle i$ (C))gg grams Amount of off-cycle credit that the vehicles incur as a result of applying the technology.
Credits b3 OCC per mile Specified in grams per mile of CO2 for each regulatory class.
Other ZEV Credits zevs Amount of ZEV credits a vehicle will generate upon application of the technology.

The technology assumptions inputs listed in Table 13 are specified for each technology and for
each of the defined vehicle technology class.

Table 13. Technology Assumptions

Category | Column Units Definition/Notes

= Index integer Unique index assigned to each technology.
% Name text Name of the technology.
O Technology Path text The path within which the technology progresses.

Applicable boolean TRUE = the technology is: available_ for applicabil_ity i_n_a tgchnology class
E PP FALSE = the technology is not available for applicability in a technology class
E Year Avail. )r:]e(;(:el First year the technology is available for applicability.
«©
z . model - .
< Year Retired year Last year the technology is available for applicability.
f2) FC percentage | Fuel consumption improvement estimate of a technology.
é Fuel consumption improvement estimate of a technology, when a vehicle is operating on its
g Secondary FC percentage | secondary fuel type (applicable when a vehicle is being converted into a plug-in HEV or
o another form of dual fuel vehicle).
% Percentage of miles a vehicle is expected to travel on its secondary fuel after applying a dual-
) Secondary FS percentage | fuel technology (applicable when a vehicle is being converted into a plug-in HEV or another
L form of dual fuel vehicle).

Electric Range number Indicates what the range, in_ miles, of an electric vehicle would be when operating ona
@ battery, as a result of applying the technology (applies to PHEV and EV technologies only).
E Electric Power hp Indicates what'the power of an electrlc'vehlcle would be when operating on a battery, as a
= result of applying the technology (applies to PHEV and EV technologies only).
< Delta Weight (%) percentage | Percentage by which the vehicle's weight changes as a result of applying the technology.
.é Delta Weight (Ibs) number grcr;](:%r;;of pounds by which the vehicle's weight changes as a result of applying the

gy.
Consumer Valuation | dollars The consumer welfare loss (or gain) associated with application of the technology.

The technology costs inputs shown in Table 14 are specified for each technology, for each of the
defined vehicle technology classes as well as each of the defined engine technology classes.
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Table 14. Technology Costs

Category | Column Units Definition/Notes
= Index integer | Unique index assigned to each technology.
% Name text Name of the technology.
O Technology Path | text The path within which the technology progresses.
o C2015 dollars
3 C2016 dollars
= Table of learned out cost estimates for the technology, per model year.
§ C2031 dollars
C2032 dollars
@ M2015 dollars
3 M2016 dollars
= Table of learned out maintenance cost estimates for the technology, per model year.
[
'z M2031 dollars
= M2032 dollars
@ R2015 dollars
3 R2016 dollars
= Table of learned out repair cost estimates for the technology, per model year.
S [R2031 dollars
o R2032 dollars
@ SC-1 dollars
g E SC-2 dollars
S= Penalty costs associated with replacing (or superseding) a technology early.
&3 [SC9 dollars
O SC-10 dollars

A.2.1 Technology Synergies

The technologies input file contains two additional worksheets for specifying fuel consumption
adjustments (or synergies) and cost adjustments to augment the base improvement factor and
cost of a technology. The detailed description and applicability of the synergy values are
described in Sections S2.2.5 and S2.2.6 above. Table 15 shows the contents of the technology
synergies worksheets.

Table 15. Technology Synergies

Category | Column Units Definition/Notes

General | Technologies | text Combination of technologies to which the fuel consumption adjustment or cost synergy applies.

SmallCar
MedCar
SmallSUvV Fuel consumption multiplier by which to adjust a vehicle's fuel economy whenever application of a
MedSUV number | technology results in a vehicle's “technology utlization state” being equal to a combination specified in
Pickup the "technologies” column. A separate adjustment factor is specified for each technology class.
Truck2b3
Van2b3

Adjustment
Factors by Class

2C1B

3C1B

4C1B

4C2B

5C1B

6C1B
6C1B_OHV
6C2B The amount by which to offset the technology cost whenever application of a technology results in a
6C2B_OHV dollars | vehicle using all technologies specified in the "technologies” column. A separate synergy value is
8C2B specified for each technology cost class.

8C2B_OHV
10C2B
10C2B_OHV
12C2B
12C4B
16C4B

NA

Adjustment Factors by Cost Class
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A.3 Parameters File

The benefits model parameters file contains a variety of input data and assumptions used to
estimate various impacts of the simulated response of the industry to CAFE standards. The file
contains a series of worksheets, the contents of which are summarized below.

A.3.1 Vehicle Age Data

The Vehicle Age Data worksheet contains age-specific (i.e., vintage-specific) estimates of the
survival rate and annual accumulated mileage applicable to different vehicle categories.

Table 16. Vehicle Age Data Worksheet
Category | Model Characteristic | Units Definition/Notes
Proportion of original vehicle sales that remain in service by

o 8 i ;

g 8 Survival Rates proportion vehicle age (year 1 to 30 for cars, 1 to 37 for trucks).

AN . - . Average annual miles driven by surviving vehicles by vehicle
> < Miles Driven miles age (year 1 to 30 for cars, 1 to 37 for trucks).

Separate survival fractions and annual miles driven are used for cars, vans, SUVSs, pickups,
ZEVs, and class 2b/3 trucks. The survival fractions measure the proportion of vehicles originally
produced during a model year that remain in service at each age, by which time only a small
fraction typically remain in service.

A.3.2 Fuel Prices

The Fuel Prices worksheet contains historic and estimates of future fuel prices, which are used
when calculating pre-tax fuel outlays and fuel tax revenues.

Table 17. Forecast Data Worksheet
Category | Model Characteristic | Units Definition/Notes
4] Retail Fuel Prices 2013 $ per gallon, varies by fuel type, forecast by calendar year
(low, average, high) staring with MY-1975.
2013 $ per gallon, varies by fuel type, forecast by calendar year
Fuel Taxes $igallon | - ing with MY-2000.

$/gallon

Fuel Price

A.3.3 Fuel Economy Data

The Fuel Economy Data worksheet contains historic and projected fuel economy levels for
passenger cars, light trucks, and class 2b/3 trucks, for each fuel type (gasoline, diesel, ethanol-85,
electricity, and hydrogen). The associated fuel shares are also provided.

Table 18. Fuel Economy Data Worksheet

Category | Model Characteristic Units Definition/Notes
> Fuel Economy m Historic and projected fuel economy levels for each
E E g (by Fuel Type and Fleet) Pg available fuel type and fleet type.
L g O | Fuel Share ercentage | Historic and projected fuel shares for each available fuel
L (by Fuel Type and Fleet) P g type and fleet type.
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A.3.4 Economic Values

The Economic Values worksheet contains an estimate of the magnitude of the “rebound effect”,
as well as the rates used to compute the economic value of various direct and indirect impacts of
CAFE standards, and the discount rate to apply when calculating present value. As mentioned
above, the user can define and edit all inputs. For example, although the economic values in
Table 19 were obtained from various sources of information, the system does not require that the
user rely on these sources.

Table 19. Economic Values Worksheet

Category | Model Characteristic Units Definition/Notes
Rebound Effect ercentage Increase in the annual use of vehicle models in response to lower per-mile cost
P 9 of driving a more fuel-efficient vehicle.
Percent rate by which the dollar value of a benefit or cost is reduced when its
Discount Rate percentage receipt or payment is postponed by one additional year into the future; used for
calculating socially-valued benefits.
The calendar year to use for "present year" discounting. If a base year value is
Base Year for Discountin ercentage used, social discounting is assumed, with all costs and benefits being
Y P g discounted to that year. If no value is specified, private discounting is implied,
with all costs and benefits being discounted to the model year being analyzed.
Annual Growth Rate for . -
Average VMT per Vehicle various Annual growth rate for average VMT per vehicle.
Base Year for Average .
Annual Usage Data model year Base year for annual growth rate for average VMT per vehicle.
Eggrvs?i;ate at Low percentage Annual growth rate for average VMT per vehicle, when using low fuel prices.
Growth Rate at Average ercentage Annual growth rate for average VMT per vehicle, when using average fuel
Fuel Price P g prices.
(FBJS;/th’?iCReate at High percentage Annual growth rate for average VMT per vehicle, when using high fuel prices.
"Gap" between Test and On- ercentage Difference between a vehicle's EPA fuel economy rating and its actual on-road
Road MPG (by Fuel Type) P 9 fuel economy.
Elé(fidelﬁom'lr')ﬂ:?; ?\jlﬁ\ljteggge minutes Average refueling time a spent by a consumer refueling the vehicle tank or
9 recharging the vehicle electric battery.
9 (by Fuel Type)
= Average Tank Volume . - .
g Refueled percentage Average tank volume refilled during a refueling stop.
E Value of Travel Time per $/hour Amount that the driver of a vehicle would be willing to pay to reduce the time
S Vehicle required to make a trip.
3 External Costs from Estimates intended to represent costs per vehicle-mile of increased travel
L

Additional Vehicle Use Due
to ""Rebound"* Effect

$/vehicle-mile

compared to approximately current levels, assuming current distribution of
travel by hours of the day and facility types.

Congestion $/vehicle-mile | Congestion component of external costs from additional vehicle use.
Accidents $/vehicle-mile | Accidents component of external costs from additional vehicle use.
Noise $/vehicle-mile | Noise component of external costs from additional vehicle use.

Ownership and Operating

Costs
Taxes & Fees (% of final Average percentage of the vehicle's final MSRP the consumer pays in taxes
vehicle MSRP) percentage and fees when purchasing a new vehicle.
Financing (% of final Average percentage of the vehicle's final MSRP the consumer would pay for

- percentage A - .
vehicle MSRP) financing a new vehicle.
Insurance (% of final Average percentage of the vehicle's final MSRP the consumer would pay for
vehicle MSRP) percentage insuring a new vehicle.
(RU/?)I?)E‘I\flien;/Ia\I/LeJEiIEIOeS?\/ISRP percentage Average percentage of the vehicle's final MSRP, Wt_]ich translates in?o rela_tive
' value loss to consumer due to decreased operating life of pure electric vehicles.
pure EVs only)
Resale Value percentage Ave_rage perce@tage of the vehicle's final MSRP the consumer recoups after
selling the vehicle.
Economic Costs of QOil
Imports
Demand cost for imported oil; increasing domestic petroleum demand that is
" " met through higher oil imports can cause the world price of oil to rise, and
Monopsony" Component $/gallon

conversely that declining imports can reduce the world price of oil; determined
by a complex set of factors, including the relative importance of U.S. imports
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in the world oil market and demand to its world price among other participants
in the international oil market.

Expected value of costs to U.S. economy from reduction in potential output
resulting from risk of significant increases in world petroleum price; includes
Price Shock Component $/gallon costs resulting from inefficiencies in resource use caused by incomplete
adjustments to industry output levels and mixes of production input when
world oil price changes rapidly.

Costs of taxpayers for maintaining a military presence to secure the supply of
$/gallon oil imports from potentially unstable regions of the world and protect the
nation against their interruption.

Military Security
Component

A.3.5 Fleet Analysis Values

The Fleet Analysis Values worksheet contains fine tuning parameters for performing fleet
analysis calculations. The Forecast of Sales contains projected vehicle production for sale in the
U.S. between model years 2014 and 2064 and is used to estimate additional car and truck fleet
values, beyond what is available on the Historic Fleet Data worksheet (discussed below). When
fleet analysis option is used, the system evaluates modeling effects for historic and forecast
model years, producing outputs required for the EIS.

Table 20. Fleet Analysis Values Worksheet
Category | Model Characteristic Units Definition/Notes
Fuel Economy Growth Rates

Growth rates used to estimate additional fuel economy
percentage | growth beyond the last model year covered during the
study period for the baseline scenario.

Growth rates used to estimate additional fuel economy
percentage | growth beyond the last model year covered during the
study period for the action alternatives.

The model year when Fuel Economy regulations were
first introduced. This value is useful when evaluating
model year | the fuel use and environmental effects assuming the
absence of CAFE standards.

This value is not used in this version of the model.
The forecast of total industry sales by model year.

The first model year specified should be immediately
following the last model year from the Historic Fleet
units Data. Forecast of Sales are used to scale individual
vehicle sales, after the last compliance model year, in
order to evaluate the fuel use and environmental
effects of future years during Fleet Analysis.

Baseline Scenario
(by Fleet Type)

Action Alternatives
(by Fleet Type)

CAFE Start Year
(by Fleet Type)

Fleet Analysis Values

Forecast of Sales
(by Fleet Type)

A.3.6 Historic Fleet Data

The Historic Fleet Data worksheet provides historic data of vehicles remaining on the road,
specified by model year for each vehicle age, for the car, class 1/2a truck, and class 2b/3 truck
fleets. The period of years covered is between 1975 and 2014.

Table 21. Historic Fleet Data Worksheet
Category Model Characteristic Units | Definition/Notes
Historic car and truck fleet data for each fleet type and
model year, specified by vehicle age.

Historic Fleet Data | Fleet Data (by Fleet Type) | units

A.3.7 Safety Values

The Safety Values worksheet contains parameters for estimating additional fatalities resulting
from decreases in vehicle weight.
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Table 22. Safety Values Worksheet

Category | Model Characteristic Units Definition/Notes
PC Threshold Ibs. .
The boundary between small and large weight effects
LT/SUV Threshold Ibs. by safety class
CUV/Minivan Threshold Ibs. y y )
Change per 100 Ibs. percentage | Change per 100 Ibs. below the weight threshold.
8 - . Base fatalities per billion miles below the weight
= Base per billion miles
K threshold.
. Adjustment for new FMVSS below the weight
5 Adjustment for new FMVSS threshold.
3 Monetized Fatalities
Cost Value dollar Social costs arising from vehicle fatalities.
Growth Rate percentage | Annual growth rate for fatality costs per vehicle.
Base Year for Annual Base year for annual growth rate for fatality costs per
Growth model year vehicle.

A.3.8 Credit Trading Values

The Credit Trading Values worksheet contains fine tuning parameters for enabling credit

transfers and credit carry forward within the model.

Table 23. Credit Trading Values Worksheet

Category | Model Characteristic Units Definition/Notes
. . . Fine Tuning Parameters for using Credit Trading option
Credit Trading Options in the model.
Whether to allow credit trading between manufacturers
Trade credits between boolean within the same compliance category (i.e., regulatory
manufacturers class) and model year.
This option is not supported in this version of the model.
Transfers credits between boolean Whether to allow credit transfers between regulatory
regulatory classes class within the same manufacturer and model year.
. . Whether to allow carrying of credits forward into the
%i;% [;Tr]i%'éf fcé;\:;ard nto boolean | analysis year from earlier model years within the same
Y manufacturer and compliance category.
" -
3 :\gi);lrr:yu?;rr\:\l:arp dber of years integer | Maximum number of model years to look forward.
[
; Whether to allow carrying of credits backward into the
._g Carry credits backward boolean analysis year from future model years within the same
IS into past model years manufacturer and compliance category.
:, This option is not supported in this version of the model.
B Maximum number of years integer Maximum number of model years to look backward.
(8} to carry backward Y This option is not supported in this version of the model.
Transfer caps corresponding to the maximum amount of
Transfer Caps (mpg) m credits that may be transferred into a compliance
ps (Mpg P9 category for each model year. The cap from the latest
model year is carried forward for all subsequent years.
Assumed Lifetime VMT by miles Assumed lifetime VMT to use when credits are
Regulatory Class transferred between compliance categories.
Additional Runtime Options
The modeling system will attempt to use available
Maximum Expiring Credit inteaer credits before they expire. This setting indicates
Years to Consider 9 maximum number of model years to consider when
using expiring credits.

A.3.9 ZEV Credit Values

The ZEV Credit Values worksheet contains parameters allowing the modeling system to target

the ZEV requirements of CA+S177 states during compliance simulation.
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Table 24. ZEV Credit Values Worksheet
Category | Model Characteristic Units Definition/Notes
Minimum percentage of zero emission vehicle (ZEV)
credits that a manufacturer must generate in order to
meet the ZEV requirement in each specified model
year.
Maximum percentage of ZEV credits that a
manufacturer may generate from PHEVS in order to
meet the ZEV requirement in each specified model
year.

ZEV Requirement (%) percentage

Max Credits from PHEV (%) | percentage

ZEV Credit Values

A.3.10DFS Model Values

The DFS Model Values worksheet contains fine tuning parameters for utilizing the Dynamic
Fleet Share model within the modeling system. When enabled, the DFS model adjusts the
production volumes in future model years as a response to increasing fuel economies and costs
of vehicle models within a given compliance category.

Category | Model Characteristic Units Definition/Notes
Initial Share of Indicates the fleet share of the LDV fleet, versus the entire
the LDV fleet percentage | light duty fleet (cars and trucks), for the model year
(passenger cars) immediately preceding the first analysis year.
Initial Fuel Economy Average fuel economy for the LDV fleet for the model year
4] of the LDV fleet mpg . A - . .
S immediately preceding the first analysis year.
§ (passenger cars)
- Initial Fuel Economy
s (trucks, class 1/2a) )
p Initial Fuel Economy
a of the LDT2b/3 fleet mpg This option is not supported in this version of the model.
(trucks, class 2b/3)
Epsilon Additional constant that serves as a "randomizer" when
"p - number dynamically adjusting the PC/LT fleet share. This value
("randomizer" parameter) -
should typically be zero.

A.3.11Fuel Properties

The Fuel Properties worksheet contains estimates of the physical properties of gasoline, diesel,
and other types of fuels, as well as certain assumptions about the effects of reduced fuel use on
different sources of petroleum feedstocks and on imports of refined fuels. These fuel properties
and assumptions about the response of petroleum markets to reduced fuel use are used to
calculate the changes in vehicular carbon dioxide emissions as well as in “upstream” emissions
(from petroleum extraction and refining and from fuel storage and distribution) that are likely to
result from reduced motor fuel use.

Table 25. Fuel Properties Worksheet

Category | Model Characteristic Units Definition/Notes
ﬁﬂzm ifXTotaI Assumed percentage | Estimated share of total fuel consumption by fuel type.
n . . Amount of energy stored in a given system or region of
3 Energy Density BTU/unit space per unit volume, specified by fuel type.
qé Mass Density grams/unit | Mass per unit volume, specified by fuel type.
o percentage . L
3 Carbon Content by weight Average share of carbon in fuel, specified by fuel type.
w SO-2 Emissions grams/unit | Sulfur Oxides emissions rate of gasoline and diesel fuels.
Fuel Import Assumptions
Share of Fuel Savings percentage | Assumed value for share of fuel savings leading to lower
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Leading to fuel imports.

Lower Fuel Imports

Share of Fuel Savings

Leading to Assumed value for share of fuel savings leading to

Reduced Domestic Fuel percentage reduced domestic fuel refining.

Refining

Share of Reduced Domestic . .
e . Assumed value for share of reduced domestic refinin

Refining from Domestic percentage from domestic crude. Y

Crude

;2?{%2; ?g:#ﬁ?g plgl?tgwdestlc percentage ,fAssumed value for share of reduced domestic refining

Crude rom imported crude.

A.3.12Emission Costs
The Emission Costs Worksheet contains emission damage costs arising from various pollutants.

Table 26. Emission Costs Worksheet

Category | Model Characteristic Units Definition/Notes
Emission Damage Costs
Carbon Monoxide $/metric-ton | Economic costs arising from Carbon Monoxide damage.
Volatile Organic $/metric-ton Economic costs arising from Volatile Organic Compounds
Compounds damage.
Nitrogen Oxides $/metric-ton | Economic costs arising from Nitrous Oxides damage.
- Particulate Matter $/metric-ton | Economic costs arising from Particulate Matter damage.
k2 Sulfur Dioxide $/metric-ton | Economic costs arising from Sulfur Oxides damage.
O Methane scalar Economic costs arising from Methane damage, specified
5 as GWP-scalar of CO-2 Costs.
8 Nitrous Oxide scalar Economic costs arising from Nitrous Oxide damage,
UE_, specified as GWP-scalar of CO-2 Costs.
CO-2 Damage

Discount rates to apply to low, average, high, or very high
Carbon Dioxide estimates.

Economic costs arising from Carbon Dioxide damage, by
Cost of CO-2 $/metric ton | calendar year; estimates for low, average, high, or very
high growth rates are provided.

CO-2 Discount Rates percentage

A.3.13Upstream Emissions

The Upstream Emissions worksheet contains emission factors for greenhouse gas and criteria
pollutant emissions from petroleum extraction and transportation, and from fuel refining, storage,
and distribution.

Table 27. Upstream Emissions Worksheet

Category | Model Characteristic Units Definition/Notes
Total emissions by stage of fuel production and
Petroleum Extraction grams/mil BTU | distribution from petroleum extraction, specified by

pollutant and fuel type.

Total emissions by stage of fuel production and
Petroleum Transportation | grams/mil BTU | distribution from petroleum transportation, specified
by pollutant and fuel type.

Total emissions by stage of fuel production and
Petroleum Refining grams/mil BTU | distribution from petroleum refining, specified by
pollutant and fuel type.

Total emissions by stage of fuel production and

Fuel TS&D grams/mil BTU | distribution from refined fuel transportation, storage,
and delivery, specified by pollutant and fuel type.
Subtotals from all stages of fuel production and
distribution.

Upstream Emissions
(Total Emissions by Stage of Fuel
Production and Distribution)

Subtotals grams/mil BTU
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A.3.14Tailpipe Emissions

With this revision of the modeling system, the tailpipe emission inputs were condensed into two
input sheets: the TE_Gasoline and TE_Diesel, specifying emissions from gasoline and diesel
operation, respectively. These worksheets contain vehicular criteria pollutant emission factors
specified by vehicle age and vehicle class (LDV, LDT1/2a, and LDT2b/3), with each group of
columns representing a different pollutant. For simplicity, gasoline and e85 fuels utilize the
tailpipe emissions provided on the TE_Gasoline worksheet, diesel fuel uses the emissions
specified on the TE_Diesel worksheet, while the remainder of the fuel types (e.g., electricity) are
assumed not to generate any tailpipe emissions.

Table 28. Tailpipe Emissions Worksheets

Category | Model Characteristic | Units Definition/Notes

5 3 Emission Rates Vehicle emission rates from gasoline operation. Emission
171 [3] '

g, 2 . rates are specified for each fleet (LDV, LDT1/2a, and

ol €« 0 (by Fuel Type grams/mile LDT2b/3), for historic and future model years, and for each
[ w| and Fleet) :

[ ~ vehicle age.
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A.4 Scenarios File

The scenarios file provides one or more worksheets that begin with “SCEN_" and are identified
as CAFE program scenarios, which are defined in terms of the design and stringency of the
CAFE program. The system numbers these scenarios as 0, 1, 2 ..., based on their order of
appearance. The first worksheet is assigned to Scenario 0, and is identified as the baseline
scenario to which all others are compared. Each scenario defines the CAFE program as it relates
to the following “regulatory classes”:

Table 29. Regulatory Classes

Reg. Class Includes

Passenger Car All passenger automobiles
Light Truck Class 1 and class 2a trucks
Light Truck 2b/3 | Class 2b and class 3 trucks

The “Regulatory Class” column on the vehicles worksheet discussed above is used to indicate
whether the vehicle is regulated as a Passenger Car (PC), Light Truck (LT), or Light Truck 2b/3
(2b3).

Within each scenario worksheet, the specifications for each regulatory class are defined
separately, using the parameters described in Table 30 below.

Table 30. Scenarios Worksheet

Category | Column Units Definition/Notes
S Function integer Functional form to use for computing the vehicle target.
£ . - number oefficients associated wi e functional form to use for computing the vehicle target.
E | ffunction coefficient | MM Coefficient ted with the functional form to use for computing the vehicle target
jb]
2 Min (mpg) m Minimum CAFE standard that each manufacturer must attain, specified as a flat-standard
=] P9 P9 in miles/gallon, or 0 if not applicable.
2 Min (%) ercentage Minimum CAFE standard that each manufacturer must attain, specified as a percentage of
i P 9 | the average requirement under the function-based standard, or 0 if not applicable.

Allow Fines boolean Indicates whether manufacturers are allowed to pay CAFE fines for non-compliance

instead of applying additional technologies.

Fine Rate number The CAFE fine rate for non-compliance in dollars per one credit of shortfall.

The applicability of multi-fuel vehicles for compliance calculations (does not apply to
single-fuel vehicles):

0 = only gasoline fuel economy value is considered (gasoline fuel share is assumed to be
100%);
Multi-Fuel integer 1 = for Gasoline/Ethanol-85 vehicles, only the gasoline fuel economy value is considered
(gasoline fuel share is assumed to be 100%); for Gasoline/Electricity vehicles, both fuel
economy values are considered;

2 = for Gasoline/Ethanol-85 and Gasoline/Electricity vehicles, both fuel economy values
are considered.

The statutory fuel share to use for compliance for flex-fuel vehicles (FFVs), whenever the
Multi-Fuel mode is 2. This fuel share applies only to vehicles operating on gasoline and
ethanol-85 fuel types. If 0 or <blank> is used, the vehicle’s assumed on-road fuel share will
be used for compliance.

FFV Share percentage

Specifies the statutory fuel share to use for compliance for plug-in hybrid/electric vehicles
(PHEVs), whenever the Multi-Fuel mode is either 1 or 2. This fuel share applies only to
vehicles operating on gasoline and electricity fuel types. If 0 or <blank> is used, the
vehicle’s assumed on-road fuel share will be used for compliance.

Supplemental Options

PHEV Share percentage

Whether to include adjustments for improvements in air conditioning (AC adjustments) for
compliance and effects calculations:

TRUE = include AC credits for compliance and effects calculations (credits, fines, and
whether mfr is in compliance);

FALSE = do not include AC credits for compliance and effects calculations (the achieved
CAFE in modeling reports will still show "CAFE w/o AC" as well as "CAFE with AC").

Include AC boolean

AC Adjustment number The AC adjustment factor in grams/mile of CO2.

AC Cost ($) dollar The cost of AC adjustment in dollars per unit.
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The maximum amount of credit a manufacturer may accrue from Off-Cycle technology

Off-Cycle Cap number improvements, specified in grams/mile of CO2.
FEV Ca number The maximum amount of credit a manufacturer may accrue from flex-fuel vehicles (FFVs),
P specified in vehcle-miles/gallon. This option is not supported in this version of the model.
SHEV Tax Credit dollar The_amount of Federal tax credits a buyer receives for purchasing a strong hybrid/electric
vehicle (SHEV).
. The amount of Federal tax credits a buyer receives for purchasing a plug-in hybrid/electric
PHEV Tax Credit dollar vehicle (PHEV).
EV Tax Credit dollar ‘(I'g\e/)amount of Federal tax credits a buyer receives for purchasing a pure electric vehicle
TW Function integer The functional form to use for computing the vehicle's test weight.
The percentage of curb weight reduction returned to payload capacity. This setting applies
whenever mass reduction technology is installed to a vehicle. For example, if payload
Payload Return percentage return is 0%, the vehicle's payload capacity remains the same; if payload return is 100%,
the vehicle's reduction in curb weight goes entirely to payload.
The percentage of GVWR reduction returned to towing capacity. This setting applies
Towing Return ercentage whenever mass reduction technology is installed to a vehicle. For example, if towing
Y P g return is 0%, the vehicle's towing capacity remains the same; if towing return is 100%, the
vehicle's reduction in GVWR goes entirely to towing.
The maximum number of years to carry forward. If a value is specified, this setting
Credit Carry Fwd integer overrides the value present in the parameters file. If 0 or <blank> is specified, the default

value from the parameters file will be used.
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Appendix B Model Outputs

The system produces seven output files in comma separated values (CSV) format. The system
places all files in the “reports” folder, located in the user selected output path (ex: C:\cafe\demo-
run\demo\reports-csv). Table 31 lists the available output types and their contents. With the
last revision of the modeling system, the structure of all outputs generated has changed from
earlier versions. The “raw” modeling results are stored as plain text (without any additional
formatting), in a “database-like” style. Most of the modeling reports have been extended to
include additional information, while some were scaled down to contain only the relevant
portions. As discussed earlier, the first scenario appearing in the scenarios file is assigned to
Scenario 0 and is treated as the baseline. The action alternatives are then assigned to Scenario 1,
2, and so on, in order of appearance. For all modeling reports, the baseline scenario always
shows absolute values, while, for the majority of reports, the action alternatives include relative
changes compared to the baseline, as discussed in the sections below.

Table 31. Output Files

Output File Contents

Contains manufacturer-level and industry-wide technology application and
penetration rates for each technology, model year, and scenario analyzed.
The results are disaggregated by regulatory class, as well as combined over
the entire fleet.

Technology Utilization Report

Contains manufacturer-level and industry-wide summary of compliance
Compliance Report model results for each model year and scenario analyzed. The results are
disaggregated by regulatory class, as well as combined over the entire fleet.

Contains industry-wide summary of energy and emissions effects for each
model year and scenario analyzed. The model produces two versions of
Societal Effects Report this output file, where the results are disaggregated by either the vehicle
class and fuel type or the regulatory class and fuel type, as well as
combined across all fuels and over the entire fleet.

Contains industry-wide summary of consumer and social costs for each
model year and scenario analyzed. The model produces two versions of
Societal Costs Report this output file, where the results are disaggregated by either the vehicle
class and fuel type or the regulatory class and fuel type, as well as
combined across all fuels and over the entire fleet.

This output file is similar to the Societal Effects Report, except it further

Annual Societal Effects Report disaggregates the results by calendar year.

This output file is similar to the Societal Costs Report, except it further

Annual Societal Costs Report disaggregates the results by calendar year.

Contains disaggregate vehicle-level summary of compliance model results,
Vehicles Report providing a detailed view of the final state of each vehicle examined by the
model, for each model year and scenario analyzed.

The remainder of this section discusses the contents of the output files.
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B.1 Technology Utilization Report

The Technology Utilization Report contains manufacturer-level and industry-wide technology
application and penetration rates for each technology. The application rates represent the amount
of technology that was applied by the modeling system during analysis while the penetration
rates represent the amount of technology that was either on the vehicle initially at the start of the
analysis, or applied by the modeling system during analysis. If a technology was present on or
applied to a vehicle, but later superseded during the modeling process by another technology (for
example, AT8 superseding AT6), the superseded technology on that vehicle will not count
toward the penetration rate.

Some of the technologies which are present in the baseline fleet, but are not explicitly analyzed
by the modeling system also appear in the report. An example of such technology is E85 FFV
(ethanol-85 flex-fuel vehicles).

The following table lists the contents of the Technology Utilization Report.

Table 32. Technology Utilization Report

Column Units Contents
Scenario integer Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action alternatives.
Et;er:gno text A short name describing the key features of the scenario.
model - .
Model Year year Model years analyzed during the study period.
Manufacturer | text Manufacturers analyzed during the study period. A value of "TOTAL" is used to represent industry-wide results.

The regulatory class for which the application and penetration rates are reported. When multiple regulatory classes

Reg-Class text are present in the output, a value of "TOTAL" is used to represent the sum across all classes.

Technology

(abbreviation) text The technology for which the application and penetration rates are reported.

The application rate of the technology, specified as a proportion of total sales. The application rates represent the
amount of technology that was applied by the modeling system during analysis. If a technology was applied to a
vehicle, but later superseded during the modeling process by another technology (for example, AT8 superseding
ATB), the superseded technology on that vehicle will not count toward the application rate.

App-Rate number

The penetration rate of the technology, specified as a proportion of total sales. The penetration rates represent the
amount of technology that was either on the baseline vehicle at the start of the analysis, or applied by the modeling
Pen-Rate number | system during analysis. If a technology was present on or applied to a vehicle, but later superseded during the
modeling process by another technology (for example, AT8 superseding AT6), the superseded technology on that
vehicle will not count toward the penetration rate.

The incremental application rate of the technology, which represents the difference between the action alternative

Incr.AR number . .
and the baseline scenario.

The incremental penetration rate of the technology, which represents the difference between the action alternative

Incr.PR number . .
and the baseline scenario.
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B.2

Compliance Report

The Compliance Report contains manufacturer-level and industry-wide summary of compliance
model results for each model year and scenario analyzed. The results are reported by regulatory

class, as well as aggregated for the entire fleet.

Most of the metrics, which are reported

independently by model year, are further summed (or averaged) over the entire analysis period.
The report provides various cost values associated with the rule, represented as “totals” across all

vehicle models, as well as “averages” per single vehicle unit.

The following table lists the

contents of the Compliance Report.

Table 33. Compliance Report

Column Units Contents
. . Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action
Scenario integer .
alternatives.
Scenario Name | text A short name describing the key features of the scenario.
Model Year model Model years analyzed during the study period. A value of "TOTAL" is used to represent the sums (or averages)
year across all model years for some of the outputs, where applicable.
Manufacturer text Manufacturers analyzed during the study period. A value of "TOTAL" is used to represent industry-wide results.
The regulatory class for which the compliance results are reported. When multiple regulatory classes are present
Reg-Class text in the output, a value of "TOTAL" is used to represent the sums (or averages) across all regulatory classes for
some of the outputs, where applicable.
- Total production of vehicles for sale for a specific model year, manufacturer, and regulatory class (as well as
Sales units - ;
sum across any of the attributes, where applicable).
Thousands of employment hours associated with the production of vehicle models. (The modeling system
k.Labor Hours hours (k) | applies any employment hours specified in the input file; however, the system reflects no predetermined
assumptions regarding the context for these inputs.)
Prelim-Stnd m Preliminary value of the required CAFE standard (before the "alternative minimum CAFE standard", as outlined
Pg in the scenarios input section, is applied).
Standard mpg The value of the required CAFE standard.
The value of the achieved CAFE standard, using a 2-bag test cycle, not including the adjustment for
CAFE (2-cycle) | mpg improvements in air conditioning or off-cycle credits.
CAFE m The value of the achieved CAFE standard, including the adjustment for improvements in air conditioning and
Pg off-cycle credits. This value is used for compliance purposes.
Average CW Ibs. Average curb weight of analyzed vehicles.
Average FP sq.ft. Average footprint of analyzed vehicles.
Average work-factor of analyzed vehicles. This value is reported only when the vehicles analyzed are subject to
Average WF Ibs. -
the work-factor based functional standards.
CO2 Required g;?n;]s“e The value of the required CO-2 standard.
. grams ;
CO2 Achieved per mile The value of the achieved CO-2 standard.
ZEV Target zevs Amount of ZEV credits required in order to meet the CA+S177 state's zero-emission vehicle standards.
ZEV Credits Zevs Amount of ZEV credits generated for compliance with the CA+S177 state's zero-emission vehicle standards.
Tech Cost dollarst thsil amount of technology costs accrued by all vehicles for a specific model year, manufacturer, and regulatory
Fines dollars! Total amount of fines paid by a manufacturer for a specific model year and regulatory class.
1 Total amount of regulatory costs accrued by all vehicles for a specific model year, manufacturer, and regulatory
Reg-Cost dollars .
class. The regulatory costs are the sum of technology costs and fines.
Total amount of technology costs accrued by all vehicles for a specific model year, manufacturer, and regulatory
. 1 class. If social discounting is used, the technology costs are discounted to the "Base Year for Discounting" value
Disc Cost dollars A - . - - -
specified in the parameters file. If private discounting is used, the discounted costs are the same as technology
Costs.
Value Loss dollars! Total loss in value to the consumer due to decreased range of pure electric vehicles.
Rel. Value Loss | dollars! Total relative loss in value to the consumer due to due to decreased operating life of pure electric vehicles.
Maint Cost dollars! Total maintenance costs accrued due to application of additional technologies.
Repair Cost dollars* Total repair costs accrued due to application of additional technologies.
i Total amount of taxes & fees paid by the consumers for purchasing new vehicles for a specific model year,
Taxes/Fees dollars
manufacturer, and regulatory class.
Financing dollars: Total amount paid by the consumers for financing new vehicles for a specific model year, manufacturer, and
regulatory class.
1 Total amount paid by the consumers for insuring new vehicles for a specific model year, manufacturer, and
Insurance dollars
regulatory class.
Total Consumer | dollars! The total consumer costs accumulated by the manufacturer for a specific model year and regulatory class. The
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Costs consumer costs are the sum of: discounted technology costs, fines, taxes & fees, financing costs, insurance
costs, maintenance costs, repair costs, loss of value, and relative loss of value.

Total Social The total social costs accumulated by the manufacturer for a specific model year and regulatory class. The social

Costs dollars! costs are the sum of: discounted technology costs, maintenance costs, repair costs, loss of value, and relative
loss of value.

Avg Tech Cost | dollars! Average technology costs per single vehicle unit.

Avg Fines dollars! Average fines paid per single vehicle unit.

Avg Reg-Cost dollars! Average regulatory costs per single vehicle unit.
Average technology costs per single vehicle unit. If social discounting is used, the technology costs are

Avg Disc Cost dollarst discounted to the "Base Year for Discounting" value specified in the parameters file. If private discounting is
used, the average discounted costs are the same as average technology costs.

Avg Value Loss | dollars! Average loss in value per single vehicle unit.

ﬁXSSREL Value dollars! Average relative loss in value per single vehicle unit.

Avg Maint Cost | dollars! Average maintenance costs per single vehicle unit.

é\ggtRepalr dollars! Average repair costs per single vehicle unit.

Avg Taxes/Fees | dollars! Average taxes & fees per single vehicle unit.

Avg Financing dollars! Average financing costs per single vehicle unit.

Avg Insurance dollars! Average insurance costs per single vehicle unit.

é\gsgts(:onsumer dollars! Average consumer costs per single vehicle unit.

é\gsgtsSomal dollars! Average social costs per single vehicle unit.
Total credits accumulated by the manufacturer for a specific model year and regulatory class. Manufacturers

Credits Earned credits? earn compliance credits whenever their achieved value of the CAFE standard is above the required value of the
CAFE standard (in mpg).

Credits Out credits? Total credits transferred out of a specific regulatory class (such as from domestic passenger automobiles to light
trucks) or carried forward from a previous model year.

Credits In credits? Total credits transferred into a specific regulatory class or carried forward into the present model year.

In the above table, note that:

(1) For the baseline scenario, all costs are specified as absolutes; for the action alternatives,
all costs are incremental and are specified as the difference between the action alternative
and the baseline scenario.

(2) For light duty vehicles (passenger cars, class-1 light duty trucks, and class-2a light duty
trucks), one credit equates to one mile per 10 gallons. For medium duty vehicles (class-2a
light duty trucks and class-3 light duty trucks), one credit equates to one gallon per 10k
miles.
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B.3 Societal Effects Report and Societal Costs Report

The Societal Effects Report contains industry-wide summary of energy and emissions effects,
while the Societal Costs Report contains corresponding industry-wide summary of consumer and
social costs for each model year and scenario analyzed. The modeling system generates two
versions of each report, where in one, the results are reported by vehicle class (LDV, LDT12a,
LDT2b3), while in the other, the results are reported by regulatory class (PC, LT, LT2b3). In
each case, the results are aggregated for the entire fleet as well. Most of the metrics, which are
reported independently by model year, are further summed (or averaged) over the entire analysis
period.

The Societal Effects Report also disaggregates energy and emissions effects by fuel type, as well
as providing aggregate totals across all fuels. The report contains calculated levels of energy
consumed by fuel type in quads, thousands of gallons, and thousands of native units during the
full useful life of all vehicles sold in each model year. For liquid fuel types (gasoline, diesel, and
E85), amount of gallons consumed is specified in their native units (for example, gallons of
E85). For non-liquid fuel types (electricity, hydrogen, CNG), amount of gallons consumed is
specified in gasoline equivalent gallons. Additionally, energy consumption in native units is
specified for electricity in mW-h, and for hydrogen and CNG in Mcf. Full useful life travel (in
thousands of miles) and average fuel economy levels are also presented to provide a basis for
comparison. The rated fuel economy levels reported are not comparable to the value of achieved
CAFE standard shown in the compliance report. The values contained in the Societal Effects
Report are computed as total VMT divided by total gallons (with the effect of the on-road gap
backed out), and do not incorporate some of the compliance credits.

The Societal Effects Report also presents estimates of full fuel cycle carbon dioxide and criteria
pollutant emissions by fuel type. As shown in Table 34 below, carbon dioxide emissions are
reported in million metric tons of carbon-equivalent emissions (one metric ton of carbon dioxide
IS equivalent to 12/44 of a metric ton of carbon), and all criteria pollutants are reported in metric
tons.

In the Societal Effects Report, for the baseline scenario, VMT, energy use, fatalities, and all
emissions are specified as absolutes. For the action alternatives, these values are incremental and
are specified as the difference between the action alternative and the baseline scenario.

The Societal Costs Report contains monetized consumer and social costs including fuel
expenditures, travel and refueling value, economic and external costs arising from additional
vehicle use, as well as owner and societal costs associated with emissions damage. In all cases,
these costs are calculated for the fleet of vehicles sold in each model year over their full useful
lives, discounted using the rate specified in the benefits model parameters file, and reported in
thousands of constant year-2013 dollars. Chapter Three, Section 6 of the primary text discusses
these types of costs and benefits in greater detail, and Appendix A (Model Inputs) discusses
corresponding input assumptions.
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In the Societal Costs Report, for the baseline scenario, all costs are specified as absolutes. For
the action alternatives, all costs are incremental and are specified as the difference between the
action alternative and the baseline scenario.

Table 34 below lists the full contents of the Societal Effects Report and Table 35 lists the full
contents of the Societal Costs Report.

Table 34. Societal Effects Report

Column Units Contents
Scenario integer Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action alternatives.
i;emngno text A short name describing the key features of the scenario.
model Model years analyzed during the study period. A value of "TOTAL" is used to represent the sums (or averages)
Model Year .
year across all model years for some of the outputs, where applicable.
The regulatory class for which the societal effects are reported. When multiple regulatory classes are present in
Reg-Class text the output, a value of "TOTAL" is used to represent the sums (or averages) across all regulatory classes for some
of the outputs, where applicable.
The vehicle class for which the societal effects are reported. When multiple vehicle classes are present in the
Veh-Class text output, a value of "TOTAL" is used to represent the sums (or averages) across all vehicle classes for some of the
outputs, where applicable.
The fuel type for which the societal effects are reported. A value of "TOTAL" is used to represent the sums (or
Fuel Type text -
averages) across all fuel types for some of the outputs, where applicable.
The average fuel economy rating of vehicles. Note, this value is not comparable to the value of achieved CAFE
Rated FE mpg standard shown in the compliance report; this value is computed as total VMT divided by total gallons (with the
effect of the on-road gap backed out), and does not incorporate some of the compliance credits.
On-road FE mpg The average on-road fuel economy rating of vehicles.
Fuel Share ratio The average fuel share, indicating the amount of miles driven by all vehicles on each fuel type.
Curb Weight Ibs. Average curb weight of analyzed vehicles.
Footprint sq.ft. Average footprint of analyzed vehicles.
Average work-factor of analyzed vehicles. This value is reported only when the vehicles analyzed are subject to
Work Factor Ibs. -
the work-factor based functional standards.
. Total production of vehicles for sale for a specific model year, regulatory or vehicle class, and fuel type (as well
Sales units . .
as sum across any of the attributes, where applicable).
KVMT miles (K) Thousands of miles traveled by all vehicles over their lifetime for a specific model year, regulatory or vehicle
class, and fuel type.
Energy used by all vehicles over their lifetime for a specific model year, regulatory or vehicle class, and fuel
Quads quads type
Amount of gallons of liquid fuel consumed, or amount of gasoline equivalent gallons of fuel consumed (for non-
gallons o - AL e .
kGallons ) liquid fuel types), by all vehicles over their lifetime for a specific model year, regulatory or vehicle class, and fuel
type.
Amount of energy consumed by all vehicles over their lifetime for a specific model year, regulatory or vehicle
KUnits varies class, and fuel type, where the units of measure vary based on fuel type. For liquid fuel types (gasoline, e85,
diesel, b20, LNG, LPG), the units are specified in thousands of gallons; for electricity, the units are specified in
mW-h; for hydrogen and CNG, the units are specified in Mcf.
Amount of fatalities resulting from reduction in vehicle curb weight and increases in VMT due to the rebound
Fatalities units effect, aggregated over the lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel
type.
. Amount of Carbon Monoxide emissions generated from domestic crude petroleum extraction, transportation, and
metric- . - - S - -
CO (b) tons refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type.
metric- Amount of Volatile Organic Compounds emissions generated from domestic crude petroleum extraction,
VOC (t) tons transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle operation,
aggregated over the lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type.
. Amount of Nitrogen Oxides emissions generated from domestic crude petroleum extraction, transportation, and
metric- . - - T ; -
NOx (t) tons refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type.
. Amount of Sulfur Dioxide emissions generated from domestic crude petroleum extraction, transportation, and
metric- . - - S - -
SO2 (1) tons refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type.
Amount of Particulate Matter (diameter of ~2.5 micrometers) emissions generated from domestic crude
PM (1) metric- petroleum extraction, transportation, and refining, from gasoline transportation, storage, and distribution, and
tons from vehicle operation, aggregated over the lifetime of all vehicles for a specific model year, regulatory or
vehicle class, and fuel type.
CO2 (mmt) million Amount of Carbon Dioxide emissions generated from domestic crude petroleum extraction, transportation, and
metric- refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the
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tons lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type.
metric- Amount of Methane emissions generated from domestic crude petroleum extraction, transportation, and refining,
CH4 (1) tons from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the lifetime
of all vehicles for a specific model year, regulatory or vehicle class, and fuel type.
- Amount of Nitrous Oxide emissions generated from domestic crude petroleum extraction, transportation, and
metric- e - - s - -
N20 (t) tons refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type.
- Amount of Acetaldehyde emissions generated from domestic crude petroleum extraction, transportation, and
Acetaldehyde metric- . ] - L . .
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the
t) tons i - oy -
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type.
metric- Amount of Acrolein emissions generated from domestic crude petroleum extraction, transportation, and refining,
Acrolein (t) tons from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the lifetime
of all vehicles for a specific model year, regulatory or vehicle class, and fuel type.
metric- Amount of Benzene emissions generated from domestic crude petroleum extraction, transportation, and refining,
Benzene (t from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the lifetime
tons 9 p g p gareg
of all vehicles for a specific model year, regulatory or vehicle class, and fuel type.
metric- Amount of 1,3-Butadiene emissions generated from domestic crude petroleum extraction, transportation, and
Butadiene (t) tons refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type.
. Amount of Formaldehyde emissions generated from domestic crude petroleum extraction, transportation, and
Formaldehyde | metric- . . - o . -
) tons refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type.
Amount of Diesel Particulate Matter (diameter of ~10 micrometers) emissions generated from domestic crude
DPM10 (1) metric- petroleum extraction, transportation, and refining, from gasoline transportation, storage, and distribution, and
tons from vehicle operation, aggregated over the lifetime of all vehicles for a specific model year, regulatory or
vehicle class, and fuel type.
metric- Amount of Methyl Tertiary Butyl Ether emissions generated from domestic crude petroleum extraction,
MTBE (t) transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle operation,
tons P P P

aggregated over the lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type.
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Table 35. Societal Costs Report

Column Units Contents
Scenario integer Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action alternatives.
Scenario Name | text A short name describing the key features of the scenario.
Model Year model Model years analyzed during the study period. A value of_"TOTAL" is used to represent the sums (or averages)
year across all model years for some of the outputs, where applicable.
The regulatory class for which the societal costs are reported. When multiple regulatory classes are present in the
Reg-Class text output, a value of "TOTAL" is used to represent the sums (or averages) across all regulatory classes for some of
the outputs, where applicable.
The vehicle class for which the societal costs are reported. When multiple vehicle classes are present in the
Veh-Class text output, a value of "TOTAL" is used to represent the sums (or averages) across all vehicle classes for some of the
outputs, where applicable.
Fuel Type text The fuel type for which the societal costs are reported. A value of_"TOTAL" is used to represent the sums (or
averages) across all fuel types for some of the outputs, where applicable.
Disc-Rate number | Social discount rate applied to future benefits. A value of 0 indicates undiscounted costs.
Pre-Tax Fuel dollars Total pre-tax fuel expenditures accumulated across all vehicles over their lifetime for a specific model year,
Cost (k) regulatory or vehicle class, and fuel type.
Fuel Tax Cost dollars Totf_il fuel tax revenues accumulated across all vehicles over their lifetime for a specific model year, regulatory or
(k) vehicle class, and fuel type.
Retail Fuel dollars Total retail fuel expenditures (pre-tax fuel cost + fuel tax cost) accumulated across all vehicles over their lifetime
Costs (k) for a specific model year, regulatory or vehicle class, and fuel type.
. dollars Benefits from the additional driving that results from improved fuel economy, accumulated across all vehicles over
Drive Surplus S e .
(k) their lifetime for a specific model year, regulatory or vehicle class, and fuel type.
dollars Benefits from reduced refu_eling frequenpy _due_ to the extendgc_l vehicle range and improved fugl economy,
Refuel Surplus ® accumulated across all vehicles over their lifetime for a specific model year, regulatory or vehicle class, and fuel
type.
Market dollars Economic costs of oil imports not accounted for by price, accumulated across all vehicles over their lifetime for a
Externalities (k) specific model year, regulatory or vehicle class, and fuel type.
Congestion dollars Congestion costs from additional vehicle use, accumulated across all vehicles over their lifetime for a specific
Costs (k) model year, regulatory or vehicle class, and fuel type.
. dollars Accident costs from additional vehicle use, accumulated across all vehicles over their lifetime for a specific model
Accident Costs -
(k) year, regulatory or vehicle class, and fuel type.
. dollars Noise costs from additional vehicle use, accumulated across all vehicles over their lifetime for a specific model
Noise Costs -
(k) year, regulatory or vehicle class, and fuel type.
Fatality Costs dollars Cost from gdd!tional fatalitie_s_resulting from reduction in vehi_cle curb weight, accumulated across all vehicles
(k) over their lifetime for a specific model year, regulatory or vehicle class, and fuel type.
CO Damage dollars Owner and societal costs arising from Carbon Monoxide damage, aggregated over the lifetime of all vehicles for a
Costs (k) specific model year, regulatory or vehicle class, and fuel type.
VOC Damage dollars Owner and societal costs arising from Volatile Organic Compounds damage, aggregated over the lifetime of all
Costs (k) vehicles for a specific model year, regulatory or vehicle class, and fuel type.
NOx Damage dollars Owner and societal costs arising from Nitrogen Oxides damage, aggregated over the lifetime of all vehicles for a
Costs (k) specific model year, regulatory or vehicle class, and fuel type.
SO2 Damage dollars Owner and societal costs arising from Sulfur Dioxide damage, aggregated over the lifetime of all vehicles for a
Costs (k) specific model year, regulatory or vehicle class, and fuel type.
PM Damage dollars Owner and societal costs arising from Particulate Matter damage, aggregated over the lifetime of all vehicles for a
Costs (k) specific model year, regulatory or vehicle class, and fuel type.
CO2 Damage dollars Owner and societal costs arising from Carbon Dioxide damage, aggregated over the lifetime of all vehicles for a
Costs (k) specific model year, regulatory or vehicle class, and fuel type.
CH4 Damage dollars Owner and societal costs arising from Methane damage, aggregated over the lifetime of all vehicles for a specific
Costs (k) model year, regulatory or vehicle class, and fuel type.
N20 Damage dollars Owner and societal costs arising from Nitrous Oxide damage, aggregated over the lifetime of all vehicles for a
Costs (k) specific model year, regulatory or vehicle class, and fuel type.
Total dollars Total consumer costs accumulated by the industry for a specific model year, regulatory or vehicle class, and fuel
Consumer ] . - .
Costs (k) type. The consumer costs are the sum of: retail fuel costs, drive surplus, and refueling surplus.
Total social costs accumulated by the industry for a specific model year, regulatory or vehicle class, and fuel type.
Total Social dollars The social costs are the sum of: pre-tax fuel costs, drive surplus, refueling surplus, market externalities,
Costs (k) congestion costs, accident costs, noise costs, fatality costs, and emissions damage costs (CO, VOC, NOx, SO2,

PM, CO2, CH4, and N20).
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B.4

Annual Societal Effects Report and Annual Societal Costs Report

The Annual Societal Effects Report and the Annual Societal Costs Report contain similar results
as the Societal Effects Report and the Societal Costs Report, except these outputs further
disaggregate the results by calendar year. Table 36 lists the full contents of the Annual Societal
Effects Report and Table 37 lists the full contents of the Annual Societal Costs Report. The
annual reports produce results as absolutes for the baseline and action alternatives.

Table 36. Annual Societal Effects Report

Column Units Contents
Scenario integer Unlque'lndex of the scenario, where 0 represents the baseline, while 1 and above represent the action
alternatives.
Scenario Name text A short name describing the key features of the scenario.
Model Year model year Model years aqalyzed durlng.the study'perl.od. When "Fleet Analysis" option is enabled during modeling, the
range of years is extended to include historic and future model years.
Age integer The vehicle's vintage, ranging from 0 to 39, where 0 corresponds to a vehicle's first year on the road.
Calendar Year ;agiierndar Calendar years analyzed for the effects calculations.
The vehicle class for which the societal costs are reported. When multiple vehicle classes are present in the
Veh-Class text output, a value of "TOTAL" is used to represent the sums (or averages) across all vehicle classes for some of
the outputs, where applicable.
The fuel type for which the societal costs are reported. A value of "TOTAL" is used to represent the sums (or
Fuel Type text .
averages) across all fuel types for some of the outputs, where applicable.
Fleet units Total on-road fleet for a specific model year, vehicle age, vehicle class, and fuel type.
KVMT miles (K) ;I;/t;)zusands of miles traveled by all vehicles for a specific model year, vehicle age, vehicle class, and fuel
Quads quads Energy used by all vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
Amount of gallons of liquid fuel consumed, or amount of gasoline equivalent gallons of fuel consumed (for
kGallons gallons (k) L . it . ]
non-liquid fuel types), by all vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
Amount of energy consumed by all vehicles for a specific model year, vehicle age, vehicle class, and fuel
KUnits varies type, where the units of measure vary based on fuel type. For liquid fuel types (gasoline, e85, diesel, b20,
LNG, LPG), the units are specified in thousands of gallons; for electricity, the units are specified in mW-h;
for hydrogen and CNG, the units are specified in Mcf.
. . Amount of fatalities resulting from reduction in vehicle curb weight and increases in VMT due to the rebound
Fatalities units ! e . -
effect, aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
. Amount of Carbon Monoxide emissions generated from domestic crude petroleum extraction, transportation,
metric- L - - VT - o
CO Upstream (t) tons and refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific
model year, vehicle age, vehicle class, and fuel type.
. Amount of Volatile Organic Compounds emissions generated from domestic crude petroleum extraction,
VOC Upstream metric- . e - - PR .
® tons transporta_tl_on, and refining, fljom gasollne_transportatlon, storage, and distribution, aggregated for all vehicles
for a specific model year, vehicle age, vehicle class, and fuel type.
. Amount of Nitrogen Oxides emissions generated from domestic crude petroleum extraction, transportation,
NOx Upstream metric- . - . T ] L
) tons and refining, fro_m gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific
model year, vehicle age, vehicle class, and fuel type.
. Amount of Sulfur Dioxide emissions generated from domestic crude petroleum extraction, transportation, and
metric- . - . A b .
SO2 Upstream (t) tons refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific
model year, vehicle age, vehicle class, and fuel type.
. Amount of Particulate Matter (diameter of ~2.5 micrometers) emissions generated from domestic crude
metric- - - . - - R
PM Upstream (t) tons petroleum extraction, transportation, and refining, from gasoline transportation, storage, and distribution,
aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
CO2 Upstream million Amount of Carbon Dioxide emissions generated from domestic crude petroleum extraction, transportation,
(mmt) P metric- and refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific
tons model year, vehicle age, vehicle class, and fuel type.
CH4 Upstream metric- Amount of Methane emissions generated from domestic crude petroleum extraction, transportation, and
® P tons refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific
model year, vehicle age, vehicle class, and fuel type.
N20 Upstream metric- Amount of Nitrous Oxide emissions generated from domestic crude petroleum extraction, transportation, and
) P tons refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific
model year, vehicle age, vehicle class, and fuel type.
Acetaldehvde metric- Amount of Acetaldehyde emissions generated from domestic crude petroleum extraction, transportation, and
Y refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific
Upstream (t) tons . )
model year, vehicle age, vehicle class, and fuel type.
Acrolein metric- Amount of Acrolein emissions generated from domestic crude petroleum extraction, transportation, and
Upstream (t) tons refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific
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model year, vehicle age, vehicle class, and fuel type.

Amount of Benzene emissions generated from domestic crude petroleum extraction, transportation, and

Benzene metric- refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific
Upstream (t) tons . )
model year, vehicle age, vehicle class, and fuel type.
- - Amount of 1,3-Butadiene emissions generated from domestic crude petroleum extraction, transportation, and
Butadiene metric- .. - - o ] e
refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific
Upstream (t) tons . )
model year, vehicle age, vehicle class, and fuel type.
- Amount of Formaldehyde emissions generated from domestic crude petroleum extraction, transportation, and
Formaldehyde metric- . - - A - e
refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific
Upstream (t) tons . )
model year, vehicle age, vehicle class, and fuel type.
. Amount of Diesel Particulate Matter (diameter of ~10 micrometers) emissions generated from domestic crude
DPM10 metric- - - . - ; R
petroleum extraction, transportation, and refining, from gasoline transportation, storage, and distribution,
Upstream (t) tons h o d >
aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
. Amount of Methyl Tertiary Butyl Ether emissions generated from domestic crude petroleum extraction,
MTBE Upstream | metric- . _ . . S .
® tons transporta_tl_on, and refining, fljom gasollne_transportatlon, storage, and distribution, aggregated for all vehicles
for a specific model year, vehicle age, vehicle class, and fuel type.
_— metric- Amount of Carbon Monoxide emissions generated from vehicle operation, aggregated for all vehicles for a
CO Tailpipe (t) e - -
tons specific model year, vehicle age, vehicle class, and fuel type.
- metric- Amount of Volatile Organic Compounds emissions generated from vehicle operation, aggregated for all
VOC Tailpipe (t) - e - .
tons vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
NOX Tailpipe (t) metric- Amount of Nitrogen Oxides emissions generated from vehicle operation, aggregated for all vehicles for a
pip tons specific model year, vehicle age, vehicle class, and fuel type.
_— metric- Amount of Sulfur Dioxide emissions generated from vehicle operation, aggregated for all vehicles for a
SO2 Tailpipe (t) e - .
tons specific model year, vehicle age, vehicle class, and fuel type.
_— metric- Amount of Particulate Matter (diameter of ~2.5 micrometers) emissions generated from vehicle operation,
PM Tailpipe (t) f i . ;
tons aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
CO2 Tailpipe m:eltlrlf)cn Amount of Carbon Dioxide emissions generated from vehicle operation, aggregated for all vehicles for a
(mmt) tons specific model year, vehicle age, vehicle class, and fuel type.
. metric- Amount of Methane emissions generated from vehicle operation, aggregated for all vehicles for a specific
CH4 Tailpipe (t) . -
tons model year, vehicle age, vehicle class, and fuel type.
N20 Tailpipe (t) metric- Amount of Nitrous Oxide emissions generated from vehicle operation, aggregated for all vehicles for a
Pip tons specific model year, vehicle age, vehicle class, and fuel type.
Acetaldehyde metric- Amount of Acetaldehyde emissions generated from vehicle operation, aggregated for all vehicles for a
Tailpipe (t) tons specific model year, vehicle age, vehicle class, and fuel type.
Acrolein Tailpipe | metric- Amount of Acrolein emissions generated from vehicle operation, aggregated for all vehicles for a specific
(t) tons model year, vehicle age, vehicle class, and fuel type.
Benzene Tailpipe | metric- Amount of Benzene emissions generated from vehicle operation, aggregated for all vehicles for a specific
(t) tons model year, vehicle age, vehicle class, and fuel type.
Butadiene metric- Amount of 1,3-Butadiene emissions generated from vehicle operation, aggregated for all vehicles for a
Tailpipe (t) tons specific model year, vehicle age, vehicle class, and fuel type.
Formaldehyde metric- Amount of Formaldehyde emissions generated from vehicle operation, aggregated for all vehicles for a
Tailpipe (t) tons specific model year, vehicle age, vehicle class, and fuel type.
DPM10 Tailpipe metric- Amount of Diesel Particulate Matter (diameter of ~10 micrometers) emissions generated from vehicle
(t) tons operation, aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
MTBE Tailpipe metric- Amount of Methyl Tertiary Butyl Ether emissions generated from vehicle operation, aggregated for all
(t) tons vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
metric- Amount of Carbon Monoxide emissions generated from domestic crude petroleum extraction, transportation,
CO Total (t) tons and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated
for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
metric- Amount of Volatile Organic Compounds emissions generated from domestic crude petroleum extraction,
VOC Total (t) tons transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle
operation, aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
metric- Amount of Nitrogen Oxides emissions generated from domestic crude petroleum extraction, transportation,
NOXx Total (t) tons and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated
for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
metric- Amount of Sulfur Dioxide emissions generated from domestic crude petroleum extraction, transportation, and
SO2 Total (t) tons refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated for all
vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
Amount of Particulate Matter (diameter of ~2.5 micrometers) emissions generated from domestic crude
metric- petroleum extraction, transportation, and refining, from gasoline transportation, storage, and distribution, and
PM Total (t) - - - i . .
tons from vehicle operation, aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and
fuel type.
million Amount of Carbon Dioxide emissions generated from domestic crude petroleum extraction, transportation,
CO2 Total (mmt) | metric- and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated
tons for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
metric- Amount of Methane emissions generated from domestic crude petroleum extraction, transportation, and
CH4 Total (t) . f . PR . -
tons refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated for all
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vehicles for a specific model year, vehicle age, vehicle class, and fuel type.

Amount of Nitrous Oxide emissions generated from domestic crude petroleum extraction, transportation, and

N20 Total (t) gﬁ;rlc- refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated for all
vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
. Amount of Acetaldehyde emissions generated from domestic crude petroleum extraction, transportation, and
Acetaldehyde metric- - - - L . .
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated for all
Total (t) tons - e ; .
vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
. Amount of Acrolein emissions generated from domestic crude petroleum extraction, transportation, and
. metric- - - - PR : -
Acrolein Total (t) tons refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated for all
vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
. Amount of Benzene emissions generated from domestic crude petroleum extraction, transportation, and
metric- . - - N : .
Benzene Total (t) tons refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated for all
vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
. - Amount of 1,3-Butadiene emissions generated from domestic crude petroleum extraction, transportation, and
Butadiene Total metric- L - . S - -
® tons refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated for all
vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
. Amount of Formaldehyde emissions generated from domestic crude petroleum extraction, transportation, and
Formaldehyde metric- L . - S . ;
Total (1) tons refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated for all
vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
Amount of Diesel Particulate Matter (diameter of ~10 micrometers) emissions generated from domestic crude
DPM10 Total (t) metric- petroleum extraction, transportation, and refining, from gasoline transportation, storage, and distribution, and
tons from vehicle operation, aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and
fuel type.
metric- Amount of Methyl Tertiary Butyl Ether emissions generated from domestic crude petroleum extraction,
MTBE Total (t) tons transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle

operation, aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
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Table 37. Annual Societal Costs Report

Column Units Contents
Scenario integer Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action alternatives.
Scenario Name | text A short name describing the key features of the scenario.
Model Year model Model years an_alyzed during_the study_ peri_od. When "Fleet Analysis" option is enabled during modeling, the
year range of years is extended to include historic and future model years.
Age integer The vehicle's vintage, ranging from 0 to 39, where 0 corresponds to a vehicle's first year on the road.
Calendar Year ;ZLerndar Calendar years analyzed for the effects calculations.
The vehicle class for which the societal costs are reported. When multiple vehicle classes are present in the
Veh-Class text output, a value of "TOTAL" is used to represent the sums (or averages) across all vehicle classes for some of the
outputs, where applicable.
Fuel Type text The fuel type for which the societal costs are reported. A value of_"TOTAL" is used to represent the sums (or
averages) across all fuel types for some of the outputs, where applicable.
Disc-Rate number Social discount rate applied to future benefits. A value of 0 indicates undiscounted costs.
Pre-Tax Fuel dollars Total pre-tax fuel expenditures accumulated across all vehicles for a specific model year, vehicle age, vehicle
Cost (k) class, and fuel type.
dollars Total fuel tax revenues accumulated across all vehicles for a specific model year, vehicle age, vehicle class, and
Fuel Tax Cost
(k) fuel type.
Retail Fuel dollars Total retail fuel expenditures (pre-tax fuel cost + fuel tax cost) accumulated across all vehicles for a specific
Costs (k) model year, vehicle age, vehicle class, and fuel type.
. dollars Benefits from the additional driving that results from improved fuel economy, accumulated across all vehicles for
Drive Surplus . - -
(k) a specific model year, vehicle age, vehicle class, and fuel type.
R dollars Benefits from reduced refueling frequency due to the extended vehicle range and improved fuel economy,
efuel Surplus - - - :
(k) accumulated across all vehicles for a specific model year, vehicle age, vehicle class, and fuel type.
Market dollars Economic costs of oil imports not accounted for by price, accumulated across all vehicles for a specific model
Externalities (k) year, vehicle age, vehicle class, and fuel type.
Congestion dollars Congestion costs from additional vehicle use, accumulated across all vehicles for a specific model year, vehicle
Costs (k) age, vehicle class, and fuel type.
. dollars Accident costs from additional vehicle use, accumulated across all vehicles for a specific model year, vehicle age,
Accident Costs ]
(k) vehicle class, and fuel type.
Noise Costs dollars Noi_se costs from additional vehicle use, accumulated across all vehicles for a specific model year, vehicle age,
(k) vehicle class, and fuel type.
Fatality Costs dollars Cost ffo_m additional fatali_ties resulting_ from reduction in vehicle curb weight, accumulated across all vehicles for
(k) a specific model year, vehicle age, vehicle class, and fuel type.
CO Damage dollars Owner and societal costs arising from Carbon Monoxide damage, aggregated for all vehicles for a specific model
Costs (k) year, vehicle age, vehicle class, and fuel type.
VOC Damage dollars Owner and societal costs arising from Volatile Organic Compounds damage, aggregated for all vehicles for a
Costs (k) specific model year, vehicle age, vehicle class, and fuel type.
NOx Damage dollars Owner and societal costs arising from Nitrogen Oxides damage, aggregated for all vehicles for a specific model
Costs (k) year, vehicle age, vehicle class, and fuel type.
SO2 Damage dollars Owner and societal costs arising from Sulfur Dioxide damage, aggregated for all vehicles for a specific model
Costs (k) year, vehicle age, vehicle class, and fuel type.
PM Damage dollars Owner and societal costs arising from Particulate Matter damage, aggregated for all vehicles for a specific model
Costs (k) year, vehicle age, vehicle class, and fuel type.
CO2 Damage dollars Owner and societal costs arising from Carbon Dioxide damage, aggregated for all vehicles for a specific model
Costs (k) year, vehicle age, vehicle class, and fuel type.
CH4 Damage dollars Owner and societal costs arising from Methane damage, aggregated for all vehicles for a specific model year,
Costs (k) vehicle age, vehicle class, and fuel type.
N20 Damage dollars Owner and societal costs arising from Nitrous Oxide damage, aggregated for all vehicles for a specific model
Costs (k) year, vehicle age, vehicle class, and fuel type.
Total dollars Total consumer costs accumulated by the industry for a specific model year, vehicle age, vehicle class, and fuel
Consumer ] . - .
Costs (k) type. The consumer costs are the sum of: retail fuel costs, drive surplus, and refueling surplus.
Total social costs accumulated by the industry for a specific model year, vehicle age, vehicle class, and fuel type.
Total Social dollars The social costs are the sum of: pre-tax fuel costs, drive surplus, refueling surplus, market externalities,
Costs (k) congestion costs, accident costs, noise costs, fatality costs, and emissions damage costs (CO, VOC, NOx, SO2,

PM, CO2, CH4, and N20).
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B.5 Vehicles Report

The Vehicles Report contains disaggregate vehicle-level summary of compliance model results,
providing a detailed view of the final state of each vehicle examined by the model, for each
model year and scenario analyzed. The report includes basic vehicle characteristics (such as
vehicle code, manufacturer, engine and transmission used, curb weight, footprint, and sales
volumes), fuel economy information (before and after the analysis), final technology utilization,
and cost metrics associated with application of additional technology.

The vehicle’s fuel economy ratings prior to the start of the analysis as well as at the end of each
compliance model year are presented. The fuel economy values are specified per fuel type
(wherever applicable) in addition to an overall value, which used for compliance purposes. For
multi-fuel vehicles, the multiple fuel economy ratings are combined according to the statutory
requirements. For flex-fuel vehicles (those that operate on gasoline and ethanol-85), only the
gasoline fuel economy rating is considered for compliance. For plug-in hybrid/electric vehicles
(PHEVs operating on gasoline and electricity), the overall fuel economy rating is harmonically
averaged based on the share of each fuel type. The vehicle’s fuel share indicates the amount of
miles driven by the vehicle on each fuel type. For vehicles operating on a single fuel (e.g.,
gasoline, diesel, or electricity), the fuel share for that fuel type only is specified. For vehicles
operating on multiple fuels (FFVs and PHEVs), the fuel shares are specified for gasoline and
ethanol-85 or for gasoline and electricity.

The Vehicles Report provides initial and final sales volumes as well as initial and final MSRPs.
The initial sales and MSRP represent the starting values as obtained from the input file, and do
not reflect changes associated with the modeling analysis. The final sales volumes are specified
by model year and will typically match the initial values, unless modeling options for sales
mixing are selected. The final MSRPs are specified by model year as well, and incorporate
additional costs arising from technology application or fine payment.

Table 38 below list the full contents of the Vehicles Report.

Table 38. Vehicles Report

Column Units Contents
Scenario integer Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action alternatives.
anerg:rlo text A short name describing the key features of the scenario.
model - .
Model Year year Model years analyzed during the study period.
Manufacturer text Manufacturers analyzed during the study period.
Veh Index integer Unigue index assigned to each vehicle by the modeling system during runtime.
Veh Code integer Index of the vehicle (unigue per manufacturer), as read from the input file.
Brand text Vehicle brand.
Model text Vehicle model.
Name Plate text Vehicle nameplate.
Platform text Name of the platform used by a vehicle.
Revision of the platform used by a vehicle. This field lists the platform version as "baseline", if the vehicle is
PIt Version text using an original and unmodified platform. Alternatively, this field shows the model year, signifying the revision
of the intial platform that the vehicle has inherited.
Vehicle's powertrain type in a specific model year. Available options are: Conventional, MHEV for mild
Powertrain text hybridizatiqn (inclu_ding 1_2 volt micro-hybrid qnd belt.- or crar)k-moynted integrated starter/gen_erator_), SHEV for
strong hybrid/electric vehicle, PHEV for plug-in hybrid/electric vehicle, BEV for battery electric vehicle, and
FCV for fuel cell vehicle.
Veh Power HP Initial power rating of a vehicle.
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Initial

Veh Power HP Final power rating of a vehicle.
Eng Code integer Index of the engine used by a vehicle.
Eng Fuel text Fuel used by the starting engine, before any modifications were made by the modeling system. Available options
Initial are: G for gasoline, D for diesel, and CNG for compressed natural gas.
Eng Type text Brief information about the starting engine, before any modifications were made by the modeling system. The
Initial field includes: engine horsepower, displacement, configuration, number of cylinders, and aspiration.
Revision of the engine used by a vehicle. This field lists the engine version as "baseline", if the vehicle is using
Eng Version text an original and unmodified engine. Alternatively, this field shows the model year, signifying the revision of the
intial engine that the vehicle has inherited.
Eng Fuel text Fuel used by the engine in a specific model year.
Eng Type text Brief information about the engine in a specific model year. At present, only the aspiration of the engine is
shown, since other attributes are assumed to remain unchanged.
Trn Code integer Index of the transmission used by a vehicle.
Trn Type Bri_ef i_nfor_mation about the_sta_trting transmission, b_efore any modifications were made by_ the modeliqg system.
Initial text This field includes: transmission type (A=automatic, M=manual,' C_\/T=cont|nuously vanable_transmssmn,
AMT=automated manual transmission, DCT=dual-clutch transmission) and number of gears (if applicable).
Revision of the transmission used by a vehicle. This field lists the transmission version as "baseline", if the
Trn Version text vehicle is using an original and unmodified transmission. Alternatively, this field shows the model year,
signifying the revision of the intial transmission that the vehicle has inherited.
Brief information about the transmission in a specific model year. This field includes: transmission type
Trn Type text (A=automatic, M=manual, CVVT=continuously variable transmission, S=sequential transmission (AMT or DCT),
HEV=unique transmission on a hybrid/electric vehicle) and number of gears (if applicable).
FE Primary Vehicle's initial fuel economy rating when operating on its primary fuel type. This represents the starting value
Initial MPY as read from the input file.
FE Secondary Vehicle's initial fuel economy rating when operating on its secondary fuel type (if applicable). This represents
Initial mpg the starting value as read from the input file.
Vehicle's overall initial fuel economy rating, before any modifications were made by the modeling system. For
FE Initial mpg FFVs (gasoline/E85) and PHEVs (gasoline/electricity_), the overall fugl economy rating_may_be harmonic_ally_
averaged based on the share of each fuel type, according to the "Multi-Fuel" setting defined in the scenarios input
file.
Fuel Initial text All fuel types initially used by the vehicle, before any modifications were made by the modeling system.
FS Initial ratio Vehicle's initial fuel share, indicating the amount of miles driven by the vehicle on each fuel type. Only the fuel
types on which the vehicle operates are reported. This represents the starting value as read from the input file.
FE Primary Vehicle's fuel economy rating when _operating on its primary f_uel type, ina specific model year, taking iqto
Rated mpg acct_)unt the effect pf tgchnolo_g_y a_ddmons made by thg modeling system. This value does not include adjustment
for improvements in air conditioning or off-cycle credits.
FE Secondary Vehiclt_a's fuel economy rating when operating o_n'its secondary fuel type (if applicable), i'n a specific mode;l year,
Rated mpg tak_lng into accc_)unt the effect c_)f te_chnolo_g_y agdmons made by the_ modeling system. This value does not include
adjustment for improvements in air conditioning or off-cycle credits.
Vehicle's overall fuel economy rating in a specific model year, taking into account the effect of technology
additions made by the modeling system. For FFVs (gasoline/E85) and PHEVS (gasoline/electricity), the overall
FE Rated mpg fuel economy rating may be harmonically averaged based on the share of each fuel type, according to the "Multi-
Fuel” setting defined in the scenarios input file. This value does not include adjustment for improvements in air
conditioning or off-cycle credits.
FE Primary Vehicle's fuel economy rating when operating on its primary fuel type, in a specific model year, taking into
c - mpg account the effect of technology additions made by the modeling system, adjusted for improvements in air
ompliance s !
conditioning and off-cycle credits.
FE Secondary Vehicle's fuel economy rating when operating on its secondary fuel type (if applicable), in a specific model year,
c . mpg taking into account the effect of technology additions made by the modeling system, adjusted for improvements
ompliance P L .
in air conditioning and off-cycle credits.
Vehicle's overall fuel economy rating in a specific model year, taking into account the effect of technology
FE additions made by the modeling system, adjusted for improvements in air conditioning and off-cycle credits. For
Compliance mpg FFVs (g_asoline/E85 and diesel/B20) and PHEVs (gasoline/electrici_ty), the overall f_uel economy ratin_g may be
harmonically averaged based on the share of each fuel type, according to the "Multi-Fuel" setting defined in the
scenarios input file. This value is used for compliance purposes.
Fuel text All fuel types used by the vehicle in a specific model year.
. Vehicle's fuel share, indicating the amount of miles driven by the vehicle on each fuel type in a specific model
Fuel Share ratio - .
year. Only the fuel types on which the vehicle operates are reported.
Vehicle's general classification (passenger vehicle: LDV; light duty truck: LDT1, LDT2a, LDT2b, LDT3;
Veh Class text medium duty truck: MDT4, MDT5, MDT®6; heavy duty truck: HDT7, HDT8). Only the passenger vehicle and
light duty truck classifications are supported by the modeling system.
Reg Class text Vehicle's regulatory class (PassengerCar, LightTruck, or LightTruck2b3).
Tech Class text Vehicle's technology class (used for technology selection and application).
Safety Class text Vehicle'_s safety class (PC=Passenger Car, CM=CUV/Minivan, LT=Light Truck/SUV; used for safety
calculations).
Redesign State | text Vehicle's redesign state, whether the vehicle is being redesigned in the current model year.
Refresh State text Vehicle's refresh state, whether the vehicle is being refreshed in the current model year.
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Platform

A flag indicating whether a vehicle serves as the leader of the engine (E), transmission (T), and/or platform (P)
that it uses. During modeling, engine, transmission, and platform technologies are first applied to a leader

Leader text vehicle during the leaders redesign or refresh, and subsequently inherited on all other vehicles during their
redesign/refresh years.
Sales Initial units ;illeehicle's production volumes in a specific model year. This represents the starting value as read from the input
Vehicle's final production volumes in a specific model year. If modeling options for sales mixing are used (such
Sales units as the Dynamic Fleet Share Model), this value will differ from the initial production volumes; otherwise, this
value will be the same the initial one.
MSRP Initial dollars ;illeehicle's initial MSRP value in a specific model year. This represents the starting value as read from the input
Vehicle's final MSRP value in a specific model year, including additional costs arising from technology
MSRP dollars o -
application or fine payment.
k.Labor Hours f(wlg)urs Thousands of employment hours associated with the production of the vehicle models in a specific model year.
CW Initial Ibs. Vehicle's initial curb weight. This represents the starting value as read from the input file.
cw Ibs Vehicle's final curb weight in a specific model year, taking into account any mass reduction technology applied
) by the modeling system.
TW Initial Ibs. Vehicle's initial test weight, before any modifications were made by the modeling system.
™w Ibs Vehicle's final test weight in a specific model year, taking into account any mass reduction technology applied by
) the modeling system.
GVWR Initial | Ibs. Vehicle's initial GVWR, before any modifications were made by the modeling system.
GVWR Ibs Vehicle's final GVWR in a specific model year, taking into account any mass reduction technology applied by the
' modeling system.
GCWR Initial | Ibs. Vehicle's initial GCWR, before any modifications were made by the modeling system.
GCWR Ibs Vehicl_e's final GCWR in a specific model year, taking into account any mass reduction technology applied by the
' modeling system.
. Vehicle's initial footprint. This represents the starting value as read from the input file. The vehicle's footprint
Footprint sq.ft. ! '
does not change during the analysis.
Vehicle's work factor in a specific model year. This value is reported only for vehicles that are subject to the
Work Factor Ibs. -
work-factor based functional standard.
FE Target g:lrl?r?isl’e Vehicle's fuel economy target in a specific model year.
grams _— . .
CO2 Target per mile Vehicle's CO-2 target in a specific model year.
. grams I - .
CO2 Rating per mile Vehicle's CO-2 rating in a specific model year.
ZEV Credits s6vs Amount of ZEV credits gengrated by a vehicle due to its full or partial operation on fgel types t_hat do not
generate downstream emissions. At present, PHEV’s, EV’s, and FCVs are ZEV credit generating vehicles.
Tech Cost dollars Unit costs accumulated by the vehicle model from technology application in a specific model year.
. Increase in vehicle price accumulated by the vehicle model from technology application and fine payment in a
Price Increase | dollars o
specific model year.
Amount of Federal tax credits a buyer receives for purchasing this vehicle. Tax credits are specified for strong
Tax Credit dollars hybrid, plug-in hybrid, and electric vehicles, only when the applicable "Tax Credit" settings are defined in the
scenarios input file.
Consumer d Loss in value to the consumer due to decreased range of pure electric vehicles. This value does not apply if the
. ollars C
Valuation vehicle is not an EV.
Rel. Value d Relative loss in value to the consumer due to due to decreased operating life of pure electric vehicles. This value
ollars - S
Loss does not apply if the vehicle is not an EV.
Maint Cost dollars Unit maintenance costs accumulated by the vehicle model from technology application in a specific model year.
Repair Cost dollars Unit repair costs accumulated by the vehicle model from technology application in a specific model year.
Taxes/Fees dollars Taxes & fees paid by the consumers for purchasing a new vehicle model in a specific model year.
Financing dollars Financing costs paid by the consumers for purchasing a new vehicle model in a specific model year.
Insurance dollars Insurance costs paid by the consumers for purchasing a new vehicle model in a specific model year.
The utilization of technologies on a vehicle model in a specific model year. The following define the utilization
codes used by the modeling system:
U = technology was initially in use on a base vehicle before modeling began
A = technology was applied to a vehicle by the modeling system
| = technology was applied to a leader of a vehicle's engine, transmission, or platform by the modeling system,
Technology and later inherited on a_current follower vehicle )
(multiple text us= technc_»logy was in use on a base vehicle, but was later superseded when another technology was applied
columns) by the modeling system

AS = technology was applied to a vehicle by the modeling system, but was later superseded when another
technology was applied

IS = technology was inherited on a vehicle by the modeling system, but was later superseded when another
technology was applied

P = technology has exceed its phase-in threshold in the current model year, and thus was not applied by the
modeling system
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X = technology is not available for application on a vehicle in the current model year
<blank> = technology is available for application on a vehicle in the current model year, but the modeling
system has not yet applied it
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Appendix C CAFE Model Software Manual

C.1 Warnings

This software was developed for analysis by U.S. Department of Transportation staff of potential
fuel economy requirements.

This software uses input files containing detailed information regarding vehicles manufactured
for sale in the United States and creates output files containing similarly detailed information
regarding such vehicles. If input files containing information in any way (e.g., based on
entitlement under 5 U.S.C 552 to confidential treatment) protected from disclosure to the public
are used, some output files created by this software must also be protected from disclosure to the
public.

C.2 Notice

The CAFE Model software is a U.S. government work not subject to copyright pursuant to 17
USC 105; however, some of the third-party works used by the software are subject to usage
agreements, as described below.

The button controls in the application toolbar of the CAFE Model use images from the Glaze
Icon Set (version 0.4.6, released on 3/06/2006) obtained from http://www.notmart.org. All icons
and/or images within the Glaze Icon Set are distributed under the GNU Lesser General Public
License (LGPL), version 2.1. The version 2.1 of the GNU LGPL may be obtained from
http://www.gnu.org/licenses/old-licenses/Igpl-2.1.html.

If users of the CAFE model have any questions about this notice, please contact the current
administrators of the CAFE Model project.

C.3 Installation and System Requirements

The CAFE Model runs on IBM-compatible computers using the Microsoft® Windows operating
system. Although the software does not have strict hardware requirements, beyond what is
needed to run the operating system, a 1 GHz or faster Intel compatible processor, with at least 2
GB of physical memory (RAM) is strongly recommended. The software has been developed and
tested on computers using Windows XP/7 and Windows Server 2003/2008, but may operate
properly on machines using older versions of Windows (e.g., Windows 2000), or newer versions
(e.g., Windows 8), as long as a compatible Microsoft® .NET Framework is installed.

The CAFE Model software uses Microsoft® Excel to read input files needed for modeling. As
such, Excel must be installed on the system. The software also uses the Microsoft® .NET
Framework, version 3.5. If the Framework is not already present, it must be installed.
Instructions for downloading and installing the .NET framework are available on the Internet at
http://www.microsoft.com/download/en/details.aspx?id=22.
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Based on the characteristics of machines used in the development of this software, the following
table provides a summary of system requirements:

Table 39. CAFE Model System Requirements
Intel compatible processor (1 GHz or faster recommended)
1 GB RAM (2 GB recommended)

10 MB hard drive space for installation

(additional disk space will be required during runtime)
Microsoft® Windows XP/Vista/7/8/10

Microsoft® Windows Server 2003/2008/2012
Microsoft® .NET Framework 3.5

Microsoft® Excel 2010 or later

Once the system requirements have been met, the latest version of the CAFE Model may be
obtained by contacting NHTSA or Volpe Center staff.

The current version of the software is packaged as a stand-alone executable and does not require

installation. To operate the model, place the “CAFE Model.exe” file on the desktop and execute
it?,

C.4 CAFE Model Graphical User Interface

The CAFE Model Graphical User Interface (GUI) provides users with a set of tools necessary to
set up and run multiple modeling test scenarios, which are commonly referred to as CAFE Model
sessions. Each CAFE Model session can be configured independently, each with its own set of
model inputs and settings. Once configured, the session may be saved for future runs, or
executed immediately.?* When the model runs, the system displays the progress of the
compliance modeling process in each session’s window.

The model GUI consists of two primary screens: the main CAFE Model window and the
Modeling Settings window. The CAFE Model window is used for managing the modeling
sessions, while the Modeling Settings window is used to configure them.

To run the modeling system, click on the CAFE Model executable file located on the desktop.
When the application launches, a Warnings dialog box is displayed (Figure 9). The user must
read and understand the warnings listed prior to using the modeling system.

23 The CAFE Model files provided may be in a zip archive, which will need to be extracted using a zip utility such
as WinZip (www.winzip.com) or 7Zip (www.7-zip.org).

241t is recommended that users save the sessions prior to running them in order to assign a meaningful title to each
session.
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i) CAFE Model Warnings |
U.S. DEPARTMENT OF TRANSPORTATION

=EE WARNINGS ***

1. This software was developed for analysis by U.S. Department of Transportation staff
of potential fuel economy requirements.

2. This software uses input files containing detailed information regarding vehicles
manufactured for sale in the United States and creates output files containing similarly
detailed information regarding such vehicles. If input files containing information in any
way (e.g., based on entitlement under 5 U.5.C 552 to confidential treatment) protected
from disclosure to the public are used, some output files created by this software must
also be protected from disclosure to the public.

‘You must understand these warnings before using this software.

This warnings screen, along with additional legal notices and license information, may
be viewed again from the CAFE Model’s Help menu.

L oK || Caed |

Figure 9. Warnings Dialog Box

After clicking the OK button in the Warnings dialog box, the main CAFE Model window,
described below, opens.

C.4.1 CAFE Model Window
The main CAFE Model window (Figure 10) is used to create, configure, and manage CAFE

modeling sessions. The main window also controls the model operation, allowing users to start
and stop modeling simulation.
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) CAFE Model =]

File WView Help

Il P E

To begin using the model, please create a New Session,
or Open an existing one.

Ready 6/01/16 16:46:34
Figure 10. CAFE Model Window

When the model first starts up, most of the menu items and toolbar icons are disabled, until a
new session is created, or an existing one is opened.

The model GUI is operated using a simple, easy to use file-menu (Figure 11), with most
commonly used shortcuts also available on the model toolbar (Figure 12). For user convenience,
most of the menu entries may also be controlled using keyboard shortcuts.

£} CAFE Model
|Ei|e Wiew Help

2P R ®E

Figure 11. CAFE Model File Menu
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) CAFE Model

File Wiew Help

AP B

Figure 12. CAFE Model Toolbar

Some of the most commonly used file menus are:

File > New Session: Creates a new CAFE Model Session and displays the Modeling
Settings window to the user.

File > Open Session: Opens an existing CAFE Model Session.

File > Close Session: Closes the active CAFE Model Session.

File > Save Session: Saves the active CAFE Model Session.

File > Start Modeling: Begins the modeling process for the active CAFE Model Session.

File > Stop Modeling: Suspends the modeling process of the active CAFE Model
Session.

File > Exit: Exits the CAFE Model. If any of the modeling sessions are still opened,
they will be closed prior to exiting the model.

View > Modeling Settings: Displays the Modeling Settings window, where all modeling
options and settings may be configured.

View > Output Location: Opens the Windows Explorer and browses to the location
where the output files and reports of the active session are saved.

C.4.2 Modeling Settings Window

The Modeling Settings window contains multiple panels for configuring all of the runtime
options available to the model. The user can operate this window to set up a new session, or
modifying an existing one, before starting the modeling process. Each of the available
configuration panels is outlined in the sections below.

C.4.2.1 General Compliance Settings Panel

The General Compliance Settings panel (Figure 13) is used to specify what type of modeling
the user would like to run. Each model is tailored to different type of analysis, using its own set
of assumptions and configuration settings. Presently, two model types are available:

Standard Compliance Model: The Standard Compliance Model is the default mode of
operation for the CAFE modeling system. This model type is used to evaluate
technology costs and benefits in response to the required CAFE standards defined in the
modeling scenarios.
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e Monte-Carlo Model:

The Monte-Carlo Model is a specialized CAFE modeling type,

which is used for running customized Monte-Carlo simulations necessary for uncertainty

analysis.

2} Modeling Settings

(General Compliance Settings
Input Settings

Output Settings

Rurtime Settings

General Compliance Settings
What type of model would you like to un?

i) Standard Compliance Madel v.1.0)
Funs a regular compliance model that estimates technology costs and benefits under
scenarios with predefined flat or reformed CAFE standards.

Optionally, please specify additional notes and.or keywords descrbing the type of run:

=]|

Motes:

Keywords: I

Save Close

C.4.2.2 Input Settings Panel

Figure 13. General Compliance Settings Panel

On the Input Settings panel (Figure 14), the user can select the input data files for use with the

modeling system.
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{2} Modeling Settings |

General Compliance Settings _

|ﬂpllt SE“I"QS

Output Settings Please specify the input files you would like to use with the model:

Runtime Settings Market-Data file:
|C:"-.C;’-‘-.FE"-J:Iemu:u-rl.ln"u'npl_rt"-market-data e " Browse |
Technologies file:
|C:"-.C;’-‘-.FE"-J:Iemu:u-run"-anLrt"-iechnnlngies = " Browse |
Farameters fila:
|C:"-.C;’-‘-.FE"-J:Iemu:umn"-inpd"-pammeters = " Browse |
Scenarios file:
|C:"-.C;’-‘-.FE"-J:Iemu:u-rl.ln"u'npl.ﬁ"ﬁu:enariu:us e " Browse |
L] Reload all selected files from disk.

Save Cloze

Figure 14. Input Settings Panel (1)

When selecting input files, the model will attempt to verify if an appropriate file was used. If

incorrect file path is entered, an error message will be displayed (Figure 15).
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{2} Modeling Settings

General Compliance Settings
Qutput Settings
Furtime Settings

Input Settings

Please specify the input files you would like to use with the model:
Market-Data file:

|C:"-.C.1‘-.F E*demo-run*input*technologies xdsx " Browse
Technologies file:
|C:"-.C;’-‘-.FE"-J:Iemu:u-run"-anLrt"-iechnnlngies = " Browse |
Farameters fila:
|C:"-.C;’-‘-.FE"-J:Iemu:umn"-inpd"-pammeters = " Browse |
Scenarios file:
|C:"-.C;’-‘-.FE"-J:Iemu:u-rl.ln"u'npl.ﬁ"ﬁu:enariu:us e " Browse |
L] Reload all selected files from disk.

The selected Market-Data file could not be opened.

Save Cloze

Figure 15. Input Settings Panel (2)

C.4.2.3 Output Settings Panel

The Output Settings panel (Figure 16) is used to configure the location where modeling results

will be saved.
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{2} Modeling Settings

General Compliance Settings )

Input Settings Output Settings

Output Settings Please specify where you would like to save the model outputs:

Rurtime Settings |C:"-.C:’-‘-.FE"-J:Iem|:|-n_|n " ——
Save Close

Figure 16. Output Settings Panel

The modeling system automatically generates the following seven output files (in CSV format)
during runtime:

Technology Utilization Report:  Provides manufacturer-level and industry-wide
technology application and penetration rates for each technology, model year, and
scenario analyzed. The results are disaggregated by regulatory class, as well as combined
over the entire fleet.

Compliance Report:  Provides manufacturer-level and industry-wide summary of
compliance model results for each model year and scenario analyzed. The results are
disaggregated by regulatory class, as well as combined over the entire fleet.

Societal Effects Report: Provides industry-wide summary of energy and emissions
effects for each model year and scenario analyzed. The model produces two versions of
this output file, where the results are disaggregated by either the vehicle class and fuel
type or the regulatory class and fuel type, as well as combined across all fuels and over
the entire fleet.

Societal Costs Report: Provides industry-wide summary of consumer and social costs for
each model year and scenario analyzed. The model produces two versions of this output
file, where the results are disaggregated by either the vehicle class and fuel type or the
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regulatory class and fuel type, as well as combined across all fuels and over the entire
fleet.

Annual Societal Effects Report: This output file is similar to the Societal Effects Report,
except it further disaggregates the results by calendar year.

Annual Societal Costs Report: This output file is similar to the Societal Costs Report,
except it further disaggregates the results by calendar year.

Vehicles Report: Provides a detailed view of the final state of each vehicle examined by
the model, for each model year and scenario analyzed.

C.4.2.4 Runtime Settings Panel

The Runtime Settings panel (Figure 17) provides additional modeling options to further
customize the model behavior, beyond what is available in the input files:

Fuel Price Estimates: Specifies whether to use the low, average, or high fuel price
estimates from the parameters input file. By default, average fuel price estimates are
used.

CO2 Price Estimates: Specifies whether to use low, average, high, or very-high carbon
dioxide cost estimates from the parameters input file. By default, average CO2 price
estimates are used.

Allow Credit Trading: Specifies whether the model should allow manufacturers to
transfer credits between passenger car and light truck fleets and to carry-forward credits
forward from previous model years into the analysis year.

Perform Fleet Analysis Calculations: Specifies whether the model should perform fleet
analysis calculations, evaluating modeling effects for historic and forecast model years
(before the first compliance model year as well as after the last compliance model year).

Scale Consumer Benefits: Specifies whether the model should scale the private
consumer benefits by a specific percentage during the effects calculations. Valid values
are between 0 and 100.
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{2} Modeling Settings |

General Compliance Settings . )
Input Settings Runtime Settings

Output Settings — Fuel Price: Estimates

Rurtime Settings () Low (=) Average (_! High

—CO2 Price Estimates
() Low (%) Average O High ' Very High

vl Allow Credit Trading
[| Perform Fleet Analysis Calculations

[] Scale Consumer Benefits (default is 100%):

Save Close

Figure 17. Runtime Settings Panel
C.5 CAFE Model Usage Examples

This section provides examples for configuring and running the CAFE Model sessions using
various model types.

C.5.1 Example 1 — Configuring for Standard Compliance Modeling
This example demonstrates the steps necessary for configuring the modeling system to perform a

regular Compliance Model run.

e Run the CAFE Model by clicking on the CAFE Model executable located on the
desktop. Read through the Warnings dialog box, and then click the OK button.

e Select File > New Session to create a new modeling session. The Modeling Settings
window appears. Note the errors at the bottom of the window; these indicate that the
input files have not been selected.

e On the General Compliance Settings panel, select the Standard Compliance Model as
shown in Figure 18 below.
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{2} Modeling Settings
General Compliance Settings - .
e srr— - General Compliance Settings

Input Settings
What type of model wauld you like to un?

Qutput Settings
Rurntime Settings {*) Standard Compliance Model {v.1.0)
Runs a regular compliance model that estimates technology costs and benefits under

scenarios with predefined flat or reformed CAFE standards.

Optionally, please specify additional notes and/or keywords describing the type of run:
Motes:

Keywords: I

Flease select a8 Scenanos file you would like to use with the model.
Flease select & Parameters file you would like to use with the

model.
Flease select @ Technologies file you would like to use with the _I
w

model.

Figure 18. Select Standard Compliance Model

Click on the Input Settings panel to select the input files to use for modeling (Figure 19).
Note that once all the input files have been selected appropriately, the error messages

disappear.

Save Close
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{2} Modeling Settings

General Compliance Settings

Input Settings

Output Settings Please specify the input files you would like to use with the model:

Rurtime Settings Market-Data file:
|C:"-.C;’-‘-.FE"-J:Iemu:u-rl.ln"u'npl_rt"-market-data = " Browse |
Technologies file:
|C:"-.C;’-‘-.FE"-J:Iemu:u-run"-anLrt"-iechnnlngies = " Browse |
Parameters file:
|C:"-.C;’-‘-.FE"-J:Iemu:umn"-inpd"-pammeters = " Browse |
Scenarios file:
|C:"-.C;’-‘-.FE"-J:Iemu:u-rl.ln"inpl.ﬁ"ﬁu:enariu:us e " Browse |
[ ] Reload all selected files from disk.

Save Cloze

Figure 19. Select Input Files
On the Output Settings panel, select the location for output files (Figure 20).
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{2} Modeling Settings |

General Compliance Settings )

Input Settings Output Settings

Output Settings Please specify where you would like to save the model outputs:

Rurtime Settings |C:"-.C:’-"-.FE"-J:|em|:|-n_|n " — |
Save Close

Figure 20. Select Output Location
e The Runtime Settings panel is not used for this exercise.

e Click the Save button to save the modeling settings and load the input files (Figure 21).

99



Modeling Settings |

General Compliance Settings )
Input Settings Output Settings

Output Settings Please specify where you would like to save the model outputs:
Runtime Settings |C:"-.C.—"-.FE"-J:|em|:| Tun " Browse |

Loading Parameters input file ...

Save Close

Figure 21. Save Modeling Settings

e Once loading completes, click the Close button to return the main CAFE Model
window. A new Compliance Model session, titled “Session 1” has now been created
(Figure 22).
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"3 CAFE Model =] E3
Fle View Help

JZEL®E

2 Session 1

Ready

New session created. 6/01/16 16:46:34

Figure 22. New Compliance Model Session Created

e Save the new session by selecting File > Save Session As.... Enter “demo.cmsd” in the
dialog box that appears, and click the Save button (Figure 23).
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Please specify the location where you would like ko save the "Session 1° session:
Save in: I = demo-run j - e E-
| 3)input

Desktop

Y

by Documents

WL
o 8

ty Computer

File name: n:IErru:u_u::rn:s:u:I j Save
[

Cancel |
p

Save as lype: IE.-'-‘-.FE Model Session Data [*. cmad)

Figure 23. Save New Session

e After the session has been saved, notice the title of the session has changed to “demo”
(Figure 24).
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"3 CAFE Model =] E3
Fle View Help

I ®E

£} demo

Ready

Session saved. 6/01/16 16:46:34

Figure 24. “demo” Session Saved

e Select File > Start Modeling to start the compliance modeling process. As the model
runs, the progress of the Compliance Model is displayed in the session window (Figure
25).
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{2} CAFE Model

M[=] k3
Fle View Help
IR ® @
) demo M =] E3
Ecenario: 1. Alternative Scenario Standards
Model Year: 2023
Manufacturer: Mfr_2
pSTND STND CAFE Credits Fines Costs
PC : 48.9 48.9 4/.1 -11m 133 m 1b

LT : 40.1 40.1 38.3 -13 m 0 3 b
2b3: 1/7.2 17.2 17.9 430 k 0 321 k

00:02:04

Mode! Running ...

6/01/16 16:46:34

Figure 25. Modeling Progress from the Compliance Model

After modeling has completed, the “Modeling Completed!” message appears at the
bottom of the main CAFE Model window (Figure 26).
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) CAFE Model

M[=] k3
File Wiew Help
L ®E

2} demo

=10] x|

Ecenario: 1. Alternative Scenario Standards
Model Year: 2032

Manufacturer: Mfr_3
pSTND STND CAFE Credits Fines Costs

PC : 54.4 54.4 54.6 3 m 0 3 b

LT : 36.0 36.0 36.0 0 0 3 b

Zb3: 17.0 17.0 19.0 7/ m 0 166 m
00:02:34

Modeling Completed!

6/01/16 16:46:34

Figure 26. Compliance Model Completed

Select View > Output Location to open Windows Explorer and browse to the location
where model outputs for the “demo” session are saved.

e Exit the session by selecting File > Close Session.

Exit the CAFE Model by selecting File > Exit, or proceed to the next example.
C.5.2 Example 2 — Configuring for “Fleet Analysis” Modeling

This example demonstrates how to take an existing session created in Example 1 — Configuring
for Standard Compliance Modeling, and modify it to perform fleet analysis calculations.

Run the CAFE Model by clicking on the CAFE Model executable located on the
desktop. Read through the Warnings dialog box, and then click the OK button.

Select File > Open Session to open an existing modeling session. Select “demo.cmsd”
in the dialog box that appears, and click the Open button (Figure 27).
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Please select the session file you would like to open:

Look jr: Ib dema-rin j = ¥ Eo-

Desktop

o

by Documents

WL
o 8

ty Computer

File name: Idemu:u.u:msd j Open
Filzz of type: IE.-'-‘-.FE Model Session Data [*. cmad) j Cancel |
y

Figure 27. Open “demo” Session

Once the session has been loaded, select View > Modeling Settings to bring up the
Modeling Settings window.

Click on the Runtime Settings panel and select the Perform Fleet Analysis Calculations
option as in Figure 28.
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{2} Modeling Settings |

General Compliance Settings . )
Input Settings Runtime Settings

Output Settings — Fuel Price: Estimates

Rurtime Settings () Low (=) Average (_! High
—CO2 Price Estimates
() Low (%) Average O High ' Very High

vl Allow Credit Trading
vl Peform Fleet Analysis Calculations

[] Scale Consumer Benefits (default is 100%):

Save Close

Figure 28. Enable Fleet Analysis Calculations
e The rest of the panels are not used for this exercise.

e Click the Save button to save the updated modeling settings; then click Close, once
saving completes.

e To prevent overwriting results from the “demo” session, select File > Save Session As...
to save the modified session with a new name. For this example, the session was saved
as “demo-fleet-analysis.cmsd”.

e Select File > Start Modeling to start the modeling process. As the model runs, the
progress of the Compliance Model is displayed in the session window.

e After compliance and fleet analysis modeling has completed, the “Modeling Completed!”
message appears at the bottom of the main CAFE Model window. Select File > EXxit to
exit the model.
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